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Documentation Updates

The title page of this document contains the following identifying information:

¢ Software Version number, which indicates the software version.

o Document Release Date, which changes each time the document is updated.

o Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go

to:
http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport

ID, goto:
http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:

o Search for knowledge documents of interest

e Submit and track support cases and enhancement requests
o Download software patches

o Manage support contracts

e Look up HP support contacts

« Review information about available services

¢ Enterinto discussions with other software customers

o Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.htmi
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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What's New

HP Sprinter Service Pack 11.52 contains the following new features:

o Integration with UFT. When working in Power Mode, you can save manual Sprinter tests as
XML files which are compatible with HP Unified Functional Testing (UFT). In UFT you can
import the XML file and convert it to an automated GUI test. For details, see
http://www.hp.com/go/uft.

o Performance Improvements. Performance improvements in many areas of the product, such
as opening, loading, and running tests.

 New Technologies. Added support for the following platforms and technologies: Windows 8,
Internet Explorer 10, Firefox versions 13 through 20, and WPF 4.

¢ Manual Mapping. In Data Injection, you can manually map fields in your application to columns
in your data set.
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How to Find Information

Product Name includes the following the following documents:

Document Description Available Formats

User Guide Describes how to use HP Sprinter to Online, and PDF
create and execute manual tests and
perform exploratory testing.

Readme Includes download instructions, last HTML DVD,
minute information, fixed issues, and HPL-
installation requirements. N,
HP
Man-
uals
Site

How to Search Help Center

To search Help Center, click the Search button at the bottom left corner of the Help Home page.

You can search for a single word, multiple words, or a specific combination of words that are
always next to each in the same order. To search for a specific combination of words, enter the
search words within quotation marks.

Documentation Updates

Sprinter documentation is also available on the HP Software Manuals site.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www?2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, goto:

http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Chapter 1

Using Sprinter - A Story

This chapter provides a general overview of how to work with Sprinter, in a user-story form. The
purpose of this story is to introduce you to Sprinter's features so that you can quickly get started
using Sprinter. As you work with Sprinter you can then explore its features in depth as needed.

This story is intended to be read in full and does not require that you have the program open as you
read. It is not a step-by-step guide to working with Sprinter, and does not provide full coverage of
the features. Other chapters of this guide describe Sprinter features in depth and are designed to be
read as needed, while you are working with the application.

This story includes:

o "Create Your Test" on page 17

e "Open Your Test and Prepare it fora Run" on page 18

o "Decideif You Want to Run Your Test in Power Mode" on page 20
o "Decide if You Want to Work with Mirroring" on page 23
e "Begin Your Run" on page 24

o "Submit a Defect" on page 26

¢ "Annotations" on page 28

e "Use Macros" on page 29

e "Use Data Injection" on page 30

o "View Your Run Results" on page 32

¢ "Run a Test with Mirroring" on page 37
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Using Sprinter for the First Time

Today is the first day you are using Sprinter to test your application. You are testing a travel
agency's Web application that allows users to find and book domestic and international flights.

You will be running an Application Lifecycle Management test, but you know you can load your
Application Lifecycle Management tests in Sprinter, so you decide whether to run your test
completely through Sprinter or in Application Lifecycle Management.

You sit down at your computer, double-click the Sprintericon !’ on your desktop, and Sprinter

opens.
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Connect to ALM

To start using Sprinter to run Application Lifecycle Management tests, you need to connect Sprinter
to Application Lifecycle Management. You click the Application Lifecycle Management Connection
button ke 2L in the main window to configure your connection.

You enter the necessary information. Since you always work on the same Application Lifecycle
Management server, you select the Reconnect on startup check box.
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Create Your Test

You enter Plan Mode . This mode lets you manually create or edit a test.
Click the New button in the Tests and Components list to create a new test.

In the Tests tab, in the Details pane, provide information for the test, such as a description and
comments. Add an attachment and parameters that will be used for the test. In the Steps tab, click
the Add button to add a test step . You provide a description, expected results, and other relevant
information in the step's fields. You format the text in these fields using rich-text capabilities, using
the formatting tools in the ribbon. You add an attachment and a screen capture for this step. Insert a
parameter that you defined in the Test pane, into a step.

Repeat the above to create multiple steps.

Click the Save button to save the test.
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Open Your Test and Prepare it for a Run

After you create a test in Plan mode, open ALM and add it to a test set in the Test Lab module.

Return to Sprinter and switch to Run Mode w .

&
Click the Open button cr=n  in the Run mode's Run Setup area to open your test. You see the Test
Sets tree and the information from the Execution tab. You select the tests you want to run and open

them.
4 [ Root Name Test Test Name Status
£ Unattached ] [Teurs Tours Ko Run
& Flight_book B [2Tours Tours Mo Run
% E::g::‘?l:;r [ NTeurs_select Tours_select] Mo Run
4 FIightZseIect [[] [MTeurs_select? Tours_select? Mo Run
1) Find NY SF

The tests appear in the Test Runs list inside the Run Setup area, in the main window of Sprinter.

Run Setup | N

\) G . R, o
P) Open Save Fawvarites
i

_} Test Runs

@| Name Status
Tours1 o
Tours o
Tours3 o

The Test Runs list displays tests that you can include in your next run. At this point you can add or
remove tests in the Test Runs list or you could use the right-click options to change the order of the
tests in your list or leave a test in the list but not include it in the next run.

For now you decide not to modify the list of tests and you check the status bar to confirm how
many tests from the Test Runs list will be included in the next run.

ITests: 3 | Active Tesis: 3|

At this point, you can review your test and run information. This information is displayed in the right

pane of the main window when you select a test in the Test Runs list and select a node in the
Definitions group.

Inner test 1 ?

[ Definitions General Settings
General Settings

Steps (2) Test instance: Inner test 1

Parameters (0
arameters (0) Test name: Inner test 1
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You review the General Settings node which displays the same information that you would
normally find in Application Lifecycle Management, including the name of the test, the name of the
test set, the name of the configuration, the test designer, the name of the run, and the test
description.

You confirm the steps in your test by reviewing them in the Steps node of the Definitions group.

You review the parameters in your test in the Parameters node of the Definitions group. You
modify the relevant actual values to meet your current testing needs.
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Decide if You Want to Run Your Test in Power
Mode

When you work with Power Mode, you have access to Sprinter's advanced functionality. This
includes data injection (automatically entering data into fields in your application), macros
(recording and replaying a set of user actions), mirroring (replicating user actions on multiple
computers), and scanners (checking that various aspects of your application behave correctly).

When you are in Power Mode, Sprinter also captures each action you perform on your application
and stores the list of these user actions (the actions you perform in your application) in the form of
descriptive sentences. For example:

"Enter "My User" in the "userName" edit field."

"Enter the encrypted password in the "password" edit field."
"Click the "Sign-In" image."

"Select the "New York" item from the "fromPort" combo box."
"Select the "February" item from the "fromMonth" combo box."
"Select the "Paris" item from the "toPort" combo box."

"Select the "March" item from the "toMonth" combo box."

You can view these user actions in your run results or in the Storyboard viewer at the end of your
run, which displays each action you performed in your test. You can also include a list of the
relevant user actions in any defect you submit to let Sprinter automatically insert a defect scenario.

If you run your test with Power Mode and do not configure data injection or macros, Sprinter will still
learn all your user actions, which you can include in defects and view in the Storyboard in the test
results.

Once you configure Power Mode to test an application, Sprinter remembers your settings every
time you test that application.

You decide that the data injection and macro capabilities will be really helpful during your run. You
have several forms that need to be filled out just to get to the main screen you need to test, and it
will be very nice to have Sprinter fill them in for you. You can also use macros to quickly run through
some of the initial screens in your application for you and get to the area that requires rigorous
testing.

You activate Power Mode by clicking the Power Mode button in the Power Mode group under the
Test Runs list.
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rPower Mode (& On |

Application {MercuryTours)
Data Injection (0)
Macros (0}

Mimoring Rules (0)

Scanners (/4]

Mirrcring (0}

To use Power Mode, you need to define the application for your test. This is the application that
you will be testing. By defining an application for your test, Sprinter is able to learn the objects and
screens in your application in order to work with the Power Mode features described above.

When you define an application for your test, Sprinter associates all your Power Mode
configurations with that application. That means that whenever you run a test in Power Mode and
select an application for your test, all the data injection data sets, macros, and rules that are
associated with that application are automatically available for your test.

You select the Application node in the Power Mode group to display the Application pane and
define the application for your test.

The travel agency application you will be testing is currently running on your computer, so you click
Quick Add, select you application from the list and Sprinter automatically defines the application
for you.

Using Data Injection

During the test you are going to run, you will need to enter data into a few forms in your application.
To make the data entry process faster and less error-prone, you configure data injection so it can
automatically fill the forms in your application with the data from your spreadsheet.

To use data injection, you need to create one or more files (data sets) that contain the data you want
to use in your application. The column headings in the data set must match the field names of the
fields in your application where you want the data injected. For example, to create a column for a
field labeled First name in your application, the column header should be First name.

The data set can be stored in the form of an .xsl, .xslx, or .csv (Comma Separated Values) file. You
then associate this file with your application in the Data Injection pane of the Power Mode group.

Now that you've associated this data set with this application, the data set will be automatically
available for any test that is configured to use this application.

Using Macros

During the testing process, you may have parts of your test that require performing a series of
actions that you want Sprinter to perform for you. There may also be parts of your test that involve
performing the same set of actions in multiple areas of your application. Macros perform a series of
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actions and run them as a single command, which can save testing time and reduce errors.

To create a new macro for your current application, you record the macro while you are performing
your test. It will then be available for your current test and for any test that is configured to use this
application.

You can view and manage the list of available macros for your application in the Macros pane of the
Power Mode group.

Using Scanners

Sprinter's scanners enable you to check whether strings in your application are spelled correctly,
whether the application conforms to Web Standards (Web applications only), if there are broken
links, or whether the user interface of your application is translated correctly.

You can turn the scanners on or off as needed. Use the Scanners pane (Power Mode group) to tumn
on the relevant scanners. During the test run, you use the Scanners sidebar to begin a scan.

Page 22 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 1: Using Sprinter - A Story

Decide if You Want to Work with Mirroring

A common need in manual testing is running the same test scenario on different configurations. You
may want to test your application on different operating systems, or in the case of a Web
application, with different browsers.

When you work with mirroring, every user action you perform in your application on your primary
machine is replicated on the defined secondary machines.

To read more about configuring a test to run with mirroring, see "Mirroring Tests" on page 36.
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Begin Your Run

You click the Run button % in the Run Setup area, your run begins and the Sprinter main

Window is hidden.

You immediately notice that Sprinter is taking up very little screen space. You see that you access
Sprinter's functionality during your run through sidebars that are positioned around the perimeter of
your display. In the closed position, the sidebars are hidden and only their tabs are visible.

12 start| & sign-on: Mercury Tours -... | [ Sprinter

«I@

You can open one, several, or all of the sidebars at once by clicking their tabs. Sidebars
automatically open and close as you click on or off them, and you can lock them in the open

position and reposition them, as needed.

e
e Toon
@ W& S @ C

BB ¢ &) e
- —
=

Ov O~ |.v 2~ By 0|BEYE SR Q

fie —————————————— %o §
=) 2. find flight. | ©

v 3. order fligh

) 4. logout

B start| 8 sigmon: ercury Tous . || I3 Sprimer

o OEE

2@

Scanners &

«I@

This design provides you with the maximum use of your display to view your application and run
your test, and enables you to expose specific Sprinter functionality as needed.

Since you used the Quick Add feature to define the application for your test, Sprinter starts your

application automatically at the beginning of the run for you.

Page 24

HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 1: Using Sprinter - A Story

You click on the Steps tab, so that you can view the test steps in the Steps sidebar.

Steps ¥ I
Test: order flight 7@
Ov Ov|wo~ Biv @B W& Q

© 1 login e B
» 2. find flight «| O
=\ 3. order fligh s ©
= 4. logout «| O
[ 0/4 | User Actions: 10 | Duration: 18:51:25

You skim the steps in your test and view their description, expected result, and any attachments.

Since you already skimmed through all the steps in your test, you decide to switch to Subtitles
mode by clicking the Subtitles button in the Steps sidebar. Subtitles mode displays the description
of each step as a subtitle on your screen instead of the sidebar, and enables you to mark the step's
status and add attachments to steps. This provides even more screen real estate, enabling you to
view even more of your application.

P T

Ahways cary a travel first aid kit
with bandages, antacids, aspiin,
bee sting wipes, and other basic
necessities.

Salon Travel

ersury Interactive (v 011003-101-058)

)

steps 4 || [3 € DataInjection 4 |Jlode: O

As you perform the steps in your test, you mark each step's status in the right column, for example
Passed or Failed.
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Submit a Defect

You continue performing the steps in your test, and for one of your steps, the actual result is not
what is described in the Expected Result. First you mark the status as Failed. Then click the
Actual Result button for the step. In the Actual Result dialog box, you enter text to describe what
actually happened in your application.

Actual Result

@ & X

.

Actusl Result:

Image:

Enter the actual result of the step

No Image

=]

From the toolbar in the Steps sidebar, you click the Smart Defect button.

Since this defect is something the developers have had a hard time reproducing in the past, you
include the list of user actions in the defect description as a reproduce scenario and attach a movie
of your run to the defect.
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Smart Defect Settings [ ? x

Include in descripiion

Wi |Cunentstep | - |

W Inclede last step's actual result information

el |AII user actions | - |

B Description praview:

User actions: |Z|

1. Enter "mercury” in the "userName" edit fisld.

2. Enter the encrypted password in the "password” edit field.
3. Click the "Sign-In" image.

4. Select the "oneway” radio button in the “ripType" radio group.

5. Select the "2” item from the "passCount” combo box |E|

Aftach to defect

¥l Current screen capture

W] Screen movie: Includs the last |1 | - | minute(s).

St Detec

You continue with your run and discover another defect, although this defect is much more basic.
Since you do not want to disrupt the flow of your run by submitting a defect and filling in the required
fields inApplication Lifecycle Management, you decide to create a Defect Reminder.

A Defect Reminder enables you to summarize the defect in your application. The reminder is
included with the test results and can be viewed at the end of your test. You can then submit the
defect later from the test Results. The same information you have available during the test is also
available to you from the results. This allows you to include annotated screen captures, movies,
and step or action information when you submit a defect.
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Annotations

In one of your steps you detect another defect in your application. You know that Sprinter lets you
capture images and attach them to a step, a run, the actual result, or a defect, but it will be easier for
the person who reviews the results if you highlight the problem in the image. So you decide to use
the Annotation Workspace to annotate the screen capture. You click the Save Annotation as
Actual Result button in the Actual Result dialog box. The Annotation Workspace opens and you
use the Annotation Tools to mark up your screen capture.

You use the Rectangle, Color Picker and Arrows to highlight the problem and then you add some
text to explain the problem. When you close the Annotation Workspace, the annotated screen
capture is attached to the Actual Results of your step.

| seLecT FLGHT
Select your departure and retum flight from the selections below. Your total price will
be higher than quoted if you elect to fly on a different airline for both legs of your
travel
Wrong date
Frankfurt to London 2/5/2010
SELECT
Blue Skies Airlined L] non-stop
@
Price: $270 (based |- 217d trip)
Blue Skies Airlin S; ;32 710 non-stop
Price: $271 (based oy rgasd trip)
Pangaea Airlines 36§ 9:17 non-stop
Price: $274 (based onroupd trip)
2@ . Unified Airlines 363 11:24 non-stop
— Price: $281 (based on fou u:npl Should be "Direct/Stops” |
i T \
LA % + Jndon to Frankfurt \ 482010
FEeTR .
,’7 | S q Blue Skies Airlines 631 1223 FOn-S10p
"? Price: $270 (based on r{
- o
“ Blue Skies Airlines 6315 14:30 non-stop
Properties § Price: $273 (based on round trip)
E
mEw % Pa'ngea Airlines 632 16:37 non-stop
z Price: $282 (based on round trip)
I_ | = Unified Airlines 633 18:44 non-stop
Price: $303 (based on round trip)
O i ©
Scresn bure:
=R 5, Mercury Interactive (v. HG-0.15)
[ Close |

In addition to saving the screen capture with the actual results, you could add it to a defect and use
the email option to send it to a coworker who recently mentioned noticing a similar problem.
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Use Macros

You continue performing the steps in your test, and you get to the area in your application where you
have a series of actions that you want Sprinter to perform for you. You click the Macros tab to open
the Macros sidebar.

a an i S o
Tours sign in | = \h[-.;, ¥

‘. 1)
@ &

Macros A

You click the record button and begin performing the actions that you want in your macro. When you
are finished with the series of actions, you click the Stop Recording button and save the macro.

The macro will be available for this run and for any future test that is configured to use your current
application.
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Use Data Injection

You continue performing the steps in your test, and you get to the area in your application where you
need to search for a flight. You click the Data Injection tab to open the Data Injection sidebar.

Data Injection ¥ |

Sample DI - ':EH - ‘H_’g; L=,
Middle: | Number: | Meal:
John 45345638 Diabetic
Kathy 12346543 Bland

Tom 89765432 Low Calorie

In the Data Injection sidebar, you select which data set you want to use in your application. You
then select the row of information for the search you want to perform and inject the data into your
application. Then you watch as Sprinter sends the data from that row to the relevant locations in the

form.
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Use the Scanners

When you get to the area in your application where you need to check for broken links or
compliance with Web standards (Web applications), proper translations, and misspellings, use the
built-in scanners. Click the Scanners tab to open the Scanners sidebar and then click the Start

Scan button @ .

g
® (/| Ge

Scanners A

After the scan ends, the Scan Results Viewer opens. Handle the results for each scanner by
creating a defect or a defect reminder or by performing a scanner-specific actions, such as adding a

word to the dictionary.

Scan Results Viewer

= o)

)
Submit Defect Defect Reminder

[7 7%

Scan Results

Summary Action
> “gBroken Links (1)
ABSpelicheck

b (fgWeb Standards (67)

Broken Link: hitp:/fnewtours.demoaut.com/images/spacer.gif
MotFound (404):
hitp:#newtours demoaut. com/images/spacer.gif

Page 31

HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 1: Using Sprinter - A Story

View Your Run Results

You click the Stop button I in the Run Control sidebar to end the run. The sidebars close and
the Run Summary pane opens in the main window. The summary includes: test and run

information, the number of actions you performed (Power Mode tests only), the number of defects
you submitted, the number of defect reminders you created, the number of comments you added

(Power Mode tests only), and the statuses of the steps you performed.

3 3

[%] acnons |_] Run Nefacts Lc] Mefert Reminders

a

! Comments

!,4_'| staps 1

© Nec Run
1

Tevrst 7
-, =
Frint Emal
S nefiniticrs Run Summary
Ganeral Seitings
siteps (1) l Testinstence: “ours! |
Parameders (1 J E lesi name:  oursl
- ir Slalus: O Passed
1 U] H——
AT T d) Run name: Run -0-17 13-06:02 |
Steps (1) T Testar:  scmin
Kun Uetects (3)
el Remrelers (1) [ Start time: | 107172012 15714 P10 |
User Actions (3} (9]  Endtime: 10/7.2012 20057 PM
Sooryopard... [ : nNuration: | 00nE43

Each of the nodes in the Results group can be selected to display more details in the right pane.

You select the Run Defects node to view a list of the defects you submitted during your test.

x ~ 8 . =]
Export Print Email | Show Defects in ALM

Run Defects

Defect IO Summary Severity Status
1 Broken Link hMain Page 2-Medium  New
2 Obsolete CGI script 3-High New

2 General Error 4-%ery High New

You can click the Defect ID number to open the ALM Defect Details dialog box for that defect.
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You then select the Defect Reminders node to view a list of the defect reminders you created

during your test.

?iv@v[:

Export Print

Email Submit Defact

Defect Reminders

Summary

Spellcheck errer found in; M+
Spellcheck errors found inM=

You select a reminder and click Submit Defect, to submit the defect. All the information for the
defect is still available in the run results. You can include an annotated screen capture, a movie, the

step information or user action information with your defect.

Since you decided to run your test in Power Mode, you select the User Actions node and view a

list of the user actions you performed during your run.

=

N A
-, (l EM » M=F - |
Generste Test Export to UFT Export Print Email
User Actions
Action  Time Drescription Comment
1 2:40:26 PM  Enter "Flowers™ in the "gquery" edit field.
2 2:40:30 P Click the "bin_search_hp_text" image.

This list of user actions can be exported to an Excel spreadsheet or as a Unified Functional Testing

test.

You click the Generate Test button to use the current test run as a template for creating a new

manual test.
Generate Test | 2 O X___I
Test Steps (2)
P ity (= [N —
&% 7 BncopySteps & || ||'.?2-£. |:= =
| Add ] Paste Steps 3 || |siBmpdimpl ||,| |__ &38| O Match whole word
| Step Font Paragraph Find
Mame | Description Expected Result |
1 Step 1 Enter "Flowers" in the "guery"
edit field.
2 Step 2 Click the "btn_search_hp_text"
image.
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You open the Steps node to see details about each of the steps. The summary includes Status,
Name, Description, Expected and Actual Results, Screen Captures, and Attachments.

x> @ . X
Export Print Email
Steps
# Status  Name Diescription Expecte *
1 o Step 3 Enter "jo" in the "j_usermame" edit field.
2 Q Step 4 Enter the encrypted password in the "j_password” edit
field.
3 © Step5  Click the "Login” button.
4 © Step6  Click the "Money Transfer " link.
5 © Step7  Select the "Money Market [543877] §84.00" item from
the "fromAccount” combo box.
i} Q Step 8 Select the "Checking [543875] §1.757.00" item from
the "toAccount” combo box.
7 Qo Step 9  Click the "Next” button.
3 Qo Step 10 Enter "68" in the "amount” edit field.
9 © Step11 Click the "25" link.
10 © Step12 Click the "Nexi” button.
1 © Step13 Click the "OK" button.
12 ©  Step14 Click the "Logout” link.
4 | m J »

You then select the Storyboard node and the Storyboard opens. The top of the Storyboard displays
a screen capture of your application as it appeared after the selected user action in the Timeline

was performed, and an Action Summary pane. The bottom of the Storyboard displays a Timeline of
your run.

Storyboard - Order Flight in DemaTours1 (24 User Actions)

lwcan-w |

Action 8 - 510/2012 5:00:10 PM

O

E - -
Smart Defect  Exportto Word  Maximize-

Login - Click the "Sign-In" image

Run Defects

Mane

LsDefect Reminders
Hone

Comments
Mane

Timeline

br s oy | 8- B -

In the Action Details pane you view a description of each action and any defects that were
submitted, defect reminders or comments that were added, and if you ran your test with mirroring,
any differences that were found between the primary and secondary machines.
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You can click the links in the Action Summary pane to open the Defect Details dialog box, create a
defect from your defect reminder, or open the Differences Viewer. You can also submit a new
defect from the Storyboard.

The bottom of the Storyboard displays the Timeline of your test. The Timeline contains a thumbnail
screen capture of each user action in your test. You can filter the thumbnails that are displayed in
the Timeline to show only those actions where you submitted a defect, only those actions where
you created a Defect Reminder, only those actions where you added a comment, or only those
actions where differences were found.

Now that you've walked through the basic processes of configuring, running, and viewing the
results of this imaginary test, you are ready to get started using Sprinter. Continue reading to learn
how to take advantage of the mirroring options.
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Mirroring Tests

You decided that you want to run your test with mirroring, because you need to make sure that your
online travel agency application will work on all of the popular browsers and the most common
operating systems.

Normally the QA team selects a few combinations of browsers and operating systems due to
limitations of time and resources. Now with mirroring, you can test many of the combinations at
once.

You have arranged for a computer lab to be set up with the combinations of the supported browsers
and operating systems and you have access to the machines for a few hours, which is plenty of
time since you can test all the combinations simultaneously.

To work with mirroring, you select the Mirroring node in the Power Mode group and configure the
secondary machines for your test. You then click the Add button to add a new machine for your
application.

You provide a machine name or IP address for the secondary machine, and since you are testing a
Web application, you define which browser you want to use to run the application on this machine.
You decide to also provide the remote desktop connection information, in case you want to open a
connection during your test (you can provide that information during the run as well). You repeat this
for each machine in the testing matrix.

You need to also set up your secondary machine with the specific configuration and settings you
want to test.
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Run a Test with Mirroring

When you start your test with mirroring, the Health Console displays the status of each machine in

your run.

Health Console ?

= ¥ 4]

Initiglize Machine Detsils Remote Deskiop

Sta... Machine
») E Primary {localhost)
O [H Firefoxiab 2)
O [Hwin7wsbn

Frogress

10%

——

10%

Details

Freparing the machina
Initializing Power Mode

Connecting to the machine

When all the machines are ready, the run begins. You click the Machines tab to open the Machines

sidebar and view the status of your machines.

You perform the user actions in your test and you monitor the Machines sidebar to check that all

your secondary machines replicated your actions successfully.

X
A%
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After one action, the Machines sidebar indicates a replication failure on a secondary machine.

In this case, any subsequent user actions you perform are not replicated on the secondary machine
where the failure occurred, until you address the replication problem between the machines.

You want to get a sense of what the problem is, so you right-click the secondary machine display
and select Show Screen from the drop-down list to view a current screen capture of the secondary
machine. You notice that on your secondary machine an ActiveX warning appeared in the browser
window. Since this is not a defect in your application, you right-click the secondary machine display
and open a remote desktop connection with your secondary machine and clear the warning. You
close the remote desktop connection and from the right-click list you select Skip. This tells Sprinter
to ignore the replication problem, unlock the secondary machine, and attempt to replicate any
pending user actions (actions that were performed on the primary machine while the secondary
machine still had differences).

As you continue your run, you come to a screen that has known compatibility problems between
browsers. To check that the application is displaying properly, you click the Compare All button

:'JE'* in the Machines sidebar. This compares the current display of the primary machine with the
current displays of all the secondary machines and looks for differences between them.

As a result of the Compare All operation, one of the secondary machines indicates a comparison
problem. You right-click the secondary machine display for that machine and select Differences
Viewer from the drop-down list.
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In the Differences Viewer the difference between the machines is highlighted.

gnore| New e View Rules

Zoom to Difference: Zoom Out | Select Al

Action Summary
@ Difference not resolved “View Calendar' button can enly be found in Firefox host
@ Difference not resolved “View Calendar’ button can only be found in Firefox host.

Primary Firefox
a O @
Maximize Maximize Remote Deskion
= m 5
Q Q Trip © One Way
T[] VewCaondsr | [
xl
H [E ——
View Calendar’ button can onlv be found in Fircfox host.

You see that the difference is in the display of a user interface element between browsers, so you
submit a defect for this difference. Now that you have submitted a defect, you don't want Sprinter to
detect this type of difference in the future. So you create a rule in the Differences Viewer,
instructing Sprinter to ignore differences of this type.

You close the Differences Viewer and retumn to your run. Once you resolve the difference, the
secondary machine is unlocked and any pending user actions are replicated.

Now that you've walked through the basic process running a test with Mirroring, you are ready to
get started using Mirroring in your Sprinter tests.
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Sprinter at a Glance

This chapter includes:

Concepts

e "Sprinter Overview" on next page

e "How User Information is Maintained" on page 44
Tasks

¢ "How to Get Started with Sprinter" on page 46
Reference

¢ "Welcome Dialog Box" on page 48

"Application Lifecycle Management Connection Dialog Box" on page 52

e "Main Window" on page 50

"Settings Dialog Box" on page 54

"Troubleshooting and Limitations - General" on page 66
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Sprinter Overview

Welcome to HP Sprinter, HP's solution for manual testing. Sprinter provides advanced
functionality and tools to make manual testing more efficient and effective.

Manual testing often requires that you leave your testing application to accomplish tasks related to
your test. For example, you may need to use graphic software to take a screen capture of your
application, you may want to record a movie of the application during the test, and you need to
switch to your defect tracking software to report defects.

Sprinter enables you to accomplish these tasks without disrupting your test flow. With Sprinter, you
can also perform many of the repetitive and tedious tasks of manual testing automatically. Sprinter
includes many tools to help you detect and submit defects. These features ensure that you can
perform all the tasks necessary for your manual test with minimum interruptions to your testing
work.

Sprinter also enables you to create, edit, and manage manual tests and business components
directly in Sprinter, and then save them to Application Lifecycle Management.

Sprinter is fully integrated with Application Lifecycle Management, enabling you to get the
maximum benefit from both solutions.

With Sprinter you can:

o Create manual tests and business components.
In Sprinter's Plan mode, you can create and edit manual tests and business components. You
can add steps manually or automatically using the Steps Capture tool. For details, see
"Creating Tests and Business Components" on page 68.

« Run manual tests and Business Process tests with a new step display, utilizing the
following features:
= User-friendly display. Steps are presented in a clear, organized, and user-friendly design,
making it easier to view step information, navigate steps, and modify step information. For
details, see "Steps Sidebar" on page 147.

= Navigation. You can move between the tests in your run without interrupting your test flow.
Sprinter updates all your displayed step and run information to match your current test.

= Ability to edit parameters during a test run. You can easily edit the actual values of
parameters in your test, during your test run.

= Multiple views. You can change the way you view your steps depending on your testing
needs. View in normal mode when more details are needed, or view in Subtitles mode if you
need to see more of your application. For details, see "Steps Sidebar" on page 147.
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= Screen captures. You can attach a plain or annotated screen capture of your application to the
step's actual value. For details, see "Steps Sidebar" on page 147.

+ Run exploratory tests with no predefined steps. If you run a test without predefined steps,
Sprinter records of all the user actions you took during your test. Sprinter also enables you to
export the list of user actions performed during informal testing sessions to:

= A formal manual test. All user actions are converted to steps.

= An Excel spreadsheet. You can then modify the text as needed and import the spreadsheet to
atest in, thereby converting an exploratory test to a formal test, with predefined steps. For
details, see "User Actions Pane/User Actions Summary Dialog Box" on page 198.

« Submit defects to Application Lifecycle Management. Submit an Application Lifecycle
Management defect directly from within Sprinter. For details, see "Tools Sidebar" on page 173.

= Open a Smart Defect. Smart Defects create a defect scenario by automatically generating a
text description of all the user actions or steps in your test. You can also attach a screen
capture or a movie of your application to the defect. For details, see "Smart Defect Settings
Dialog Box" on page 177.

» Create a Defect Reminder to submit a defect at the end of your run, enabling you to keep
testing without interrupting the flow of your test run.

« Create and annotate screen captures of your application. Sprinter provides tools that
enable you to take and annotate a screen capture of your application at any point in the testing
process. Tools are included for measuring and comparing user interface elements. You can
report defects in the display by attaching the annotated screen capture to a defect, saving it as a
file, or attaching it to an email. You can also include annotated screen captures in the Actual
Result of a step. For details, see "Annotation Tools Sidebar" on page 183.

¢ Record and run macros on your test application. Create and run macros to allow Sprinter to
perform a set of actions in your application for you. For details, see "Macros Sidebar" on page
248.

« Inject data. Sprinter can automatically enter data into fields in your application for you. The data
is automatically matched to your application's fields. For details, see "Data Injection Sidebar" on
page 240.

+ Replicate your actions on another computer. Mirroring enables you to replicate your user
actions on multiple computers with different configurations (operating system, browser). Sprinter
detects differences in the displays of these computers and enables you to report defects on
these differences. For details, see "Testing on Multiple Machines - Overview" on page 275.
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« Scan your application for potential defects. Scanners enable you to check that various
aspects of your application behave correctly during a run session. You can then report defects
on any results found during the scanning process. For details, see "Scanners Overview" on page
255,

o View test results. Sprinter includes a Storyboard that displays each action you performed in
your test. For each action, you can see a screen capture of the action, any defects that you
reported, and defect reminders and comments you added to your run. If you ran the test with
multiple configurations you can view the differences between the displays of different
computers. For details, see "Run Results Overview" on page 188.

All this functionality is available from within Sprinter and can be used without interrupting the flow of
your manual test.
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How User Information is Maintained

Sprinter saves settings and other user-specific configurations and applies this information the next
time you run Sprinter.

When you run Sprinter, this information is saved in the Application Lifecycle Management project,
per-user (as unique information for each unique Application Lifecycle Management user in each
project). Additionally, it is saved to your local computer, per Windows user profile.

The next time you run Sprinter, it applies these saved settings and configurations, if they are
available. Some information is saved and applied per-user and some information is saved and
applied depending on the application defined for your test.

The tables below describe how the user information is saved and applied ( Some user information is

relevant for Power Mode features only, as indicated by the Power Mode icon @)_

Note: When you begin a Sprinter session while not connected to Application Lifecycle
Management, any information that is stored locally is applied to Sprinter. If you then connect to
Application Lifecycle Management, the information stored in Application Lifecycle
Management is applied in addition to the local information. Some of your local information may
be replaced by the Application Lifecycle Management information for your user in your project.
This combined set of information is then saved in Application Lifecycle Management for your
user in your project. If there is a conflict between the information stored locally and the
information stored in Application Lifecycle Management, the most recent information is
applied.

To maintain a consistent working environment in Sprinter, it is recommended that you connect
to Application Lifecycle Management before making any changes to your settings or
configurations.
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Information Applied Per User in Your Application Lifecycle Management

Project

User

Information Where Defined

Favorites "Run Setup Area"
on page 124

Settings "Settings Dialog
Box" on page 54

P "Application Pane

Applications | (Power Mode
Group)" on page
214

P "Scanners Pane

Scanners (Power Mode
Group) / Scanner
Settings Dialog
Box" on page 262

P, "Mirroring Pane

Secondary | (Power Mode

Machines Group)" on page
294

How Information is Applied

o Uses the list from your last Sprinter session.

« When you load tests, Sprinter checks the first test to see
if it has a defined application. If it does, Sprinter checks if
that application is in your list of applications in the
Applications pane. If it is missing, Sprinter adds it to the
list and selects it.

o If you do not have permissions to modify resources in
Application Lifecycle Management, all your test settings
and configurations are saved for your user profile on your
local computer only.

Information Applied Per Application

User

Information Defined

Where

How Information is Applied

P Macros | "Macros When you save a macro, add a data set, or create a rule, Sprinter
Sidebar" on | associates them with the application defined for your test in the
page 248 "Application Pane (Power Mode Group)" (described on page 214).
) "Data When you select an application for your test in the Application
— pane, all the macros, data sets, and rules associated with that
Data Sets Injection C _ _
Sidebar" on application are available in your test.
page 240 This information is retrieved per-user in your Application Lifecycle
Management project.
7 Rules "Rules g .
Manager Note: By default, rules are applied per-application. You can define
Dialog Box" | global rules for all your tests in the "Rule Wizard - Rule Details
on page 320 | Page" (described on page 322).
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How to Get Started with Sprinter

The following steps describe the general prerequisites to using Sprinter, and how to start using
Sprinter.

Throughout this guide, descriptions of features that are available only in Power Mode are
identified by the Power Mode 2 icon.

This task includes the following steps:

o Prerequisites

e Connectto ALM

Create and edit test

Run a test

Prerequisites

¢ Sprinter functionality is available with:
= HPApplication Lifecycle Management 11.50
= Application Lifecycle Management Quality Center 11.50 Enterprise Edition

o You must have the following permissions in Application Lifecycle Management to run a test in

Sprinter:

Permission Permission Level

Test Lab > Results Create, update, and delete
Test Lab > Run Create and update

o Tosave your user information to Application Lifecycle Management you need the following
additional permissions:

Permission Permission Level
Resources > Resource Create, update, and delete
Resources > Resource folder Create and update

o To edit test steps, you need the following additional permissions:

Permission Permission Level

Test Plan > Design Step Create, update, and delete
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o To create new manual tests, you need the following additional permissions:

Permission Permission Level

Test Plan > Test Create, update, and delete
Test Plan > Test Folder Create, update, and delete
Test Plan > Test Parameters Create, update, and delete

Connect to Application Lifecycle Management

If you are going to run an Application Lifecycle Management test, report defects to Application
Lifecycle Management, or if you want your configurations and settings to be saved for your
Application Lifecycle Management user, you need to connect to an Application Lifecycle
Management project.

You also need to be connected to Application Lifecycle Management if you want to run a test with
mirroring on more than one secondary machine. For details on testing with mirroring, see "Testing
on Multiple Machines - Overview" on page 275.

You must be connected to Application Lifecycle Management to run a test in Sprinter.
Click the Application Lifecycle Management button k= 2. to open the Application Lifecycle

Management Connection dialog box and connect to Application Lifecycle Management.

If you do not connect to Application Lifecycle Management, you will be prompted to connect when
you open a test.

For details, see "Application Lifecycle Management Connection Dialog Box" on page 52.

Create and edit a test or component
For details, see "How to Author a Test or Component" on page 70.

Run a test or test set
For details, see "How to Run a Manual Test in Sprinter" on page 114.

Page 47 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 2: Sprinter at a Glance

Welcome Dialog Box

This dialog box provides quick access to Sprinter Help and feature movies. It also lets you open or
create a test or business component.

The following image shows the Welcome dialog box.

Plan Run Help Introduction
Welcome to HP Sprinter 11.52! E Product Movies
Sprinter is HF's solution for efficient and effective See all of the HP Sprinter movies on the HE ALM

manual testing. Product Feature movies page
Use Sprinter to Plan and Run manual tests.

What's New

® Test authoring

® Scanners for automatic defect detection
® Storyboard export to Word or PDF

® Exploratory Testing enhancements

® Technologies support

® Data Injection Manual Fields Mapping

v Show on startup [ Close |

To access Do one of the following:
o Start Sprinter.

¢ Inthe main window, select Welcome Screen from the drop-down arrow
adjacent to the Help button.

Important The Show on startup option instructs Sprinter to display the Welcome dialog
Information | hox each time Sprinter is opened.

You can configure Sprinter to bypass the Welcome dialog box in the "General
Settings Pane (Settings Dialog Box)" (described on page 54).

Introduction Tab

The Introduction tab lists the new Sprinter features and provides links to feature movies.

Help Tab

The Help tab provides links to this user guide, customer support, and the About screen.

Page 48 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 2: Sprinter at a Glance

Plan Tab

User interface elements for the Plan tab are described below:

Ul Elements Description

New HP Opens the Authoring pane and adds a new test entry to the Tests and

ALM Test Components list.
If you are not connected to Application Lifecycle Management, the "Application
Lifecycle Management Connection Dialog Box" on page 52 opens to enable you
to connect to Application Lifecycle Management.

New HP Opens the Authoring pane and adds a new business component entry to the

ALM Tests and Components list.

Business

Component | If you are not connected to Application Lifecycle Management, the "Application
Lifecycle Management Connection Dialog Box" on page 52 opens to enable you
to connect to Application Lifecycle Management.

Open HP Opens the "Open Dialog Box" on page 133 (described on page 133) to the parent

ALM Test Subject root in ALM's Test Lab module.
If you are not connected to Application Lifecycle Management, the "Application
Lifecycle Management Connection Dialog Box" on page 52 opens to enable you
to connect to Application Lifecycle Management.

Open HP Opens the "Open Dialog Box" (described on page 133) to the parent business

ALM component root.

Business

Component | If you are not connected to Application Lifecycle Management, the "Application
Lifecycle Management Connection Dialog Box" on page 52 opens to enable you
to connect to Application Lifecycle Management.

Run Tab

User interface elements for the Run tab are described below:

ul
Elements Description

Open HP | Opens the "Open Dialog Box" (described on page 133) to allow you to open a test

ALM from ALM's Test Lab module.

Test
If you are not connected to Application Lifecycle Management, the "Application
Lifecycle Management Connection Dialog Box" on page 52 opens to enable you to
connect to Application Lifecycle Management first.

Favorites | The list of your favorite Sprinter tests.
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Main Window

This window enables you to manage your tests and components, set test and component
definitions, view test results, and configure Sprinter settings. You can also access the Settings
dialog box and Application Lifecycle Management Connection dialog box.

The panes displayed in the main Sprinter window differ depending on whether you are authoring a
test or component, or running a test.

Tasks you can accomplish with the main window:

o "How to Get Started with Sprinter" on page 46

« "How to Author a Test or Component” on page 70

e "How to Run a Manual Test in Sprinter" on page 114

o "How to Review Run Results" on page 189

The following image shows the main window for Plan mode.

‘$ = JO = = ” Test Steps (1)
L. Tests and C P
:“;m ;‘“:ﬁ:; [SiDefniions___}| Details
New Component 1 ‘Components\Demo P::‘:&lel: @ Name: New Test 1
Attt (VN | Location: SubjectiDemo
Designer: admin
Creation date: 3/13/2012
Status: Design
Description:
Comments:
[Tests 11 Componenis: 1 Do SPRINTER, Prosest: Senity, User s (|
To access 1. Start Sprinter and close the Welcome window, if open.
2. Select Plan from the main toolbar.
Important e The information available in the Details pane depends on the selected test
information in the Test and Components list.
e To exit Sprinter, close the main window.
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See also e "Sprinter Overview" on page 41
e "Test and Component Authoring Overview" on page 69

e "Power Mode Overview" on page 111

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

Indicates that Sprinter is in Run mode and shows the Run Setup area in the left

pane. For details, see "Run Setup Area" on page 124.

pane. For details, see "Plan Area" on page 73.

W Indicates that Sprinter is in Plan mode and shows the Authoring area in the left
F_.O‘

Opens the "Application Lifecycle Management Connection Dialog Box" (described

L2 on page 52), enabling you to configure your Application Lifecycle Management

connection and connect to a Application Lifecycle Management project.

Opens the "Settings Dialog Box" (described on page 54).

Settings

] Opens the Help for the main window.
help

Drop-down options:
e Help

e Printer-Friendly Documentation. Opens a printer-friendly version of the Sprinter
documentation, in Adobe Acrobat Reader (PDF) format.

¢ HP Software Support. Connects you to the HP Software Support Online Web
site.

e Check for Updates. The first time you select Check for Updates, you are
directed to download and install the HP Update application (unless you have other
HP applications that use Check for Updates installed on your computer). The
next time you select Check for Updates, the application will run automatically.

o Welcome Screen

e About
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ul
Elements Description

<Status | The status bar displays the following information:
bar>

Plan Mode

e Test and Component Count Tzsts: 1| Components: 1 . The number of tests and
components in the Tests and Components list.

Run Mode

o Test Runs list statuslTests: 21 Active Tests: 2] The number of tests in the Test Runs
list, followed by the number of tests within the list that will be included in the next
run.

o ;OAppIication Lifecycle Management connection status. The state of Sprinter's
connection to Application Lifecycle Management. The icon is deactivated when

you are disconnected from Application Lifecycle ManagementYou can double-
click this icon to open the "Application Lifecycle Management Connection Dialog
Box" (described on page 52).

The main window also contains the following areas:

Plan Mode

o "Plan Area" on page 73

o "Definitions Group (Test/Component Tab)" on page 85
e "Steps Tab" on page 93

Run Mode

¢ "Run Setup Area" on page 124
o "Power Mode Group" on page 212
o "Run Setup Definitions Group" on page 135

¢ "Results Group" on page 192

Application Lifecycle Management
Connection Dialog Box

This pane enables you to connect to Application Lifecycle Management.
Tasks you can accomplish with the Application Lifecycle Management Connection dialog box:
e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Application Lifecycle ManagementConnection dialog box.
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HF ALM Connection

Server:

Address: | hitp:/#fmachine.domain:3080/acbin/ | > |

User name: | tester

Your HP ALM user name

Password: | |
| Authenticate |
Project:

Domain

Project
] Reconnecton startup f‘é
[ e thi }
V| Close this dialog after connecting .

Exit Sprint

To access | Do one of the following:

« Inthe main window, click the Application Lifecycle Managementbutton iis .

¢ Inthe status bar, double-click the Application Lifecycle Management icon © .
Important e The server Address must be entered in the format: http://<Application
information

Lifecycle Management server name>[<:port number>]/gcbin.

Your Application Lifecycle Management connection status is displayed in the
status bar. When you are connected to Application Lifecycle Management, the
Application Lifecycle Management icon is active and when you are
disconnected it is deactivated.

The Domain and Project fields are not case-sensitive.

If your connection to Application Lifecycle Management is lost and there are
tests in the Test Runs list, you must reconnect to the same project to run or
save the tests.

Descriptions of the user interface elements are available in the dialog box when you hover over

them.
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Settings Dialog Box

This dialog box includes the following panes:

"General Settings Pane (Settings Dialog Box)" on next page
"Hot Key Settings Pane (Settings Dialog Box)" on page 57
"Plan Settings Pane (Settings Dialog Box)" on page 58
"Run Settings Pane (Settings Dialog Box)" on page 59

"Mirroring Settings Pane (Settings Dialog Box)" on page 61
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This pane enables you to set general settings for Sprinter.

The following image shows the General Settings pane.

5 General Settings ?

| Show Welcome dialog on starfup
| Show Power Mode Welcome dialog
Enable animations

Language: |English -

To access J
Select Settings button s=tinz= > General node.

User interface elements are described below:

Ul Elements Description

Show Opens the Welcome dialog box each time you start Sprinter. For details, see
Welcome "Welcome Dialog Box" on page 48.

dialog on

startup Tip: You can also disable this dialog by clearing the Show on startup check

box in the dialog box.

Show Power | Opens the Welcome to Power Mode dialog box when you activate Power

Mode Mode.
Welcome
dialog Tip: You can also hide this dialog by clearing the Display this screen when

Power Mode is turned on check box in the dialog box.

Enable Enables animations for Data Injection and Annotations during test runs.
Animations Animation enhances the look and feel of the run, showing the operations within
the applications in an animated way.

Note: Enabling animation may affect performance.
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Ul Elements Description

Language A drop-down indicating the interface language.

Note: For a change in the interface language to take effect, you must restart
Sprinter.
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Hot Key Settings Pane (Settings Dialog Box)

This pane enables you to define hot keys for various functions in Sprinter.

The following image shows the Hot Key Settings pane.

Hot Key Settings

2

o)

Assign

Pass Step Alt +F5

Fail Step Alt +F6
Return to Previous Step Alt +FT7
Advance to Mext Step Alt +F8
Toggle Subtitles Alt +F12
Toggle Sidebars Control + Back
Display Step Details Alt +Up

Cpen Annctation Workspace Contrel + F10

To access

Select Settings button seting=> Hot Keys node.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

Assigns a new hot key to a function.

Assign

To change the hot key for a function:

1.

2.

3.

4.

Select the function from the list.

Click the Assign button. The Assign Hot Key dialog box opens.

Press the key combination you want for the hot key.

Click OK.

<Function list>

The list of functions and their currently defined hot keys.
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Plan Settings Pane (Settings Dialog Box)

The Plan pane enables you to define the test's Plan mode settings.

The following image shows the Plan Settings pane.

"j Plan Settings

2

® Insert the text of the

Insert the text of the

‘While using the Steps Capture tool (when each performed user action is capiured to a separate step):
captured user action info the step’s Description

captured user action into the step’s Name.

To access J

Select Settings button ==ting= > Plan node.
Important This settings only applies when Single User Action per Step is selected in a
information Steps Capture session.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements

Description

Plan Settings

These options indicate where to place the text of the captured action:
o Insert the text of the captured user action into the step's Description.

« Insert the text of the captured user action into the step's Name.
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Run Settings Pane (Settings Dialog Box)

This pane enables you to define when Sprinter saves screen captures and movies of your run, and

autosave settings.

The following image shows the Run Settings pane.

2

H Run Settings
Capture all im

Do not capture images

all images during a
Capture all images for a failed test

) Capture all images for a failed step (tests with steps only)

V| Auto-save every | 1 ﬂ minutes

b Automatic screen movie recording

test

To access

Select Settings button settngs > Run node.

Important o
information

The options in the Run Settings pane that control screen captures are
relevant only for tests that were run in Power Mode and determine which
screen captures will be available for display for the actions in the Storyboard.
For details, see "Storyboard Window" on page 201.

Sprinter temporarily captures and saves images for each action in your run.
The options in the Run pane determine which captures will be saved with the
run results and which will be discarded.

If the Capture all images in a test option is disabled in the Setting dialog box,
your ALM administrator can enable it in the project. In ALM, select Tools >
Customize. In the Project Customization window, select the Sprinter node,
and select the desired options in the Screen Captures section. For example,
Enable Storing of all images during a test. For details, see " Sprinter
Customization in ALM " on page 62.

See also "Testing on Multiple Machines - Overview" on page 275
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User interface elements are described below:

Ul Elements Description

Capture all images
during a test

Saves a screen capture of the application for every user action.

2 Relevant for tests run in Power Mode only.

Note: Capturing all images may cause a delay in the time it takes to
submit a defect to Application Lifecycle Management and increase the
storage needs of your platform server.

Capture all images
for a failed test

Saves a screen capture of the application for every user action in a
failed run.

P Relevant for tests run in Power Mode only.

Capture all images
for a failed step (tests
with steps only)

Saves a screen capture of the application for all failed steps.

P Relevant for tests run in Power Mode only.

Do not capture
images

Does not save any screen captures of the application.

P Relevant for tests run in Power Mode only.

Auto save every
<value> minutes

Determines how often Sprinter automatically saves your test during a
run.

Automatic screen
movie recording

Automatically records a movie of your run. You can use a Smart
Defect to attach the recorded movie to a defect.

Default state: Cleared

¢ You must be connected to Application Lifecycle Management to
use screen movies.

The screen movie functionality must first be enabled by your
Application Lifecycle Management administrator.
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Mirroring Settings Pane (Settings Dialog Box)

This pane enables you to define how Sprinter compares and detects differences between primary
and secondary machines in a test with mirroring.

2 Mirroring is relevant for tests run in Power Mode only.

The following image shows the Mirroring pane.

&le Mirroring Settings

?

window.

v lgnore differences in the position of objects if they are under| 30 3 pixels

= 1anore differences in - is if they nder - .
| Ignore differences in the size of objects if they are unde BD &@ | Dixels

| When there is a difference in the size of a window, ignore the position and size of objects in the

To access

Select Settings button Settings > Mirroring node.

See also ¢ "Testing on Multiple Machines - Overview" on page 275

o "Rules Overview" on page 281

User interface elements are described below:

Ul Elements Description

Ignore differences in the position
of objects if they are under
<value> pixels

Defines the number of pixels by which the location of an
object can be different between the primary and
secondary machines.

If the same object's location differs by up to this number
of pixels between the two machines, it will not be
detected as a difference.
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Ul Elements

Description

Ignore differences in the size of
objects if they are under <value>
pixels

Defines the number of pixels by which the size of an
object can be different between the primary and
secondary machines.

If the same object's size differs by up to this number of
pixels between the two machines, it will not be detected
as a difference.

When there is a difference in the
size of a window, ignore the
position and size of objects in the
window

Instructs Sprinter to ignore differences in the size and
position of an object, when the window containing the
object is a different size in the primary and secondary
machines.

Sprinter Customization in ALM

This page is only available in ALM, and allows you to customize and override the settings in

Sprinter.

This dialog box enables you to activate or deactivate Sprinter features. Deactivated features are

visible in the Sprinter user interface, but are inactive.

Sprinter

PI:I Save

Enable manual tests ta run with:
) Manual Runner

) Sprinter
#) Bath Manual Runner and Sprinter

Screen Captures

(#) Enable storing of all images during a test

") Enable storing of all images for a failed test
) Disable storing of images

| Allove macros
w| Allow Diata Injection
v| Allow editing steps in Sprinter Bun mode

Allow attaching movies to defects

I amirnur mavie length [minutes):

FR=|

") Enable storing of all images for a failed step [tests with steps anly)

To access
left pane.

Inan ALM project, click Tools > Customize. Then click the Sprinter node in the
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Important The settings available in the Sprinter page control which features are enabled in
information | gprinter. Users still need the correct permissions within ALM that allow them to
perform various functions.

For example, suppose you select Allow editing of steps in Sprinter Run
Mode. The features that allow step editing will be enabled in Sprinter. However,
users that do not have test editing permissions in ALM will still be unable to edit
steps in atest.

See also "Run Settings Pane (Settings Dialog Box)" on page 59

User interface elements are described below:

ul Description
Elements
Save Saves Sprinter customization changes.

Enable Options include:
manual
tests to o Manual Runner. Enable manual tests to run with the Manual Runner only.

run with . . .
o Sprinter. Enable manual tests to run with Sprinter only.

o Both Manual Runner and Sprinter.(Default) Enable manual tests to run with
Manual Runner or Sprinter.
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ul Description

Elements

Screen o Sprinter temporarily saves the screen captures of all the actions in your test. You

Captures indicate which images to capture during the run, in Sprinter's Settings dialog box,
in the Run pane. For details, see "Run Settings Pane (Settings Dialog Box)" on
page 59.

o The settings below control access to the corresponding options in Sprinter's Run
pane. These are useful for administrators, as it allows them to limit the amount of
images saved during test runs.

= Enable storing of all images during a test. Enables the storing of all images
during a run.
Note: Storing all images during a test may cause a delay due to traffic and
increase the storage needs on the ALM repository.
= Enable storing of all images for a failed test. (Default) Enables the storing
of all images for a failed test during a run.
= Enable storing of all images for a failed step (tests with steps only).
Enables the storing of all images for a failed step during a run.
= Disable storing of images. Disables the storing of any images during a run.

o Regardless of your selection, you can always attach screen captures to defects,
both during your test, and at the end of your test from the test results.

Allow Enable recording and running macros in Sprinter. Macros are available only for tests
macros | rynin Sprinter using Power Mode.

Allow Enable Sprinter's Data Injection feature, allowing you to automatically enter data into
Data fields in your test application. Data Injection is available only for tests run in Sprinter
Injection :

using Power Mode.

Allow Enable adding, deleting, and modifying the name or description of steps in a test.
editing
of steps | If this option is cleared, you are still able to modify the actual results of a step and
in add screen captures to steps.
Sprinter
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ul Description

Elements

Allow Enable attaching movies to defects when opening a defect from Sprinter's Tools
attac_hing sidebar, Workspace Tools sidebar, or from the test results.

movies

to ¢ Maximum movie length (minutes). The maximum length of the movie that you
defects can attach to a defect. The movie length for each defect is set in Sprinter's Smart

Defect Settings dialog box. You can attach a movie to a defect, of a size that is
up to the length of time defined by this setting. The maximum allowable length of
amovie is 10 minutes.

Note:

= Increasing the length of movies that can be attached to defects may cause
adelay in the time it takes to submit a defect to ALM and increase the
storage needs of your ALM server.

= The length of the movie you can attach to a defect may be limited by the
maximum size of an attachment you are allowed to attach to a defect in
ALM.
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Troubleshooting and Limitations - General

This section describes troubleshooting and limitations for Sprinter.

Sprinter Integrations

Sprinter stores user information in Application Lifecycle Management, in the Sprinter folder in the
Resources folder. You should not modify this folder.

When the Application Lifecycle Management Test Instances Filter dialog box is open, if you
navigate away from the dialog box, you may need to press ALT+TAB (for local machines) or
ALT+INSERT (for remote machines) to return to the dialog box.

Sprinter Service Pack 11.52 and QuickTest Professional 11.00 cannot be installed on the same
machine. Sprinter Service Pack 11.52 and UFT can be installed on the same machine.
However, you may be unable to run tests in Power mode while UFT is running.

Installing Sprinter Service Pack 11.52 may interfere with a manually entered UFT registry entry
"AbortlfHangInSendData" under HKEY_LOCAL_MACHINE\SOFTWARE\Mercury
Interactive\QuickTest Professional\MicTest\.

Workaround: On machines with UFT 11.50, add this registry entry manually after the Sprinter
installation.

Sprinter Agent Timeout

During Steps Capture or Run Test startup, the first time you perform the operation on a given

machine, a popup message may report that the Sprinter Agent is not responding. This may indicate

that the initialization of the agent exceeded the allotted time.

Workaround 1: (per machine)

Repeat the operation several times. If you do not succeed, refer to Workaround 2.

Workaround 2: (per machine)

1.

2.

Close Sprinter.

Increase the agent's initialization time. Open the Sprinter.exe.config file located in Sprinter's
bin folder and locate the entry Initialize:80. Increase its value, for example to Initialize: 280.

Start Sprinter and repeat the problematic operation (Steps Capture or Run Test startup).

If the operation succeeds, open the above Sprinter.exe.config file that you modified earlier.
Revert to the original value—Initialize: 80.
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Sprinter Ports

By default, Sprinter chooses ports during runtime. You can control the ports used by Sprinter when
it communicates with the agent and other clients. This may be required if you are working over a
firewall.

To set the ports, modify Sprinter's configuration files, located in the installation's bin folder.
Uncomment the appropriate keys according to the table below. Accept the default value or provide
a custom port.

Key to uncomment

File to Edit Affected Process and edit
Sprinter.exe.config The port number to use by the | <!--<add
TCP listener at the Sprinter.exe | key="Port.IMnR.Tcp"
process (to enable requests value="9091"/>-->
from the AImClient.exe
process).
SprinterRTE.exe.config The port number to use by the | <!--<add
TCP listener at the key="Port.-

SprinterRTE.exe process (to Station. Tcp"
enable requests from the value="9092"/>-->
Sprinter.exe process).

SprinterAgent.exe.config The port number to use by the | <l--<add

TCP listener at the key="Port.Agent.Tcp"
SprinterAgent.exe process (to | value="9093"/>-->
enable requests from the
Sprinter.exe process).

The changes will take affect the next time you start Sprinter or the Sprinter Agent. (To restart the
Agent, right-click its tray icon and select Exit. To start it again, select Sprinter Agent from the
Start menu.)

For additional information about each of the settings, refer to the comments in the configuration
files.

Note: This configuration only allows you to run a single instance of Sprinter per machine.
Therefore, you will be unable to run multiple instances of Sprinter on terminal servers or Citrix
environments on the same machine.
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Creating Tests and Business
Components

This chapter includes:

Concepts

o "Test and Component Authoring Overview" on next page

Tasks

o "How to Author a Test or Component" on page 70

Reference

o "Plan Area" on page 73

e "Things to Remember When You Work with the Tests and Components List " on page 77
e "Open Dialog Box" on page 78

e "Save/Save As Dialog Box" on page 80

e "Check Out Dialog Box" on page 83

e "Check In Dialog Box" on page 84

o "Definitions Group (Test/Component Tab)" on page 85
e "Steps Tab" on page 93

e " Callto Test Dialog Box" on page 100

¢ " Select Application Dialog Box" on page 102

o "Capture Sidebar" on page 104

o "Captured Steps Sidebar" on page 106
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Test and Component Authoring Overview

Sprinter's Plan mode enables you to create and edit tests or components directly in Sprinter and
save them to the Application Lifecycle Management. You can create and edit steps manually in the
Steps tab, or use Steps Capture to automatically generate steps based on your user actions. You
can then add screen captures or attachments to steps. You can define input parameters for each
step, and also output parameters for components.

For task details, see "How to Author a Test or Component" on next page"How to Author a Test or
Component" on next page.

For user interface details, see "Plan Area" on page 73.
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How to Author a Test or Component

This following steps describe how to create and manage tests and components in Sprinter.
This task includes the following steps:

o Prerequisites

o Create a new test or component

e Open an existing test or component

o Manage version-controlled tests or components
o Manually add and edit steps

o Automatically add steps using Steps Capture

o Manage step parameters

o Manage step attachments

« Manage component snapshots

e Save the test

Prerequisites
Ensure that you have the required user permissions and connect to Application Lifecycle
Management as described in "How to Get Started with Sprinter" on page 46. Make sure that the

toolbar shows Plan mode W

Create a new test or component

il
o Tocreate anew test, click the New button s=w in the Plan area. A new test is added to the
Tests and Components list.

o Tocreate a new business component, select New > New HP ALM Business Component. A
new business component is added to the Tests and Components list.

Open an existing test or component
Ik
e Toopen atest, click the Open button oe=n in the Plan area.
e Toopen abusiness component, select Open > Open HP ALM Business Component.
If you are already connected to Application Lifecycle Management, the Open dialog box opens,

enabling you to select which Application Lifecycle Management tests or components you want to
open.
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If you are not connected to Application Lifecycle Management, the Application Lifecycle
Management Connection dialog box opens enabling you to first enter the server information. For
details, see "Application Lifecycle Management Connection Dialog Box" on page 52.

For details on the Open Application Lifecycle Management Test/Component dialog box, see the
"Open Dialog Box" on page 78.

Manage version-controlled tests or components

o
version= |f you open a test or component from an Application Lifecycle Management project that
supports version-control, the test or component opens in read-only mode unless you have already

checked it out. The following functionality is available from the Plan area's Versions menu for
managing version-control:

o Toenable editing, use the Check Out option. The test or component is checked out for you, and
only you can edit its contents. You can only check out the last version—not older versions.

o Torelease the check out of the test or component, use the Check In option. The test or
component is checked in to the Application Lifecycle Management project, and other users can
now check out and edit that test or component.

¢ To cancel the check out of the test or component without changing the version number or saving
any changes that you made to it, use the UndoCheck Out option. The test or component is
checked back in and all changes that you made after the check out are lost.

For details on the Check Out dialog box, see the "Check Out Dialog Box" on page 83.

For details on the Check In dialog box, see the "Check In Dialog Box" on page 84.

Manually add and edit steps
Use the Steps tab to:

o add, edit, move, and delete test or component steps

o import steps from Excel or CSV files

o format steps using rich text editing capabilities

o add screen captures and attachments to steps

o insert calls to an external Application Lifecycle Management test
o insert parameters to steps

For details, see the "Steps Tab" on page 93.

Note: It is recommended that you limit the content of all fields that support rich text, such as
Description, to 2500 characters.
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Automatically add steps using Steps Capture

In the Steps tab, select an application for your test and then click the Steps Capture button to
navigate within your application and perform typical user actions. For details, see "Steps Tab" on
page 93.

While you perform actions, Sprinter captures them and converts the actions into steps. Using the
Captured Steps sidebar, you can define whether to convert each user action to a step or to group
multiple user actions into steps. For details, see "Captured Steps Sidebar" on page 106.

Manage step parameters
Add parameters to your test or component using the Test/Component tab's Parameters pane. You
can then associate these parameters with steps in the Steps tab.

Note: Fortests, only input parameters are supported. For components, input and output
parameters are supported, per component.

For details on the Parameters pane,see "Parameters Pane (Plan Mode Definitions Group)" on page
88.

Manage step attachments (tests only)

Use the Test tab's Attachments pane to add and remove test attachments.
This pane is not available for components.

For details on the Attachments pane, see "Attachments Pane (Plan Mode Definitions Group)" on
page 91.

Manage component snapshots (components only)

Use the Snapshots pane to add, annotate, or remove screen captures for components. These
screen captures are then saved with your component in Application Lifecycle Management.

This pane is not available for tests.

For details on the Snapshots pane, see Snapshot Pane (Plan Mode Definitions Group).

Save the test or component in Application Lifecycle Management
In the Tests and Components pane, do one of the following:

o Click the Save button. The Save dialog box opens for tests or components that you save for the
first time.

« Select Save > Save As. The Save As dialog box opens and allows you to save your test or
component under another name.

For details on the Save/Save As dialog box, see "Save/Save As Dialog Box" on page 80.
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Plan Area

This area enables you to create, open, and save tests and components.

Tasks you can accomplish with the Plan area:
o "How to Author a Test or Component" on page 70

The following image shows the Plan area.

Plan 7
il I
& |. - .-_q} - - IE -
MNew Open Save ‘ersions

..Tests and Components

Mame Location
Mew Test 1 SubjectiDemo
Mew Component 1 Components\Demo

To access 1. Start Sprinter and close the Welcome window, if open.

2. Click Plan in the Sprinter title bar.

Management first.

Important If you are not connected to Application Lifecycle Management and you create or
information | 5pen a test or component, the "Application Lifecycle Management Connection
Dialog Box" on page 52 opens, enabling you to connect to Application Lifecycle

page 77

See also "Things to Remember When You Work with the Tests and Components List " on
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Element

Description

Creates a new test or component and adds it to the Tests and Componentslist.
Drop-down options:

o New HP Application Lifecycle Management Test. (Default) Adds a new blank
test to the Tests and Components list.

e New HP Application Lifecycle Management Business Component. Adds a
new component to the Tests and Components list.

Open

Adds an existing test or component to the Tests and Components list.
Drop-down options:

e Open HP Application Lifecycle Management Test. (Default) Opens the Open
ALM Test dialog box. The tests you select are added to the Tests and
Components list.

e Open HP Application Lifecycle Management Business Component. Opens
the Open ALM Business Component dialog box. The components you select are
added to the Tests and Components list.

For details, see "Open Dialog Box" on page 78.

Save

Opens the "Save/Save As Dialog Box" (described on page 80), which enables you
to save the items in the Tests and Components list.

Shortcut key: Ctrl+s
Drop-down options:
e Save. Saves the selected test or component.

e Save As. Saves a copy of the selected test or component to the specified
location.

Note: The save options are disabled when more than one test or component is
selected.
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ul
Element Description
2 Enables you to manage versions of tests and components.

Drop-down options:

e Check Out. Checks out the test or component from HP ALM.

e Check In. Checks the test or component into HP ALM.

¢ Undo Check Out. Cancels the check out of the test or component and discards
all of the changes made since it was checked out.

Notes:

e These options are enabled only when you are connected to an Application
Lifecycle Management project that supports version control.

o Viewing version history and baseline history of tests and components is not
supported.

Important:

o Before upgrading a project in ALM, make sure to check-in all Sprinter files in the
Test Resources module.

Name The list of open tests and components.

Notes:

e When you select a test or component, the details pane displays the Definitions
Group for that test or component. For details, see the "Definitions Group
(Test/Component Tab)" on page 85.

¢ An asterisk next to a test or component name indicates the test or component
has changes that have not been saved.

o A warning symbol /4. next to a test or component indicates a problem with the
definitions of the test or component or in the Steps tab. When you select the test
or component, the warning symbol is also displayed adjacent to the node in the
Definitions group or step, that is causing the warning. Select the node and
review the displayed definitions for any warning messages. For details, see the
"Definitions Group (Test/Component Tab)" on page 85.

¢ Alock symbol & next to a test or component indicates that it is currently locked
(in a non-versioned project) or checked-out to another user (in a versioned
project).
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ul
Element Description
<Context | The following options are available from the context menu, when you select a test
menu or component from the list.
(right-
click) e Check Out. Checks out the test or components from HP ALM.
options>
e Check In. Checks in the test or components into HP ALM.
¢ Undo Check Out. Cancels the check out of the test or component and discards
all of the changes made since it was checked out.
« Remove. Removes the selected tests or components from the Tests and
Components list.
e Save. Saves the selected test or component.
e Save As. Saves a copy of the selected test or component to the specified
location.
<> Hide/Show. Hides or shows the Plan area.
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Things to Remember When You Work with the
Tests and Components List

e A warning symbol /. next to a test or component indicates a problem with the definitions of the
test or component or in the Steps tab. When you select the test or component, the warning
symbol is also displayed adjacent to the node in the Definitions group or step, that is causing
the warning. Select the node and review the displayed definitions for any warning messages. For
details, see "Definitions Group (Test/Component Tab)" on page 85.

e Alock symbol & next to a test or component indicates that it is currently locked by another user
(in a non-versioned project) or checked-out by another user (in a versioned project).

o Forafull description of all the features in the Tests and Components list, see "Plan Area" on
page 73.
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Open Dialog Box

This dialog box enables you to open a test or component from Application Lifecycle Management.
For tests, you open a test from the Application Lifecycle Management Test Plan module. For
components, you open a component from the Application Lifecycle Management Business
Components module.You can filter the tests or components that are displayed to make their
selection easier.

Tasks you can accomplish with the Open dialog box:
¢ "How to Author a Test or Component" on page 70

The following image shows the Open dialog box.

Open [ o=
Fal

Yy B O|l% @

Filter Select Columns Refresh | Select All Deselect All

4 E Root Cenfiguration: Name Test: Test Name Status Re *

(3 unattachea ] []order flight order flight Mot Completed ela
4 [ demo
JI, demcFlight
.......... — .

Selected tests: 0 | Cancel |

To access | Inthe Plan area, selectOpen > Open HP Application Lifecycle Management
Test or Open > Open HP Application Lifecycle Management Business
Component.

Important The options in this dialog box are identical when opening tests and components.
information

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

Y Opens the Filter dialog box, enabling you to filter the tests or components based
A on specific criteria. For details, click Help in the Filter dialog box.

1IN Opens the Select Columns dialog box, enabling you to select the columns to
Seeet Columns display. For details, click Help in the Select Columns dialog box.
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Ul Elements Description

Reloads the data from HP ALM.

R

Refresh
I{;z Selects all the currently displayed tests or components in the list.
Select Al
% Deselects all the currently displayed tests or components in the list.

Deselect All

<folder list> | Located on the left side of the dialog box. Displays all the test or component
folders available in your project.

Note: You cannot move items within a folder.

<Test list>/ Located on the right side of the dialog box. The list of tests or components in the

<Component | gejected folder in the folder list. Select the check boxes next to the tests or

list> components you want to open in Sprinter.
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Save/Save As Dialog Box

This dialog box enables you to select a location in which to save your test or component.

Tasks you can accomplish with the Save/Save As dialog box:

o "How to Author a Test or Component" on page 70

The following image shows the Save As dialog box.

Save As 2 X7
E W o=
Mew Folder Refresh
4 [ subject Test Name i
] Unattached 5, Calc
B Mew Test2
= Name: | Copy of New Test 1 | [FFORTI - Cancel |

To access In the Plan area, do one of the following:

e Click Save or press CTRL+S

o Select Save > Save As
Important e The options in the Save dialog box are identical to the options in the
information

Save As dialog box.

The options in the Save/Save As dialog box are identical when saving
tests or components.

The Save dialog box opens for tests or components that you save for
the first time.

The Save As dialog box opens and allows you to rename a tests or
component.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element Description

B Opens the " New Folder Dialog Box" (described on page 82), which enables you
e Finkles to add a folder under the currently selected folder in the folder list.

'S Refreshes the pane of the selected folder displaying its current contents.
Refresh

<folder list> | Located on the left side of the dialog box. Displays all the tests or components
folders available in your project.

Note: You cannot move items within a folder.

<Test list>/ Located on the right side of the dialog box. The list of tests or components in the

<Component | gelected folder in the folder list.
list >
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% New Folder Dialog Box

This dialog box enables you to create a new folder in Application Lifecycle Management in which to

save your test or component.
Tasks you can accomplish with the New Folder dialog box:
e "How to Author a Test or Component" on page 70

The following image shows the New Folder dialog box.

New Folder | 7 x|
Name: || |
Enter the name of the new folder.
To access In the Save/Save As dialog box, click New Folder.
See also "Save/Save As Dialog Box" on page 80

Descriptions of the user interface elements are shown when you hover over them.
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Check Out Dialog Box

This dialog box enables you to add a comment that will be associated with the checkout.

Tasks you can accomplish with the Check Out dialog box:

e "How to Author a Test or Component" on page 70

The following image shows the Check Out dialog box.

Check Cut

Change comments:

7 ™=

“ersioning sanity 1

To access

In the Plan area, select Versions > Check Out.

Important information

You can only check out the latest version.

See also

"How to Author a Test or Component" on page 70

User interface elements are described below:

Ul Element

Description

Change Comments

A text area for describing the reason for the check out.
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Check In Dialog Box

This dialog box enables you to add a comment that will be associated with the checkin.
Tasks you can accomplish with the Check In dialog box:
e "How to Author a Test or Component" on page 70

The following image shows the Check In dialog box.
Check In e
The version number will be increased by one.

Change comments:

“ersioning Test 1

[T Keep checked out

To access In the Plan area, select Versions > Check In.

Important information After the checkin, the version number will be increased by one.

See also "How to Author a Test or Component" on page 70

User interface elements are described below:

]

Element Description

Change A text area for describing the change.

comments

Keep Keeps the test or component checked out. This is ideal for:

checked

out o Creating a new test version. When you enable this option, provide a comment,

and click OK. Sprinter creates a new version of the test in ALM.

o Entering comments while still working in a change.
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Definitions Group (Test/Component Tab)

The Plan mode's Definitions group is located in the left side of the Test or Component tab in the
main window.

This group includes the following panes:
o "Details Pane (Plan Mode Definitions Group)" on next page
o "Parameters Pane (Plan Mode Definitions Group)" on page 88

o "Attachments Pane (Plan Mode Definitions Group)" on page 91 (Tests only)

Snapshot Pane (Plan Mode Definitions Group) (Components only)

The Parameters and Attachments nodes indicate in parenthesis the number of included items for
the selected test or component.

| E5 Definitions

Dietails

Parameters {3)

Attachments (1)
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Details Pane (Plan Mode Definitions Group)

This pane displays the test or component details.

Tasks you can accomplish with the General Settings:

e "How to Author a Test or Component" on page 70

The following image shows the Details pane.

Details

Name:

Location:

Designer:

Creation date:

New Test 3

CSprinterTests\New Test 3. spt

user

71232012

Description:

A zample Sprinter test

Comments:

The following image shows the Details pane for tests.
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Details

Name: Mew Test 1

Location: SubjectiDemo

Designer. admin

Creation date: 313/2012

Status: Design

Description:

Comments:

To access | Do the following:

1. Inthe Plan area, select a test or component in the Tests and Components
list.

2. Click the Test or Component tab in the right pane.

3. Select the Definitions > Details node.

Important The Details pane for tests has a read-only Designer field.
information

e The Details pane for components has a read-only Created by field.
o If yourtest or component has user-defined fields, they are displayed and can
be edited in the Details pane.

e You can save tests and components only after you enter information in
mandatory user-defined fields (marked with an asterisk), if they were defined
for the project.

Descriptions of the user interface elements are available when you hover over them.
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Parameters Pane (Plan Mode Definitions Group)

This pane enables you to create parameters and edit their details. It displays existing parameters

and allows you to edit their values.
Tasks you can accomplish with the Parameters pane:
o "How to Author a Test or Component" on page 70

The following image shows the Parameters pane for tests.

1Y I
Rl AL
Mew Delete | Move Up Move Down Filter
Parameters
Is Uzsed Name Default Value Description
Date Todays' date
w  Username JohnDoe The defautl user name
Total The total amount of the transaction

The following image shows the Parameters pane for components.

<Py % ﬂ ?
o v * b 4 -
New Delete | Move Up Move Down | Filter

In Parameters

Iz Used Mame
InParametert

Is Encrypted  Description

Default Value
& A sample Input parameter

Out Parameters

Iz Used Mame Description
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Ul Example - . I N ¥ | T.
components Mewr Delete | Move Up Move Down |  Filter
In Parameters
Is Used Mame Default \Value Iz Encrypted  Description
InParameter ettt A sample Input parameter
Qut Parameters
Iz Used  Mame Description
Click thumbnail to view full size image.
To access Do the following:
1. Inthe Plan area, select a test or component from the Tests and
Components list.
2. Click the Test or Component tab in the right pane
3. Select the Definitions > Parameters node.
Important For tests, only input parameters are supported. For components, both input
information and output parameters are supported.

User interface elements are described below:

ul
Elements Description
Y Adds a new input parameter for tests.
Mew
ff; . Adds a new input or output parameter (for components only). The drop-down

provides these options:
¢ New Input Parameter (default)

e New Output Parameter
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ul
Elements Description
) 4 Deletes the selected parameters from the list.
Delete
s Moves the selected parameter up the list.
Move Up
T Moves the selected parameter down the list.
Mowve Down
Y Enables you to filter the parameter list according to a text string.
Filter
Note: You can use plain text with the wildcard, *.
Is Used Indicates whether the parameter is used by the test or component.
Name The name of the parameter.
Default The default value for an input parameter.
Value
Value The value of the parameter.
Available only for: output parameters in components
Is Indicates whether to encrypt the parameter. This option is automatically selected
Encrypted | if the parameter is already encrypted in ALM.
Available only for: input parameters defined for components
Description | A description of the parameter and its purpose.
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Attachments Pane (Plan Mode Definitions Group)

This pane displays and enables you to manage attachments that are used in your test. This pane is
not available for components.

Tasks you can accomplish with the Attachments pane:
o "How to Author a Test or Component" on page 70

The following image shows the Attachments pane.

=H
L] \:I %
Add Attachment Open Attschment Delete
Attachments
Name Description
[E] NTUSERDATLOG
._.j indezx.dat
To access Do the following:

1. Inthe Plan area, select a test from the Tests and Components
list.

2. Click the Test tab in the right pane.

3. Select the Definitions > Attachments node.

Important information | This pane is only available for tests.

User interface elements are described below:

Ul
Elements Description
(ks Adds an attachment to the list.

Add Attachment

=g Opens the selected attachment in an external application, corresponding to the
Desnfitsenment | gttachment's file type.

Note: To open the attachment, the associated application must be installed on
your computer.
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LEjllements Description
) 4 Deletes the selected attachment from the list.
Delste
Name The file name of the attachment.
Description | A textual description of the attachment.
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Steps Tab

This tab displays the steps in your test or component and enables you to edit, move, and delete
steps. You can also add attachments, calls to external Application Lifecycle Management tests,
and screen captures.

Tasks you can accomplish with the Steps tab:
e "How to Author a Test or Component" on page 70

The following image shows the Steps tab for a manual test.

| New Test 1 ?

Test Steps (3)

ﬁf i S CutSteps M nsert Parameter gl Call to Test A F Q
&% o
sinn s [25 Copy Steps &, (1. Add Atiachment 22 Import Steps

Add  Steps Capture Font Paragraph Find

Paste Steps 3§ &8 Screen Capture +
Step
| |;';:=.H Mame Description

1 | 10| Click the ==<MyParam==>"link

2 Click the "Help' link

3 ‘Wait for the page to synchronize Synchrenize in under 10 seconds

To access | Do the following:

1. Inthe Plan area, select a test or component from the Tests and
Components list.

2. Click the Steps tab.

Important e You can resize the Sprinter window and the columns in the display to view all
information the information.

¢ Right-click the column header area to select which columns to display.

o Parameters in steps are represented by <<<parameter name>>>. If a
parameter was deleted from the Parameters list, it is displayed as <parameter
name>.

See also "Capture Sidebar" on page 104

The Steps tab contains a ribbon and a grid representation of the steps.

Steps Tab - Ribbon
The Ribbon contains the Step, Font, Paragraph, and Find sections.

Step Section
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The ribbon's Step section lets you manage the test's or component's steps. The following table

describes the user interface elements:

ul
Elements Description
Adds a new step to the steps grid.
& -
s Drop-down options:
o After Current Step (Default) (ALT+N)
o Before Current Step (SHIFT+ALT+N)
o After All Steps (CTRL+ALT+N)
K- Starts a Steps Capture session, in which you navigate your application and
sré:; perform user actions as you would in a regular run session. Sprinter captures each
Copte user action, converts it to a step, and adds it after the selected step in the steps
grid.
For details on the functionality available with a Steps Capture session, see
"Captured Steps Sidebar" on page 106.
G cutsteps | Cut/Copy/Paste Steps. Allows you to use cut, copy, and paste individual or
“» Copy Steps

7] Paste Steps

multiple steps.

]

Sy

L

Move Step Up/Down. Moves the selected step up or down the steps grid.

Delete Steps. Deletes the selected steps.

Insert Parameter. Opens the "Insert Parameter Dialog Box" (described on page
98), which enables you to insert a parameter at the cursor's location in the
Description or Expected Results fields.

Add Attachment. Adds a file from the file system as an attachment to the selected
step (tests only).
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, continued

Ul
Elements

&

Description

Screen Capture. Enables you to add a screen capture to the selected step
(ALT+C).

Drop-down options:

Take Screen Capture. Opens the Capture sidebar, allowing you to take a
screen capture of the desktop and attach it to the selected step. For details, see
"Capture Sidebar" on page 104.

Delete Screen Capture. Removes the attached screen capture from the
selected step.

Call to Test. Opens the " Call to Test Dialog Box" (described on page 100), which
enables you to insert a call to an external Application Lifecycle Management test as
a step in your test. When you run your test, the steps of the external test are
displayed in the Steps sidebar.

Note: You can only insert calls to manual tests.

o
-

Import Steps. Enables you to import steps from an Excel or CSV file.

The imported file should comply with the following guidelines:

The table must be located in the workbook's first sheet.

The steps must be declared in a table structure, with the headers on the top and
the step data beneath them.

The table's headers must match the columns in the Steps pane. For CSV files,
make sure the header row is separated from the data row with a character
defined as a common separator in the machine's locale.

The standard columns (Name, Description, Expected Result) can have either
an English or local language title.

When importing steps from a CSV file in a non-English operating system in
which the separator is not a comma, all data appears in a single column. For
example, in German Windows 7, the default separator, a semicolon, is ignored.
Workaround: Change the default separator in your locale to a comma. Select
Control Panel > Regional and Language > Additional Settings. Change the List
separator value to a comma.

User defined (UDF) column names should be identical to the field's label in ALM
Customization.
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Font Section

The ribbon's Font section lets you format text in fields using rich-text capabilities, such as
Description and Expected Result, or user-defined fields of Memo type. It includes the following
standard controls:

¢ Select a Font

¢ Setthe Font Size

¢ Increase/Decrease Font Size

o Set the Text Highlight Color

o Set the Text Color

¢ Set Text Decoration: Bold/Italic/Underline
¢ Remove Text Formatting

Paragraph Section

The ribbon's Paragraph section lets you set the paragraph properties to text in the Description and
Expected Result fields. It includes the following standard controls:

Create Bulleted Entries

Create Numbered Entries

o Indent Right/Left
o Align Text Left/Center/Right/Justify

Find Section

The ribbon's Find section lets you search the text associated with the steps. The following table
describes the user interface elements:

ul
Elements Description

<search | The text tofindinthe search in the steps. You can search for text in the Name,
text> Description or Expected Results fields, or in any user-defined field.

¢ ™ Search Down/Up. Allows you to choose the direction of the search.

Match Instructs the search engine to find a whole word.

whole

word

Steps Tab - Steps Grid

The Steps grid shows the tests or components in a grid representation. The following table
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describes the user interface elements (unlabeled elements are shown in angle brackets):

Ul Elements Description

o]

Screen Capture. Indicates whether a screen capture is attached to the

selected step. The Screen Capture icon [ indicates that a screen capture
exists.

Name The name of the step.
Default value (for new steps): Step <NUMBER>
Description A textual description of the step.

Tip: This field supports rich-text.

Expected Result

The expected result of the step.

Tip: This field supports rich-text.

<user-defined (Optional) If your Application Lifecycle Management project has user-

fields> defined fields, they are displayed in the steps grid by their logical names. A
red asterisk in the header of a user-defined field, indicates that the field is
mandatory—you must provide a value.

Attachments The list of files that are attached to the step (tests only).

<Context menu
(right-click)
options> - Steps
column

The following options are available when you right-click the Step number
column in the Steps grid:

e Cut Steps (CTRL + X)

e Copy Steps (CTRL + C)

e Paste Steps (CTRL + V)

o Add Step Before Current Step (SHIFT + ALT + N)
o Add Step After Current Step (ALT + N)

e Delete Step (CTRL + DEL)

<Context menu

The following options are available when you right-click editable text in the

(right-click) steps grid:
options> -
editable text e Cut
columns
e Copy
o Paste
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Insert Parameter Dialog Box

This dialog box enables you to select a parameter from alist to insert and use in a step. You can
also add a new parameter to the list.

Tasks you can accomplish with the Insert Parameter dialog box:

o "How to Author a Test or Component" on page 70

The following image shows the Insert Parameter dialog box for tests .

Insert Parameter

T o

New Filter

=

Is Used Mame
Sample Param 1

v Sample Param 2

Default Value

1234567

Description

The following image shows the Insert Parameter dialog box for components.

Insert Parameter

<>
S v ? -
New Filter

[~ B

In Parameters

Is Used Name
InParametert

Default Value

Is Encrypted

Description

Test Input Parameter

Out Parameters

Is Used Name
OutParameteri

Description
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ul Example - Insert Parameter [~
Components .7
Mew Fitter
In Parameters
Is Used Name Default Valus Is Encrypted  Description
InParameteri Test Input Parameter
Out Parameters
Is Used Name Description
DOutParameter!
Click thumbnail to view full size image.
To access Do the following:
1. Inthe Steps Table, click within a step's Description or Expected
Result column.
2. Click Insert Parameter.
Important For tests, only input parameters are supported. For components, input and
information output parameters are supported.
See also "New Parameter Dialog Box" on next page
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New Parameter Dialog Box

This dialog box enables you to define a new parameter to add to the list of available parameters.
Tasks you can accomplish with the New Parameter dialog box:
¢ "How to Author a Test or Component” on page 70

The following image shows the New Parameter dialog box.

New Parameter [~

Mame |InPa’ameter2 |

Description | |

Default Value | |

The default value for the parameter.

Is Encrypted ]

To access | Inthe "Insert Parameter Dialog Box" on page 98, click New.

Important e Thels Encrypted option is only available for input business components.
information When checked, the Default Value field shows an encrypted value and is not
editable.

¢ You can also add parameters directly to the "Parameters Pane (Plan Mode
Definitions Group)" (described on page 88).

Call to Test Dialog Box

This dialog box enables you to insert a call to an external Application Lifecycle Management test as
astep in your test. When you run your steps, the steps of the external test are displayed in the
Steps sidebar. This feature is not supported for components.

Tasks you can accomplish with the Call to Test dialog box:
« "How to Author a Test or Component” on page 70

The following image shows the Call to Test dialog box.
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Call to Test =T
Yy m G
Fiter Select Columns Refresh
« = Subject Test Hame Template Greation Date Modified Status
Unattached By New Test2 1212012011 12420/2011 3:32 PM Design
EI dlEMmp B Calet 1162012 116/2012 11:07 AM Design
Show Only Template Tes.ts “ | Cancel |
To access In the "Steps Tab" on page 93, click the Call to Test button.
Important information e Youcanonly insert calls to manual tests.
o Callto Test is not supported for components.

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

Y Opens the Application Lifecycle Management Filter dialog box, enabling you to filter
e the tests based on specific criteria. For details on filtering tests and components,
click Help in the Test Instances Filter dialog box.

N Opens the Application Lifecycle Management Select Columns dialog box, enabling
seestslmes | you to select which columns to view in the dialog box. For details on selecting
columns, click Help in the Select Columns dialog box.

'S Refreshes the pane of the selected folder displaying its current contents.
Refresh

<folder Located on the left side of the dialog box. Displays all the test folders available in
list> your project.

Note: You cannot move items within a folder.

<Test Located on the right side of the dialog box. The list of tests in the selected folder in
list> the folder list. Select the test you want to call.

Show Filters the test list to display only template tests.

only

template | Default state: Selected

tests
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Select Application Dialog Box

This dialog box enables you to define or select the application that your test will use. You can also
add, edit, or delete existing applications.

Tasks you can accomplish with the Select Application dialog box:
e "How to Author a Test or Component" on page 70

The following image shows the Select Application dialog box when there are previously defined
applications.

e x|

0L 2 X o

Quick Add  Add Edit Remowe

Application: |r\.-le'c uty Tours | - |

Mercuty Tours - Details

Type: Web application
URL: http:ifnewtours demoaut com
Browser: Intemet Explorer

Technologies: Web

Run Settings:

Sprinter will start the application when the run begins.

To access | Do the following:

1. Enter Plan mode.

2. Open or create a new test or business component.
3. Select the Steps tab.

4. Expand the Steps Capture button and choose Select Application from the
drop-down.

Important For details on how Sprinter maintains the list of applications, see "How User
information | |nformation is Maintained" on page 44.

See also The functionality of this dialog box is similar to the functionality for managing
applications when working in Run mode. For details, see "Applications" on page
207.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul
Elements

é—n1

Quick Add

Description

Opens the "Quick Add Application Dialog Box" (described on page 221), enabling
you to add an application to your application list from a list of currently running
applications.

[d

Add

Opens the "Add/Edit Application Dialog Box" (described on page 216), enabling
you to manually define a new application to add to your application list.

[z

Edit

Opens the "Add/Edit Application Dialog Box" (described on page 216), enabling
you to edit the application details for the selected application in the application list.

* Removes the selected application from the application list.

Femove

Application | The list of available applications. Use the Add, Quick Add, Edit, and Remove
buttons to manage the list of applications.
To use a previously defined application, enter the first character of the name and
then select it from the displayed list.
For details on how Sprinter maintains the list of applications, see "How User
Information is Maintained" on page 44.

Application | Displays information about the application you selected in the Application list.

details area | cjick the Edit button to open the "Add/Edit Application Dialog Box" (described on
page 216) and edit these details.
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Capture Sidebar

This sidebar enables you to add a snapshot to a business component or to a test or component
step.

Tasks you can accomplish with the Capture sidebar:
e "How to Author a Test or Component" on page 70

The following image shows the Capture sidebar.
g
o o] X

Capture A

To access - Component To add a Component snapshot:

shapshot
1. Inthe Plan area, select a component in the Tests and

Components list.

2. Intheright pane, select the Component tab and click on the
Snapshot node.

3. Click the Screen Capture button.

To access - Step snhapshot | To add a Step snapshot:

1. Inthe Plan area, select an entry in the Tests and
Components list.

2. Intheright pane, select the Steps tab.

3. Click the Screen Capture button.

Important information ¢ Toclose the sidebar, click the Cancel E4 button.

o Tolock the sidebar in the open position, click the thumbtack

P icon.

o Toreposition the sidebar, click and drag on the sidebar
header.

User interface elements are described below:

]

Elements Description

=] Capture. Captures the current screen and closes the sidebar.
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ul
Elements Description

ol Annotate Screen Capture. Captures a screenshot of the screen and opens it in the
annotation workspace. For details, see the "Annotation Tools Sidebar" on page 183.

Ed Cancel. Ends the capture session without performing a screen capture.
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Captured Steps Sidebar

This sidebar displays the steps that result from the user actions that are performed during your
Steps Capture session.

Tasks you can accomplish with the Captured Steps sidebar:
e "How to Author a Test or Component" on page 70

The following image shows the Captured Steps sidebar.

Captured Steps (7) ¥ ||

00| @~ &7 [F]k
[a]
1 | Click the "Sign-In" image.

i

Select the "Frankfurt” item from the "fromPort” combo box.

Select the "28” item from the "fromDay” combo box.

WM

Select the "New York" item from the "toPort” combo box.

n

Select the "Business” radio button in the "servClass” radio gr

Select the "Blue Skies Airlines” item from the "airline” combo

=l | @

Click the "findFlights" image.

To access | InPlan Mode, click the Steps tab's Steps Capture button.

e Toclose the sidebar, click the End Steps Capture Session ! button.

e Tolock the sidebar in the open position, click the thumbtack M icon.

e Toreposition the sidebar, click and drag on the sidebar header.

Important e The steps in this sidebar are displayed in read-only mode. To edit steps, first
information end the Steps Capture session and then edit the steps in the "Steps Tab" on
page 93.

o By default, multiple user actions are added to a single step, until you instruct
the Steps Capture tool to begin a new step. To automatically create a new step
for every action performed, click the Single User Action per Step button
described below.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

sl

End Steps Capture Session. Ends the Steps Capture session and adds the
captured steps to the Steps grid.

[N
[N

e Pause Capture. Temporarily pauses the capturing of user actions.

¢ Resume Capture. Resumes the capturing of user actions.

Tools to manage the screen captures:

e Screen Capture. Takes a capture of the screen and attaches it to the step
selected in the sidebar.

o Annotated Screen Capture. Opens the Annotated Tools sidebar. The annotated
screen capture will be attached to the step selected in the sidebar. For details,
see "Annotation Tools Sidebar" on page 183.

o Delete Screen Capture. Deletes the selected step's screen capture.

Delete Step. Deletes the selected step from the Steps grid.

Multiple User Actions per Step. Instructs Sprinter to add all user actions to the
last step.

Single User Action per Step. Creates a new step for each user action.

Start a New Step. Creates a new step to which Sprinter will add all future user
actions.

Note: This button is only relevant when Multiple User Actions per Step is
enabled.

Steps
Display
area

A grid representation of the steps showing:
Step number. The sequential number of the step.

Step. A textual description of the performed user action. When the Steps Capture
session ends, this text is added by default to the step's description area.
Alternatively, you can configure this to be added to the Step's Name field instead.
For details, see "Plan Settings Pane (Settings Dialog Box)" on page 58.

Capture. Anicon ! indicating that there is a screen capture associated with the
step. If noiconis present, the step has no screen capture.
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Running Tests

Throughout this guide, descriptions of features that are available only in Power Mode are
identified by the Power Mode"9 icon.

This chapter includes:

Concepts

o "Tests with Steps" on next page

o "Exploratory Tests" on page 110

¢ "Power Mode Overview" on page 111

e "Running Tests in Power Mode" on page 112

Tasks

e "How to Run a Manual Test in Sprinter" on page 114

« "How to Navigate Steps" on page 118

e "How to Mark Steps" on page 119

« "How to Edit and Add Actual Results and Attachments to Steps" on page 120
e "How to Run an Exploratory Test in Sprinter" on page 121

Reference

¢ "Run Setup Area" on page 124

e "Things to Remember When You Work with the Test Runs List " on page 123
o "Test <'Test Name': All Runs Dialog Box" on page 131

e "Open Dialog Box" on page 133

¢ "Run Setup Definitions Group" on page 135

o "Run Control Sidebar" on page 141

o "Steps Sidebar" on page 147

o "Generate Test Dialog Box" on page 161

"Troubleshooting and Limitations - Running Tests and Components " on page 162
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Tests with Steps

Sprinter enables you to run steps that you manually add to your test or those that you imported from
an external file.

When you run your test, the steps are displayed in the Steps sidebar. From the Steps sidebar you
can:

Navigate your steps

o Mark the status of your steps

¢ Modify the actual results of your steps

o Add attachments to steps

o Add screen captures to the actual results of your steps

o Edit your steps' details

o Submit defects

e Searchinyour steps

o View the parameters in your steps (Business Process Testing only)

The Steps sidebar also provides a Subtitles mode, which displays your step descriptions and
enables you to navigate and mark your steps in a one line subtitle, while providing more screen real
estate for your application.

When you finish your run, Sprinter saves your changes to the run results for your run If you made
changes to your steps' details, Sprinter prompts you to save your changes to the Test Plan module
in Application Lifecycle Management.

If your test is checked-in, Sprinter will automatically check it out, save your changes, and check it
back in. If your test is checked-out to another user, Sprinter will warn you that your changes cannot
be saved.
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Exploratory Tests

With Power Mode enabled, you can navigate your application without the need to follow predefined
steps. While you navigate your application, Sprinter captures each user action that you perform.

You can then export these user actions to a new manual test, to a Unified Functional Testing test,
or to an Excel file. For details, see "How to Run an Exploratory Test in Sprinter" on page 121.
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Power Mode Overview

When you run a Sprinter test in Power Mode, Sprinter is able to learn your application's display and
identify its objects. This ability gives you access to Sprinter's advanced functionality including data
injection, recording and replaying macros, and working with mirroring (replicating user actions on
multiple computers).

When you are in Power Mode, Sprinter keeps a record of all your user actions, which you can view
as alist or in the Storyboard at the end of your run. You can also include the list of your steps or user
actions in any defect you submit to let Sprinter automatically create a defect scenario for you.

You can export the list of user actions at the end of your run to an Excel spreadsheet, modify them
for use as steps, and then import them to a test in the future.

After a test run, you can use the test steps as a template and automatically generate a test. For
details, see the "Generate Test Dialog Box" on page 161.

Sprinter's built-in scanners let you scan your application for spelling errors, Web Standards errors,
broken links, or localization errors.

Power Mode allows you to take advantage of these advanced testing features. To use Power
Mode, click the Power Mode button in the "Main Window" on page 50 and configure each node in
the "Power Mode Group" on page 212.

For more details, see "Power Mode" on page 205 and "Running Tests in Power Mode" on next
page.
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Running Tests in Power Mode

When you run a manual test in Sprinter, you need to decide if you need to run your test in Power

Mode'? .

The following table summarizes the Power Mode features to help you decide if you need to run your

test in Power Mode:

Feature Description

Application

You must define an application for your test to use Power Mode. Defining an
application for your test also enables Sprinter to open the application
automatically when you start your test.

Sprinter saves settings and other user-specific configurations and applies this
information the next time you run Sprinter.

Many Power Mode configurations are associated with their specific application.

Because you define application for your test, all tests have the same defined
application will share the same Power Mode configuration.

For details, see:
e "Applications" on page 207
e "How User Information is Maintained" on page 44

o "Application Pane (Power Mode Group)" on page 214

Data Enables you to automatically enter data into fields in your application. For details,

injection see "Data Injection Overview" on page 228.

Macros Enables you to record a series of user actions that you can run as a single
command during your run. For details, see "Macros Overview" on page 244.

Mirroring Enables you to replicate the user actions in your test on another computer with a
different configuration (operating system, browser). For details, see "Testing on
Multiple Machines - Overview" on page 275.

Scanners Enables you to check that various aspects of your application behave correctly
during a run session. You can scan your application for spelling errors, broken
links (Web applications only), Web Standards errors (Web applications only), and
localization errors. For details, see "Scanners Overview" on page 255.
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Feature Description

Storyboard | Enables you to view a timeline of the user actions you performed on your test. The

Storyboard displays the defects, comments, and defect reminders for each action
in your test. For details, see "Storyboard Window" on page 201.

Comments | Enables you to add comments to user actions in your run. These comments can
be reviewed later in the Storyboard. For details, see "Comment Dialog Box" on
page 182 and "Run Results Overview" on page 188.

User Enables you to view a summary of the user actions in your test. For details, see
Actions "User Actions Pane/User Actions Summary Dialog Box" on page 198.
summary
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How to Run a Manual Test in Sprinter

The following steps describe how to run a manual test in Sprinter.

Sections marked with the Power Mode icon " are only relevant when Power Mode is active.

This task includes the following steps:

o Prerequisites

o Open atest or component

o Configure your test definitions

« Configure Power Mode

o Start your run and perform the user actions in your test
o Detect and submit defects

o Use data injection and macros in your test

o Use mirroring with your test

¢ Use scanners in your test

e Stop your run and view and analyze the run results

Prerequisites
Ensure that you have the required user permissions and connect to Application Lifecycle
Management as described in "How to Get Started with Sprinter" on page 46.

Open a test
You can open a test in one of the following ways:

o Open an Application Lifecycle Management test from within Sprinter.
(&
Click the Open button 2re=n in the Run Setup area.
If you are already connected to Application Lifecycle Management, the Open dialog box opens,

enabling you to select which Application Lifecycle Management tests you want to open.

If you are not connected to Application Lifecycle Management, the Application Lifecycle
Management Connection dialog box opens first, enabling you to connect to Application Lifecycle
Management, and then the Open dialog box opens.

For details, see the "Open Dialog Box" on page 133.

« Open an Application Lifecycle Management test from within Application Lifecycle
Management.
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= In Application Lifecycle Management, select the Test Lab module, and make sure that the Test

Sets tab is selected.

= Select the Execution Grid tab.

= Select the test, tests, or test set you want to run.

o Foratest set, click Run Test Set, and select Sprinter from the dialog box that is displayed.

[¢]

For an individual or multiple tests, click the down-arrow next to the Run button and select
Run with Sprinter. If you are continuing a previous run that was run with Sprinter, click

Continue run with Sprinter.

u

[E Run = JIL Run Test Set

X | o T-

il [ Run with Sprictsr

Fun weith Manual Runner

(I Cortinue run with Sprinter

Ctrl+At+F9

Once you open a test you can immediately skip to the following steps. All other steps are optional

based on your testing needs:

= Start your run and perform the user actions in your test

= Stop your run and view and analyze the run results

Configure your test definitions

When you configure your test definitions, you can view and edit your test details, run details,

parameters, and steps.

For details, see "Run Setup Definitions Group" on page 135.

2 Configure Power Mode
Before running your test with Power Mode, you need to configure Power Mode for the application
you are testing. Decide if you need use data injection, macros, and other advanced features
provided by Power Mode. For details, see "Running Tests in Power Mode" on page 112 and "How

to Prepare a Test to Run in Power Mode" on page 210.

o Set up Mirroring. Use the mirroring feature to replicate your user actions on multiple computers

with different configurations, such as operating systems, browsers, and so forth. To run a test

with mirroring, you must configure all the machine that you intend to use for your test.

For details, see "How to Prepare a Test for Mirroring" on page 284.

o Scanners. Use scanners to check that various aspects of your application behave correctly
during the run session, such as W3C compliance, broken links, spelling and localization. You

can also configure the Scanner settings during the run session. However, to display the
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Scanners sidebar, you need to configure settings for one or more scanners before the run
session begins.

For details, see "How to Scan Your Application For Potential Defects" on page 257.

Start your run and perform the user actions in your test
Click the Run button *~. For details, see the "Main Window" on page 50.

o Start your application.

P If you are running your test in Power Mode and did not configure Sprinter to start your
application when the run begins, you need to manually start your application.

Note: To enable Power Mode to work with your application, it is recommended that you
configure Sprinter to start your application when the run begins.
o If you are running a test with steps you can run those steps directly.

o You can perform the steps you imported to your local test from an external file as described in
the "Steps Tab" on page 93.

For details about running the test steps, see:

= "How to Navigate Steps" on page 118

= "How to Mark Steps" on page 119

= "How to Edit and Add Actual Results and Attachments to Steps" on page 120

o If yourtest does not have steps, you can begin your test run and perform exploratory user
actions. For details, see "How to Run an Exploratory Test in Sprinter" on page 121

Detect and submit defects

Sprinter enables you to submit defects to Application Lifecycle Management. You can also keep a
record of a defect, create a reminder to submit your defect later, or include a screen capture of a
defect in an email.

For details, see "How to Detect and Submit a Defect" on page 170.

7 Use data injection and macros in your test
If you are running your test with Power Mode, you can automatically enter data into forms in your
application using data injection and you can automate user actions with macros.

For details, see:
e "How to Inject Data into your Application" on page 231

e "How to Record and Run Macros" on page 245
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2 Use mirroring with your test
When you run a test with mirroring, you can view the status of all the machines in your test,
compare their displays, and detect and resolve differences in their displays.

For details, see "How to Run a Test with Mirroring" on page 286.

For details on the mirroring feature, see "Testing on Multiple Machines - Overview" on page 275.

2 Use scanners in your test
When you perform scans during a run session, you can monitor the progress of each scanner in the
Scan Progress window. After each scan ends, you can view and address the results.

For details, see:
e "Scan Progress Window" on page 268
e "Scan Results Viewer" on page 270

Stop your run and view and analyze the run results

Click the End Run button ). For details, see the "Run Control Sidebar" on page 141.

You can now view the results of your run in the main window. For details, see "How to Review Run
Results" on page 189.
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How to Navigate Steps

Note: This task is part of a higher-level task. For details, see "How to Run a Manual Test in
Sprinter" on page 114.

You can view the steps in your test in the Steps sidebar or in Subtitles mode.

Steps Sidebar (default mode)

The Steps sidebar displays all the step information and enables all of the functionality of marking,
modifying, and adding attachment to steps, as well as opening defects.

step heading to collapse a step.

= By default, the Step Display area is set to Auto Expand, so that clicking on a step heading
expands that step. When Auto Expand is not selected, double clicking on the step heading
expands the step.

= When you start arun, the Step Display Area displays the first step expanded. If you switch
between runs, the last step you marked is expanded.

« When you set the status of a step to Passed, the Step Display Area automatically advances to
the next step in the test.

For more details, see "Steps Sidebar" on page 147.

Subtitles Mode
Subtitles mode displays the description of each step as a subtitle on your screen, and enables you

to mark the step's status and add attachments to steps.
e Click Steps sidebar > Show Subtitles button = to view the steps in subtitles mode.

« When you start a run, the subtitle displays the first step. If you switch between runs, the last
step you marked is displayed.

« When you set the status of a step to Passed, the subtitle automatically advances to the next
step in the test.

« You can modify the appearance of the subtitles as described in the "Subtitles Settings Dialog
Box" on page 160.

¢ You can use hotkeys to mark a step's status, navigate steps, and perform other functions in
subtitles mode. For details, see "Hot Key Settings Pane (Settings Dialog Box)" on page 57.

For more details, see "Subtitles Toolbar" on page 158.
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How to Mark Steps

Note: This task is part of a higher-level task. For details, see "How to Run a Manual Test in
Sprinter" on page 114.

You can mark the steps in your test from the following locations:

o Steps Sidebar toolbar

¢ Subtitles toolbar

o Stepdisplay area

Steps Sidebar toolbar

¢ Select one or more steps in your test and click one of the status buttons © ¥ @ > to set their
status.

= CTRL-click multiple steps to select them.
= Click a step and then SHIFT-click another step to select a range of steps.

e You can also set the status of all the steps up to and including the current step, using the drop-
down options next to these buttons.

For more details, see "Steps Sidebar" on page 147.

Subtitles Toolbar

e Click Steps sidebar > Show Subtitles button = to view the steps in subtitles mode.

« Click the Pass or Fail buttons & € to mark the currently displayed step as Passed or Failed.

o Click the Step Status button 9 toselecta step status from the drop-down list.

For more details, see "Subtitles Toolbar" on page 158.

Step display area
e You can click the Status button (No Run, by default) & in the heading of each step in the Steps
display area to set the status for that step.

o If you select more than one step, you can click the Status button in any of the selected steps to
set the status of all steps in the selection.

» CTRL-click to select multiple steps.
= SHIFT-click to select a range of steps.

For more details, see "Steps Sidebar" on page 147.
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How to Edit and Add Actual Results and
Attachments to Steps

Note: This task is part of a higher-level task. For details, see "How to Run a Manual Test in
Sprinter" on page 114.
You can edit the actual results of steps, add and delete steps, and add attachments to steps.
This task includes the following steps:
o Edit the actual result of a step
o Add attachments to a step
o Edit the details of a step

o Add and delete steps

Edit the actual result of a step

You can edit and add a screen capture to the Actual Result of a step from the following locations:

o The Steps sidebar. Click the Actual Result button “# to edit or add a screen capture to the
actual results of a step. For details, see "Actual Result Dialog Box" on page 156.

¢ The Subtitles toolbar. Click the Actual Result button “+# to edit or add a screen capture to the
actual results of a step. For details, see "Actual Result Dialog Box" on page 156.

¢ The Annotation Workspace. In the Tools sidebar click the & Annotation Workspace button.
In Annotation mode, click the Save to Actual Result button to add an annotated screen capture
of your application to the actual results of a step. For details, see "Annotation Tools Sidebar" on
page 183.

Add attachments to a step

Click the Steps sidebar > Attachments button = to add an attachment to a step in your test. For
more details, see "Run Attachments Dialog Box" on page 145.

Edit the details of a step

Click the Steps sidebar > Edit Step button < 7 to edit the name, description, or expected result of
a step in your test. For more details, see "Edit Steps Dialog Box" on page 155.

Add and delete steps

Click down-arrow next to the Steps sidebar > Edit Step button © " 7 and select Edit Steps, Insert
Before, Insert After, or Delete Step to edit, add, or delete steps in your test. For more details, see

"Edit Steps Dialog Box" on page 155.
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How to Run an Exploratory Test in Sprinter

12 Relevant for Power Mode only

The following steps describe how to run an exploratory test in Sprinter.
This task includes the following steps:

o Prepare the exploratory test

o Explore your application

o Review and export the captured user actions

Prepare the exploratory test
o Ensure that you have the required user permissions and connect to Application Lifecycle
Management as described in "How to Get Started with Sprinter" on page 46.

o Open atestin Sprinter, as described in "How to Run a Manual Test in Sprinter" on page 114.

e Tum on Power Mode and select an application for your test, as described in the " Configure
Power Mode " on page 115 step.

Explore your application

Begin the run session, and perform any user action in your application. Sprinter captures all of the
user actions that you perform. You can manage the capturing of user actions and view the status of
your exploratory run in the "Run Control Sidebar" on page 141. For example, you can pause the
capturing of user actions temporarily, and resume the capturing when it is relevant.

For details, see "Run Control Sidebar" on page 141.

Review and export the captured user actions

At the end of the run session, review the captured user actions in the User Actions pane of the
"Results Group" on page 192. For user interface details, see "User Actions Pane/User Actions
Summary Dialog Box" on page 198.

In this pane you can export the captured user actions to:

« anew manual test with steps. Inthe new test, each user action is converted to a manual
step. Before saving the new test to Application Lifecycle Management, you can edit its details,
steps, and any user-defined information that your Application Lifecycle Management project
requires. For details, see "Generate Test Dialog Box" on page 161.

« a Unified Functional Testing-compatible automated test data file. This XML file contains all
the user actions and test object representations of the controls in your application that you used
during the run session. You can then import this file to HP Unified Functional Testing, where it is
converted to a GUI test with a local object repository.
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« an Excel or CSV file. This file contains all the user actions that you performed during the run
session. You can edit the content of the file and then import it into an existing test or component.
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Things to Remember When You Work with the
Test Runs List

o The Test Runs list contains the list of all the tests you can include in your next run. Any
changes you make to the Test Runs list do not affect the Test Lab module in Application
Lifecycle Management.

o When you click the Run button, only active tests in the Test Runs list are run. For details on
how to activate and deactivate tests, see the description of the context menu (right-click)
options in the "Run Setup Area" on next page. Deactivated tests appear disabled (gray) in the
Test Runs list.

= After you run atest, the test becomes deactivated in the Test Runs list. To run the test again,
you can use the context menu (right-click) options to:

o Activate the test. In your next test run, the current run will continue.
o Add a new run for the test.

o Replace the current run with a new run.

You can indicate which columns to display in the Test Runs list and add columns to the display,

by clicking the Select columns button Ir' or right-clicking on the column headers. You can also
resize columns and drag columns to change the order in which they are displayed.

A warning symbol /L. next to a test indicates a problem with the definitions for that test. When
you select the test, the wamning sign is also displayed next to the node that is causing the
warning. Select the node and review the displayed definitions for any warning messages. For
details, see the "Run Setup Definitions Group™" on page 135

A lock symbol & next to a test indicates that the test is currently locked. This occurs when the
test or run is locked in Application Lifecycle Management.

For a full description of all the features in the Test Runs list, see "Run Setup Area" on next
page.
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Run Setup Area

This area enables you to open tests and select which tests to include in your run. You can define
test details and view previous results for test. You can also configure Power Mode for your run.

Tasks you can accomplish with the Run Setup area:

e "How to Run a Manual Test in Sprinter" on page 114

o "How to Prepare a Test to Run in Power Mode" on page 210
o "How to Prepare a Test for Mirroring" on page 284

o "How to Review Run Results" on page 189

The following image shows the Run Setup area.

Run Setup Y

" FE. - - c..-w-l,) -
P> Open Save Fawvarites

«x Test Runs

fal

@| Name Status
Tours1 (x]
Tours o
Tours3 o
To access | Enter Run mode. The Run Setup area is in the left pane.
Important e The Test Runs list contains the list of all the tests you can include in your next
information run. Any changes you make to the Test Runs list do not affect Application
Lifecycle Management or the Application Lifecycle Management Test Lab
module.
o Tests inthe Test Runs list correspond to instances of a configuration in
Application Lifecycle Management. These instances are referred to as tests
throughout the product and this guide.
See also "Things to Remember When You Work with the Test Runs List " on previous page
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

= Run

¢ Runs all the activated tests in the Test Runs list.

o For details on activating and deactivating tests, see the description of
the context menu (right-click) options for the Test Runs list, below.

P> Run in Power Mode to enable data injection, mirroring, scanners, and
macros.

¢ Runs all the activated tests in the Test Runs list.

o For details on activating and deactivating tests, see the description of
the context menu (right-click) options for the Test Runs list, below.

(= Adds atest to the Test Runs list.
Open
Drop-down options:

e Open HP Application Lifecycle Management Test. (Default) Opens the
"Open Dialog Box" on page 133. If you are not connected to Application
Lifecycle Management, the "Application Lifecycle Management
Connection Dialog Box" on page 52 opens, enabling you to connect to
Application Lifecycle Management first.

If you have tests in the Test Runs list, the Open option removes the
current tests in the list and replaces them with your selection. If your
tests are not saved, you are prompted to save them.

o Append HP Application Lifecycle Management Test. Opens the "Open
Dialog Box" on page 133. The tests you select are appended to the Test
Runs list. If you are not connected to Application Lifecycle
Management, the "Application Lifecycle Management Connection
Dialog Box" on page 52 opens, enabling you to connect to Application
Lifecycle Management first.

The Append option adds your selection to the end of the Test Runs
list.
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, continued

Ul Elements Description

Save

Saves the selected tests in the Test Runs list.

Shortcut key:Ctrl+s

Drop-down options:
¢ Save. Saves the run definitions for the selected tests.

o Save All. Saves the run definitions for all the tests in the Test Runs
list.

Application Lifecycle Management tests are automatically saved to
Application Lifecycle Management throughout the test run. If you lose your
connection to Application Lifecycle Management during a run, your test will
display an asterisk next to its name indicating that the test has changes
that have not been saved. You must first reconnect to Application Lifecycle
Management in the "Application Lifecycle Management Connection Dialog
Box" on page 52 and then click the Save button to manually save the run
results to Application Lifecycle Management.

Fawvarites

Enables you to save the current list of tests as a favorite and load a saved
list of tests into the Test Runs list.

For details on how Sprinter maintains the list of favorites, see "How User
Information is Maintained" on page 44.

Drop-down options:

o Add to Favorites. Saves the current Test Runs list as a favorite in the
Favorites list.

o Manage Favorites. Allows you to change the order of your Favorites
list and remove favorites from the list. For details, see the "Manage
Favorites Dialog Box" on page 130.

N Select Columns. Allows you to select which columns to display in the
' Test Runs list. For example to add the run name column to the display,
select Run.
You can also select columns by right-clicking on the column headers.
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, continued
Ul Elements Description
Name The list of tests available to be included in the next run.

Tests in the Test Runs list correspond to instances of a configuration in
Application Lifecycle Management. These instances are referred to as
tests throughout the product and this guide.

« When you click the Run button, only active tests in the Test Runs list
are run. For details on how to activate and deactivate tests, see the
description of the context menu (right-click) options described
below. Deactivated tests appear disabled (gray) in the Test Runs list.

¢ Right-click atestin the Test Runs list to view the context menu (right-
click) options described below.

o Foreachtestinthe list you can set the status of the test by clicking in
the Status column and selecting a value from the drop-down list.

e When you select atest in the Test Runs list, the details pane displays
the groups for that test. For details, see "Run Setup Definitions Group"
on page 135 and "Results Group" on page 192.

o An asterisk next to a test name indicates the test has changes that
have not been saved.

e A warning symbol /L. next to a test indicates a problem with the
definitions for that test. When you select the test, the warning symbol is
also displayed next to the node that is causing the warning. Select the
node and review the displayed definitions for any warning messages.
For details, see the "Run Setup Definitions Group" on page 135.

e Alock symbol & next to a test indicates that the test is currently
locked. This occurs when you load a previous run of a test, and that run

is also currently being edited in Application Lifecycle Management.

o The Name and Status columns are displayed by default. You can right-
click on the column headers of the Test Runs list to add and select the
displayed columns, and drag column dividers to adjust column width.
You can also drag columns to change the order in which they are
displayed.
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, continued

Ul Elements Description

<Context menu ¢ Move Up. Moves the selected test up the Test Runs list.

(right-click)
options> ¢ Move Down. Moves the selected test down the Test Runs list.

¢ Remove. Removes the selected tests from the Test Runs list.

o Activate/Deactivate Test. Includes or removes the selected tests from
the next run session. Deactivated tests appear disabled (gray) in the
Test Runs list.

¢ Run This Test Only. Starts a run with the selected test only.

¢ Replace with New Run. Removes the selected test from the Test
Runs list, replaces it with a new copy and saves any run results. (This
can be useful if a test in the Test Runs list failed and you want to re-run
the test.)

o Add New Run. Adds a new run of the selected tests to the Test Runs
list.

e Show All Runs. Opens the "Test <'Test Name'>: All Runs Dialog
Box" on page 131.

Status The status values include the following default system values as well as
any user-defined status values:

o '“WPassed. The test passed.

o OFailed. The test failed.

o ] Blocked. The test is blocked.

e ONot Completed. The test was paused in the middle of the run.

« ©ONo Run. (Default selection) The test has not yet been run.

e QN/A. Current status is not applicable.

The Name and Status columns are displayed by default. You can right-
click on the column headers of the Test Runs list to add and select the
displayed columns, and drag column dividers to adjust column width. You
can also drag columns to change the order in which they are displayed.
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, continued

Ul Elements Description

Test Name

(Not displayed by default) The name of the test as it appears in the Test
Plan in Application Lifecycle Management.

Right-click on the column headers of the Test Runs list to select which
columns to display.

Test Set Name

(Not displayed by default) The name of the test set that contains the test,
as it appears in the Test Lab in Application Lifecycle Management.

Right-click on the column headers of the Test Runs list to select which
columns to display.

Run

(Not displayed by default) The name of the run.

Right-click on the column headers of the Test Runs list to select which
columns to display.

Zower Mode

Enables you to configure and activate Power Mode for your tests. For
details, see "Power Mode Group" on page 212.
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Manage Favorites Dialog Box

This dialog box enables you to change the order of your favorites in the favorites list and delete
favorites from the list.

The following image shows the Manage Favorites dialog box.

Manage Favorites | 7 =7
t ¢ X
Move Up Move Down Delete
Favarite
;; Mercury Tours set
;, Banking
—_—
To access Inthe Run Setup area, select Favorites > Manage Favorites.

Descriptions of the user interface elements are available in the dialog box when you hover over
them.
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Test <'Test Name'>: All Runs Dialog Box

This dialog box enables you to view previous run results. You can load a previous run in the Test
Runs list, view run results in the Storyboard, and view a run results summary.

Tasks you can accomplish with the Test <'Test name'>: All Runs dialog box:

o "How to Review Run Results" on page 189

The following image shows the Test <'Test name'>: All Runs dialog box.

Test Tours1": All Runs

bz = [ | O

Open Run Storyboard Run Summary | Refresh
Start Date Run Nams Status User =

L'} MIA Run_7-15_10-35-8 © NoRun Tester

[:_) TM5201010:12:19 A Run_7-15_10-11-5 (@ Mot Completed  Tester

L'} TMS201012:28:18 AM Run_7-15_0-7-47 Q Mot Completed  Tester

D 711502010 12:06:16 AM  Run_7-14_18-28-55 (D Not Completed  Tester

[:} TH42010 6:27:23 PM Run_7-14_16-41-22 [0 Blocked Tester g

D TN42010 42513 PM Run_7-14_13-4815 (O NotCompleted Tester

[:} 742010 12:56:56 P Run_7-14_12-3-5 @ WNotCompleted Tester

[(> 7M4/201012:00:13PM  Run_7-14_11-58-42 (D MNot Completed Tester

[:_“} TM4201010:22:32 AM  Run_7-14_10-21-32 (D MNotComplsted Tester

[> 7M4/201010:18:10 AM  Run_7-14_0-0-15 @ NotCompleted Tester

[:_“) TH22010 2:52:33 PM Run_7-12_14-52-3 @ NotCompleted  Tester .

To access Inthe Test Runs list, Right-click a test and select Show All Runs.
Important The current run in the Test Runs list is always displayed at the top of the list
information of All Runs, but it is disabled.

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

3 Adds the selected run to the Test Runs list.
Open Run

i) Opens the "Storyboard Window" on page 201 for the selected run.

Storyboard

(&) Displays the Run Summary for the selected run.
Run Summary
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ul
Elements Description

'S Refreshes the list of runs from Application Lifecycle Management.
Refresh
<Run The list of runs for the test. The run list displays the following columns:
list>

e Run Icon. This icon is blue for runs that were performed with Sprinter and green
for those that were performed with the Application Lifecycle Management manual
runner.

o Start Date.The data and time that the test run began.
¢ Run Name. The name you assigned to the run in the General Settings pane.
o Status. The current status of the test.

e User. The user who ran the test.
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Open Dialog Box

This dialog box enables you to open a test from Application Lifecycle Management (from the
Application Lifecycle Management Test Lab module). You can filter the tests that are displayed to

make selecting tes

ts easier.

Tasks you can accomplish with the Open dialog box:

e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Open dialog box.

Y o Y [ T @
Filter Refresh Filter Select Columns | Select All Deselect All
4 El Root Configuration: Name  Test: Test Name Status Re *
. E _LrJnatrta:hed [1ITours1 Tours1 No Run Je
)ﬁST‘zst set1 [1]Tours2 Tours2 Mo Run Jer
B3 Tester2 [11Tours3 Tours3 No Run Je
[ Tester3
51 Testers
[ m b
3 tests are currently selected | Open | Cancel |
To Inthe Run Setup area, select Open > Open Application Lifecycle Management Test
access | or Append Application Lifecycle Management Test.

User interface elements are described from left to right (unlabeled elements are shown in angle

brackets):

ul
Elements Description

Y Filter folders. Opens the Filter dialog box enabling you to filter the list of displayed
e folders. For details, click Help in the Filter dialog box.

=/
Refresh

Reloads the data from the HP ALM project.

Fitter

Y Filter tests. Opens the Filter dialog box enabling you to filter the displayed tests.
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ul
Elements Description

R

Sedect Columns

Opens the Application Lifecycle Management Select Columns dialog box, enabling
you to select which columns to view. For details, click Help in the Select Columns
dialog box.

i)

Select Al

Selects all the currently displayed tests in the list.

e

Desslect All

Deselects all the currently displayed tests in the list.

<Test set | Located on the left side of the dialog box. Displays your test sets hierarchically. A
tree> test set contains a subset of the tests in your project.

Note: You cannot move items within a folder.
<Test Located on the right side of the dialog box. The list of tests in the selected test set in
list>

the test set tree. Select the check boxes next to the tests you want to open in
Sprinter.
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Run Setup Definitions Group

The Run Setup Definitions group is located in the left side of the main window.
This group includes the following panes:

o "General Settings Pane (Run Setup Definitions Group)" on next page

o "Steps Pane (Run Setup Definitions Group)" on page 137

¢ "Parameters Pane (Run Setup Definitions Group)" on page 140

The number in the Steps and Parameters nodes within parentheses, indicate the number of steps
and parameters for the selected test.
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General Settings Pane (Run Setup Definitions
Group)

This pane displays your test's details.

Tasks you can accomplish with the General Settings:

e "How to Run a Manual Test in Sprinter" on page 114

e "How to Run an Exploratory Test in Sprinter" on page 121

The following image shows the General Settings.

General Settings
Test instance: Order Flight
Test name: Order Flight
Test set. Root\DemoTours\DemoTours1

Owner: ir

+ Run name: | Run_4-30_15-42-57

Description: This test covers the main business process for the demo Tours
application

Attachments: Mo sttachments

To access In the main window, select a test from the Test Runs list and then select
Definitions > General Settings node.

Important o If your Application Lifecycle Management test has user-defined fields that can
information be edited, they are displayed and can be edited in the General Settings pane.

o The test settings for Application Lifecycle Management tests are defined in
Application Lifecycle Management and are read-only in the General Settings
pane.

Descriptions of the user interface elements that can be edited are available in the pane when you
hover over them.

If Application Lifecycle Intelligence (ALI) is enabled for your ALM project, the General Settings pane
provides an additional field—Test Build. This drop-down enables you to select a specific build
(build ID) upon which to run your test.
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Steps Pane (Run Setup Definitions Group)

This tab displays the steps in your test. For Business Process Tests it displays the test hierarchy,
including components, steps, groups, flows, and iterations.

It also enables you to import steps to a test from an external file.

Tasks you can accomplish with the Steps tab:

e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Steps tab for a test.

Export Print Email
Steps
# Status  Name Description Expecte *
1 © Step3  Enter"jo"inthe "j_username" edit field.
2 © Step4  Enter the encrypted password in the "_password” edit
field.
3 Q Step 5 Click the "Login" button.
4 Q Step 6 Click the "Money Transier " link.
5 Q Step 7 Select the "Money Market [543877] $84.00" item from
the "fromAccount” combo box.
g © Step®  Selectthe "Checking [543875] §1,757.00" item from
the "toAccount” combo box.
7 Q Step 9 Click the "Next" button.
3 Q Step 10 Enter "68" in the "amount” edit field.
] © Step11  Click the "25" link.
10 Q Step 12 Click the "Next” button.
il © Step13  Click the "OK" button.
12 Qo Step 14 Click the "Logout” link.
4 | m | 3

The following image shows the Steps tab for a Business Process Test.
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Steps
Mame Description Expected Result Actu
= &g Tours Qo
s Login Q Summary
Pre Conditicn:
Post Conditien:
= &5 Find 3 flight © Summary
Pre Conditicn:
Post Condition:
- U lteration 1 %)
Type @ Select One Way
Passengers 0 <2
From O <MewYork:
To & <5zn Francisco>
= 23 teration 2 o
Type @ Select One Way
Passengers Qo <
From O <Mew Yorks
To ) <5en Francisco:
= 2= Select © Summary
Pre Conditicn:
Ul Example -
Components || ~€Ps
MName Description Expected Result Acty
= g Tours (%]
& Login O Summary
Pre Conditicn:
Past Conditicn:
= &% Find a flight © Summary
Pre Conditicn:
Post Condition:
-1 U lteration 1 (2]
Type @ Select OneWay
Passengers 0 <2
From O <MNew York>
To O <5an Francisco>
= %3 lteration 2 Q
Type © Select OneWay
Passengers Q <
From © <New York>
To € <San Francisco>
= 2 Select O Summary
Pre Conditicn:
Click thumbnail to view full size image.
To access In the main window, select a test from the Test Runs list and then select
Definitions > Steps node.
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Important
information

¢ You can resize the Sprinter window and the columns in the display to view all
the information.

Right-click the column header area to select which columns to display.

e The Name, Description, and Expected Result values can be edited in the
"Steps Sidebar" during the test run (described on page 147).

Parameters in steps are represented by <actual value <. If there is no actual

value, the parameter is displayed as <<<parameter name>>>

You cannot Export, Print, or Email steps in a Business Process Test.

o Click the Import button to import steps from an external file into a non-
Application Lifecycle Management test.

e You canimport steps from .xsl, .xslx, and .csv files.

If you import steps to your test from an external file, the file must have the
following column headers:

= Step Name
» Description
» Expected

If your file does not have columns with these headers, Sprinter uses the first
three columns in your file as those fields in your steps.

Sprinter does not recognize any other column headers in the external file.
Other field values (actual result, attachments) must be entered in the "Steps
Sidebar" (described on page 147).

For details on working with steps in an Application Lifecycle Management test,
see the Application Lifecycle Management User Guide.

Descriptions of the user interface elements are available in the pane.
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Parameters Pane (Run Setup Definitions Group)

This pane displays and enables you to edit the actual values of the parameters used in your test.

For Business Process Testing, this pane only shows the input parameters.

Tasks you can accomplish with the Parameters pane:

e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Parameters pane.

Parameters
Name Actusl Value Default Value Description Test
From San Francisco San Francisco  Departure city Tours
Passnegers 2 2 number of passen... Tours
User name BEaob Bob Default user name  Tours
To Mew Yark New Vork Destinstion City Tours
Credit first Bob Bob Credit Card firstn...  Tours_selectl

Actual Value can be edited from Sprinter. All other values must be edited from

To access In the main window, select a test from the Test Runs list and then select
Definitions > Parameters node.

Important The default values in the Parameters pane are taken from the test. Only the

information

Application Lifecycle Management.

For details on using parameters in tests, see the Application Lifecycle

Management User Guide.

User interface elements are described below:

LE’IIements Description
Name The name of the parameter.
Actual The value that will be used in the test run. If there is no actual value, the default
Value value will be used.
Default The default value for the parameter.
Value
Description | The description of the parameter.
Test The source test of the parameter.
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Run Control Sidebar

This sidebar enables you to set the status of your test and move between the different tests in the
list of tests you are running.

Tasks you can accomplish with the Run Control sidebar:

e "How to Run a Manual Test in Sprinter" on page 114

e "How to Run an Exploratory Test in Sprinter" on page 121

The following image shows the Run Control sidebar in a test without Power Mode.

B 0L

i

3k |DemoTestt

Run Control & l

2 In Power Mode, this sidebar also enables you to view the number of user actions in your run.

BEEua

ey
)

Tours1 in Test Seti

~ |[@~] J&
&

Lo

Run Control & [

To
access

Do the following:

1. Enter Run mode

2. Open atest or component.

3. Click the Run = or the Power Mode Run P~ button.
To end the run and close the sidebar:

1. Expand the sidebar.

2. Click the Stop = button.

the sidebar, click and drag on the sidebar header.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description
24 P User Actions. Displays the number of user actions performed in the current
run.
Eﬂ] Pause/Resume Capturing. Pauses and resumes Sprinter from capturing each

N— user action as it is performed.

o If you pause capturing, all subsequent actions are not represented in the
"Storyboard Window" on page 201 or the User Actions report. If you enabled
Automatic screen movie recording in the Settings dialog box, this is also
paused. For details, see "Run Settings Pane (Settings Dialog Box)" on page
59.

o If you are performing a test on multiple machines (mirroring) and pause
capturing, all subsequent actions are not replicated on the secondary
machines.

o If after you pause capturing, you perform actions in the test that affect the user
interface, there may be significant differences between the primary and
secondary machines. When you restart capturing, the secondary machines
may be unable to replicate the user actions until you manually update the
secondary machine user interface to match that of the primary machine.

Attachments (tests only). Opens the "Run Attachments Dialog Box" (described
on page 145), enabling you to add, edit, or remove attachments in your run.

I Test Details (tests only). Opens the "Test Details Dialog Box" (described on
page 146).
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Ul
Elements

_-_
S,

Description

Previous Test. Returns to the previous test in the Test Runs list.

o All the sidebars and displays are updated to display the current state of the
previous test in the Test Runs list.

e When moving between tests, you may need to perform actions in the test
application to ensure it is in the proper state for the test you want to perform.

. 2 If you are working in Power Mode, you may want to stop capturing while
performing these actions, so that they do not appear in the Run Control

sidebar, the "Storyboard Window" on page 201, or the list of actions in a defect.

. 2 If you are running a test with mirroring, you can continue capturing so that
these actions are replicated on your secondary machines. If you stop

capturing, you will need to perform these user actions on each secondary
machine in your run.

<Test list>

The list of tests in your run. Each test in the list includes the date and time of the
test and the test status.

To move between tests, click the Previous Test or Next Test buttons, or click the
down-arrow next to the test list and select a test.

<Test
status>

The status of the current test. You can modify the status of the current test by
clicking the down-arrow next to the test status icon and selecting a status from the
list.

Status values:

The status values include the following default system values as well as any user-
defined status values:

. O Passed. The test passed.

« ©OFailed. The test failed.

e ONot Completed. The test was paused in the middle.
o LBlocked. The test is blocked.

« ONo Run. (Default selection) The test has not yet been run.

o @N/A. Current status is not applicable.
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Ul
Elements

I

i,

Description
Next Test. Advances to the next test in the Test Runs list.

o All the sidebars and displays are updated to display the current state of the next
test in the Test Runs list. When moving between tests, you may need to
perform actions in the test application to ensure it is in the proper state for the
test you want to perform.

. 2 If you are performing a test with Power Mode, you may want to stop
capturing while performing these actions, so that they do not appear in the Run

Control sidebar, the "Storyboard Window" on page 201, or the list of actions in
a defect.

o Py you are running a test with mirroring, you can continue capturing so that
these actions are replicated on your secondary machines. If you stop

capturing, you will need to perform these user actions on each secondary
machine in your run.

L

End Run. Ends the testing session and returns to the "Main Window" on page 50.
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Run Attachments Dialog Box

This dialog box displays run attachments, and enables you to add, edit, or remove attachments (not
available for business component steps).

Tasks you can accomplish with the Run Attachments dialog box:

o "How to Edit and Add Actual Results and Attachments to Steps" on page 120

The following image shows the Run Attachments dialog box.
Run Attachments 2 a x|
& = ¥
| tours data txt
= tours_actions. csv
|| users.xt
To access In the "Run Control Sidebar" on page 141 click the Run Attachments button “

User interface elements are described below:

ul
Elements Description

s Add Attachment. Enables you to browse to a file and add it as an attachment.

] Open Attachment. Opens the selected attachment in the default program for the
attachment's file type.

X Remove Attachment. Removes the selected attachment.
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Test Details Dialog Box

This dialog box displays the description and any attachment for your test.

The following image shows the Test Details dialog box.

Test Details

This iz a test for the Mercury Tours Website.

| Close |
To access Select "Run Control Sidebar" on page 141 > Test Details button & .
Important Click the thumbnail of an attachment to open it in the default program for
information the file type.

Descriptions of the user interface elements are available in the dialog box when you hover over
them.
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Steps Sidebar

This sidebar enables you to navigate, mark, and edit the steps in your test.
Tasks you can accomplish with the Steps sidebar:

« "How to Navigate Steps" on page 118

e "How to Mark Steps" on page 119

« "How to Edit and Add Actual Results and Attachments to Steps" on page 120

The following image shows the Steps sidebar.

Steps ¥ I
Test: order flight 7@
Ov O~ |- 2~ B~ 0|8 B Q
G ———— ¥ o B
(=) 2. find flight | O
(= 3. order fligh s ©
(=) 4. logout s O
=]
0/4 | User Actions: 10 | Duration: 18:51:25

If you are running a Business Process Test, the Steps sidebar displays the test hierarchy and
components in an additional pane on the left. The Steps display area displays the steps for the

selected component.
Steps ¥ |
Tours —» Find a flight — lteration 1 ?
B & Tours £ O~ O~ |0 B~ MI&"&”E?IEH & Q
=l # Find 5 flight & Select One Way
651 Q) || (= 2. Passengers s ©
%3 lteration2 € § (=' 3. From .'l (]
# Select © © 4.To 2| ©
[=]
[4] 1l I | 079 | User Actions: 0 | Duration: 00:00:32
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To access | Do the following:
1. Enter Run mode

2. Open atest or component.

3. Click the Run /'~ orthe Power Mode Run #~ button.

reposition the sidebar, click and drag on the sidebar header.

Important o If your manual test does not have any steps and you did not manually change
information the Sprinter configuration file, the Steps sidebar is not displayed.

e Some options are available only when you are connected to Application
Lifecycle Management.

e Some options are available only when you are working with Business Process
Testing.

e Steps in components are displayed in the order in which they were created and
not by their logical order in the component.

o User defined fields in steps are not supported in Application Lifecycle
Management business process tests.

The Steps sidebar contains the following elements:
o "Steps Toolbar" below

o "Steps Display Area" on page 151

o "Steps Status Bar" on page 153

Steps Toolbar
User interface elements are described below:

ul
Elements Description

<Title The title bar of the Steps sidebar displays the test name as it appears in Test Plan
bar> module of Application Lifecycle Management.

For Business Process Testing tests, the title bar displays the name of the Business
Process Test and the current component.
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ul
Elements Description

O~ Pass Selected Steps. (Default) Marks the selected steps as Passed. (CTRL-click to
select multiple steps.)

Click on the down arrow for the following options:
o Pass. Marks the selected steps as Passed.
o Pass All. Marks all the steps as Passed.

o Pass Selected, Pass Previous Unmarked. Marks the selected step as Passed,
and marks all the unmarked steps prior to the selected step, as Passed. This
option is available only when a single step is selected.

Q- Fail Selected Steps. (Default) Marks the selected steps as Failed. (CTRL-click to
select multiple steps.)

Click on the down arrow for the following options:
o Fail. Marks the selected steps as Failed.

o Fail Selected, Pass Previous Unmarked. Marks the selected step as Failed,
and marks all the unmarked steps prior to the selected step, as Passed. This
option is available only when a single step is selected.

- Actual Result. Enables you to modify the actual result and/or add a regular or
annotated screen capture to the actual result. For details, see the "Actual Result
Dialog Box" on page 156

If your steps have user defined fields from Application Lifecycle Management, they
can be edited in the Actual Result dialog box.

& - Edit Step. Opens the "Edit Steps Dialog Box" on page 155. (not available for
Business Process Tests)

Click the down-arrow for the following options:

o Edit Step. (Default) Enables you to edit a step.

¢ Insert Before. Enables you to insert a new step before the current step.
o Insert After. Enables you to insert a new step after the current step.

o Delete Step. Deletes the selected step.
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ul
Elements Description

-

Smart Defect. Enables you to submit a defect to Application Lifecycle Management.
Drop-down options:

o Smart Defect. (Default) Opens the "Smart Defect Settings Dialog Box" on page
177, enabling you to include automatically generated defect scenario information
in your defect description.

e New Defect. Opens the New Defect dialog box, enabling you to manually submit
a defect to Application Lifecycle Management. When you create a new defect,
add the relevant attachments and the steps required to reproduce the defect.

o Add Defect Reminder. Opens the "Defect Reminder Dialog Box" on page 181.

If you are not connected to Application Lifecycle Management, the "Application
Lifecycle Management Connection Dialog Box" on page 52 opens, to enable you to
connect to Application Lifecycle Management first.

Attachments. (Tests only) Opens the "Run Attachments Dialog Box" on page 145,
enabling you to add, edit, or remove attachments in your step.

S Previous Component (Business Process Tests only). Returns the right pane and
the Steps display area to the previous component.

g Next Component (Business Process Tests only). Advances the right pane and the
Steps display area to the next component.

Parameters mode (Business Process Tests only). Displays and enables you to edit
the actual values of the parameters for the component selected in the left pane.

= Show Subtitles. Displays the steps, as an on-screen subtitle.

For details on working with subtitles, see "Subtitles Toolbar" on page 158.

Auto Expand. Expands each step when you click on its heading.

Expand All. Expands all the steps in the Steps display area.

Collapse All. Collapses all the steps in the Steps display area.

Next Test. Ends the run for the current test and advances to the next test in the run.
To return to a previous test, use the PreviousTest button in the "Run Control
Sidebar" (described on page 141).
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ul
Elements Description

Q Find. Enables you to search the steps for specific text.

o Find searches the step name, description, and expected result for the specified
text.

e The search text is not case-sensitive.

e The first step containing the text is automatically opened.

Steps Display Area

This area displays the steps in the current run. For Business Process Tests, it displays the steps in
the current component. In Parameters Mode (Business Process Tests only) it displays the
parameters for the component selected in the left pane.

Navigating | « By default, the Steps display areais set to Auto Expand, so that clicking on a
step heading expands that step.

o When you start a run, the Steps display area displays the first step expanded. If
you switch to another run that you have not yet completed, the last step you
marked is expanded.

« When Auto Expand is selected (default), clicking on a step heading selects
and expands the step. Clicking again collapses the step.

o When Auto Expand is not selected, double-clicking on the step heading
selects and expands the step. Double-clicking again collapses the step.

« When you set the status of a step, the Steps display area automatically
advances to the next step in the test.

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

=] Expand/Collapse. Expands or collapses the selected step. When the step is
expanded, the name, description, and expected results are displayed.

” Actual Result. Opens the "Actual Result Dialog Box" on page 156, enabling you to
modify the actual result and add a screen capture or annotated screen capture to the
actual result.
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ul
Elements Description

(X ) Status. Displays a drop-down list that enables you to set the status of the step.

Default status values:

. O Passed. The step passed.

o OFailed. The step failed.

o []Blocked. The step is blocked.

e DNot Completed. The step was paused in the middle of the run.

o ONO Run (Default) The step has not yet been run.

e QN/A. Current status is not applicable.

Note: In addition to the default status items above, the list includes any user-defined
statuses defined for your Application Lifecycle Management project. For details on
user-defined statuses, see the Application Lifecycle Management Administrator
Guide.

Tip: You can CTRL-click to select multiple steps and then use the one of the
selections in the drop-down list to set the status of all the selected steps.

<Step When a step is expanded, the following fields are displayed:

content>
« Name. If the step name is too long to display in the step heading it is truncated,

and the full step name is displayed in the step description.
o Description
o Expected Result

o Actual Result (if added). If you added a screen capture to the Actual Result, an
icon is added to this area. If you move the cursor over the icon, the screen capture
is displayed.

o Step Attachments. If you added an attachment to a step, anicon indicates that
there is an attachment.

Double-clicking the icon opens the attachment in your default program for that file
type. Forimages, moving the pointer over the icon displays a preview of the
attachment.
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Steps Status Bar

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul

Elements Description

<Steps Displays a progress bar and text indicating the number of steps that do not have a

status status of No Run, out of the total number of steps.

bar>

User Displays the number of user actions performed in the current test run.

Actions

Duration | Displays the amount of time spent on the current run. The Duration counter resets
to 0 when you move between runs in the Run Control sidebar.

Step Attachments Dialog Box

This dialog box displays step attachments, and enables you to add, edit, or remove attachments.

Tasks you

¢ "How to Edit and Add Actual Results and Attachments to Steps" on page 120

can accomplish with the Step Attachments dialog box:

The following image shows the Step Attachments dialog box.

Step Attachments 7 o ™%

b B X

| Desert.jpg

| Lighthouse jpg

| Tulips.jpa

i

To access In the Steps Sidebar, click the Step Attachments button ~
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User interface elements are described below:

ul
Elements Description

e Add Attachment. Enables you to browse to a file and add it as an attachment.

= Open Attachment. Opens the selected attachment in the default program for the
attachment's file type.

4 Remove Attachment. Removes the selected attachment.
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Edit Steps Dialog Box

This dialog box enables you to edit a step in your test.
Tasks you can accomplish with the Edit Steps dialog box:
« "How to Edit and Add Actual Results and Attachments to Steps" on page 120

The following image shows the Edit Steps dialog box.

Edit Steps 7=

Name: | Multiply |

Description: |Click the "8" button.
Click the "8" button.
Click the ™= button.

Click the "3" button.
Click the "=" button.
Click the "C" button.

Expected result: |287

To access | Cjick "Steps Sidebar" on page 147 > Edit Steps button < 7 .

Important Changes you make to steps in an Application Lifecycle Management test are
information | sayed in the run results the Test Lab module of Application Lifecycle
Management. When the run ends you have the option to save the changes to the
test, in the Application Lifecycle Management Test Plan module as well.

¢ Changes you make to steps that were imported into your test from an extemnal
file are saved in your test, but not in the extemnal file.

See also "Tests with Steps" on page 109

Descriptions of the user interface elements are available in the dialog box when you hover over
them.
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Actual Result Dialog Box

This dialog box enables you to edit the actual result of a step in your test.

Tasks you can accomplish with the Actual Result dialog box:

« "How to Edit and Add Actual Results and Attachments to Steps" on page 120
o "How to Detect and Submit a Defect" on page 170

The following image shows the Actual Result dialog box.

Actual Result ™
& X
Actual Result: || E
Enter the actual result of the step
Image:
No Image
=]
| OK | Cancel |
To access Do one of the following:
e Click "Steps Sidebar" on page 147 > Actual Result button =« .
o Click "Steps Sidebar" on page 147 > Step header > Actual Result button “#
o Click "Tools Sidebar" on page 173 > Screen Capture section > Save To
Actual Result button = .
Important If your steps have user defined fields from Application Lifecycle Management,
information | they can be edited in the Actual Result dialog box.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

E@! Save Screen Capture as Actual Result. Saves a screen capture of your
application and adds it to the Actual Result for the current step.

~ Save Annotation as Actual Result. Opens the Annotation Workspace, enabling
you to annotate a screen capture of your application. When you close the Annotation
Workspace, the annotated screen capture is added to the Actual Result for the
current step. For details on working in the Annotation Workspace, see "Annotation
Tools Sidebar" on page 183.

X Remove. Removes the screen capture or annotation from the Actual Result for the
current step.

Actual The actual result of the current step.

Result

Image Displays any image attachment you saved with the actual result of the current step.
<user Additional fields defined for the Step entity in the ALM project's customization. For
defined | getails, see the ALM documentation.

fields>
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Subtitles Toolbar

This toolbar enables you to run, mark, and edit the steps in your test while in subtitles mode.
Tasks you can accomplish with the Subtitles toolbar:

« "How to Navigate Steps" on page 118

e "How to Mark Steps" on page 119

o "How to Edit and Add Actual Results and Attachments to Steps" on page 120

The following image shows the Subtitles toolbar.

€ 200 w0 |FA{ L

To access | Click the "Steps Sidebar" on page 147 > Subtitles button & | and then hover over
the subtitle.

Important ¢ You can use hot keys to mark a step's status, navigate steps, and perform
information other functions. For details, see "Hot Key Settings Pane (Settings Dialog Box)
" on page 57.

¢ You can still view the Steps sidebar while you are in Subtitles mode, by
clicking on the Steps sidebar tab.

User interface elements are described below:

ul
Elements Description

C Previous Step. Displays the previous step.
:> Next Step. Displays the next step.
O Pass. Marks the current step as Passed, and displays the next step.
0 Fail. Marks the current step as Failed. The next step is not displayed automatically.

This gives you the opportunity to open a defect on the current step.

” Actual Result. Opens the "Actual Result Dialog Box" on page 156, enabling you to
modify the actual result and add a screen capture or annotated screen capture to the
actual result.

o - Step Status. Enables you to select a status for the current step from the drop-down
list.
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ul
Elements Description

@ Hide Subtitles. Hides the subtitles display.

Settings. Opens the "Subtitles Settings Dialog Box" on next page.

Step Details. Displays the following step details:

=¥

<

e Name
e Description
o Expected Result

o Actual Result. If you added a screen capture to the Actual Result, anicon is
added to this area. If you place the cursor over the icon, the screen capture is
displayed.

o Step attachments. If you added an attachment to a step, an icon indicates the
attachment. Double-clicking the icon opens the attachment in your default
program for that file type. Forimages, moving the pointer over the icon displays a
preview of the attachment.

Click the button again to close the step details display.
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Subtitles Settings Dialog Box

This dialog box enables you to set display options for subtitles.

The following image shows the Subtitles Settings dialog box.

Sublitles Seltings 7 ™=

AT ]~

Select the text and background color for the subfitles.

Font size 12 20 24 30

Location | |

.—DI—.

Transparency: 1 ' ]
Law High

Aufto-hide delay: ] | 3 |, | |seconds
—_—
To Click the "Steps Sidebar" on page 147 > Subtitles button = | hover over the subtitle
access

and click the Settings button

Descriptions of the user interface elements are available in the dialog box when you hover over
them.
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Generate Test Dialog Box

This dialog box enables you to edit the test details and steps for a new manual test. This test is
based on user actions that you performed during an exploratory run session.

Tasks you can accomplish with the Generate Test dialog box:

e "How to Run an Exploratory Test in Sprinter" on page 121

The following image shows the Steps tab in the Generate Test dialog box.

Generate Test e
Test Steps (2)
. -?; Cut Steps |' —l
&0? T BaCopysteps o |mhimen| Bl |0 e
P Paste Steps 3¢ || [l (80| || |[SliBn iy filly| [ Match whole word
Step Font Paragraph Find
Mame | Description Expected Result |
1 Step 1 Enter "Flowers" in the "guery”
edit field.
2 Step 2 Click the "btn_search_hp_text"
image.
To access In the "Results Group" on page 192, select User Actions and click the
=
Generate Test button <= .
Important o This functionality is available only at the end of the run session.
information
o This functionality is not available when viewing the results in the Results
Viewer, even when Sprinter is installed.

The Generate Test dialog box includes the following user interface elements:

ul
Elements Description

Test tab | Provides the same functionality that is available in the "Details Pane (Plan Mode
Definitions Group)" on page 86.
Steps Provides the same functionality that is available in the "Steps Tab" on page 93.
tab
Save Opens the save dialog box for specifying a test location.
Page 161 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 4: Running Tests

Troubleshooting and Limitations - Running
Tests and Components

This section describes troubleshooting and limitations for running tests with steps and Business
Process Tests.

¢ You cannot run Sprinter with a display color depth of 256 colors (8 bit).

o To work with the Silverlight add-in, your Silverlight application must be initialized with the
EnableHtmlAccess property value set to 'True'. For details, see http://msdn.microsoft.com/en-
us/library/cc838264.aspx.

¢ When running a Sprinter test in ALM, the Cross Run report does not show the Sprinter test
steps. To access the report, click the Test Runs tab and select Analysis > Reports > Cross
Run with Steps.

« Microsoft Excel is required to run a business component with static configuration using Sprinter
11.50 and ALM 11.00. When working with ALM 11.50, Excel is not required.

e Therunresults of a Business Process test which was run in Sprinter 11.50 against ALM 11.0, is
presented in the Results Viewer as a flat list instead of as a structured tree.
Workaround: Install the ALM 11.0 Patch 10 or higher.

¢ When moving a jQuery slider with the mouse, the "mouse up" action must be performed while
the mouse pointer is over the slider. Otherwise, the user action will not be recorded.

o If you close the Run Attachments dialog box and reopen it while an attachment is still
uploading, the attachment is not displayed. Do not delete run attachments until they finish
uploading.

o Certain ASPajax controls may not be recognized by Sprinter. Try refreshing the page.

o When working with Sprinter on a Windows Server 2008 or 2008 R2 machine, you must install
the Desktop Experience feature in order to successfully display all image attachments in ALM.

To install Desktop Experience:
= Onthe server machine, select Start > Administrative Tools >Server Manager.
= Select the Features node, and click Add Features in the right pane.

= Inthe Add Features Wizard window, select the Desktop Experience check box, and click
Next.

= Click Install to complete the installation through the wizard.

For more information about this issue, see http://technet.microsoft.com/en-
us/library/cc772567.aspx.
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Business Process Testing Limitations

o If you open abusiness process test that cannot be run, Sprinter displays the test without any
steps. This may occurin, but is not limited to, the following situations:

= Yourbusiness process test has an input parameter linked to an output parameter, but the

number of iterations for the components that contain the input and output parameters do not
match.

= You created an output parameter for a flow but it is not linked to an existing parameterin a
component.

Note that Sprinter will not display an error message for the test in this case.

o If aBusiness Process Testing configuration includes multiple iterations and you open it from

Sprinter, the configuration parameters are not displayed in the Parameters pane of the Run
Setup Definitions Group.
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Detecting and Submitting Defects, and
Using Tools

Throughout this guide, descriptions of features that are available only in Power Mode are
identified by the Power Mode'ra icon.

This chapter includes:

Concepts

o "Detecting and Submitting Defects Overview" on next page

¢ "Using Annotation Tools to Detect Defects" on page 167

o "Submitting Defects" on page 169

Tasks

o "How to Detect and Submit a Defect" on page 170

Reference

e "Tools Sidebar" on page 173

o "Smart Defect Settings Dialog Box" on page 177
o "Custom Selection Dialog Box" on page 180

o "Defect Reminder Dialog Box" on page 181

e "Comment Dialog Box" on page 182

o "Annotation Tools Sidebar" on page 183
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Detecting and Submitting Defects Overview

Sprinter provides tools that assist you to detect defects in your application and report them to ALM.
These tools allow you to detect and report defects without disrupting the test flow.

Sprinter defect detecting tools enable you to examine the display of the application being tested, for
defects such as alignment, spacing, and color usage. You can also annotate a screen capture with
shapes, lines, arrows, and text, to assist in highlighting and communicating defects.

SELECT FLIGHT

travel,

SELECT

Lza N

i

éELEET
|ﬂ-
-i
o}
=
8
c
=
o
=]
—_— =
| []
1 ' -
Screen Capture

ndon to Frankfurt

Select your departure and return flight from the selections below. Your total price will
be higher than guoted if you elect to fly on a different airline for both legs of your

Frankfurt to London

Wrong date \'

2/5/2010
Blue Skies Airlines 5:03 non-stop
Price: $270 (based |r: 217d trip)
Blue Skies Airlines S.j ;§§ 710 non-staop
Price: $271 (based o r trip)
Pangaea Airlines 317 non-stop
Price: $274 (based orroupd trip)
Unified Airlines 363 11:24 non-stop
Price: $281 (based on Yourld trp| Should be "Direct/Stops”

4/8/2010

Blue Skies Airlines ) Ton-siop
Price: $270 (based on rd&: 237f0)
Blue Skies Airlines 6315 2o 14:30 nan-stop

Price: $273 (based on round trip)

Pangea Airlines 632

Price: $282 (based on round trip)

Unified Airlines 633

Price: $303 (based on round trip)
CONTINUE

- IEE| v @ D5, Mercury Interactive (v. HG-0.15)

16:37 non-stop

18:44 non-stop

Sprinter defect submitting tools enable you to submit a defect to ALM, email an annotated screen
capture of the application screen, or print an annotated screen capture of the application screen.

The defect detecting and submitting tools are located in the Annotation Workspace. When you open
the Annotation Workspace, a capture of your current screen is displayed in the workspace. You can
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examine the elements in this screen capture and add any annotations to it. When you submit a
defect and attach a screen capture, add a screen capture to the actual results of a step, or if you

keep arecord of a defect from the Annotation Workspace, this screen capture is attached with the
annotations you added.

This section also includes:

o "Using Annotation Tools to Detect Defects" on next page

o "Submitting Defects" on page 169
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Using Annotation Tools to Detect Defects

Sprinter provides a variety of tools to enable you to detect defects in the display of your application.
This section includes:

e RulerTool

o Guides Tool

e Color Picker Tool

Ruler Tool

The Rulertool * enables you to accurately measure the distance between user interface
elements in the application display. The Ruler tool displays the length of the ruler line in pixels.

Frankfurt to London 2452010
SELEGT

LEFART

non-stop

User interface elements are typically arranged horizontally and vertically on the screen. Therefore,
the Ruler tool locks the ruler line along the horizontal or vertical axes when you drag it (SHIFT-drag
to unlock), to make measuring distances between elements easier. Multiple ruler lines can be
placed on the annotation Workspace to enable you to compare the distances of multiple elements in
the user interface. You can zoom in on the annotations workspace to more accurately measure
elements.

The Ruler tool snaps on to each element to assist you in accurately measuring the distance
between two user interface elements.

Guides Tool

The Guides tool *| enables you to examine the alignment of user interface elements in the
application.

When you select the Guides tool, vertical and horizontal guide lines follow the cursor as you move
over the screen capture of your application in the annotation workspace. When you click the left
mouse button, the guide lines are placed on the workspace, which enables you to determine if
elements are aligned with one another. You can leave the guide lines on the workspace to be
included in the screen capture of the application when you report the defect, or save, email, or print
the screen capture. You can place multiple sets of guide lines on the workspace. You can zoom in
on the annotations workspace to more accurately view the alignment of elements.

Color Picker Tool

q’f
The Color Picker tool enables you to detect the color of any point on the screen and to
compare the colors of two or more points on the screen. This allows you to determine if colors are
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used consistently in the application being tested.

When you select the Color Picker tool, a pop-up balloon displays the RGB (Red, Green, Blue)
values above the cursor as you move over the Annotation Workspace. By placing multiple pop-up
balloons on the workspace, you can determine if the colors of various on-screen elements are
consistent. You can leave pop-up balloons on the workspace to be included in the screen capture of
the application when you report the defect, or save, email, or print the screen capture.

Parent topic: "Detecting and Submitting Defects Overview" on page 165
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Submitting Defects

Sprinter gives you the following ways to submit defects:
o Smart Defect

When you submit a defect using Sprinter's Smart Defect, you can indicate the type of information
to automatically add to your defect:

= Defect description. You can choose to add the defect scenario to the description of your
defect. The scenario can include an automatically generated list of the test steps and/or a list of
the recorded user actions you performed in your run.

After you select which information to include, the New Defect dialog opens with the selected
information already entered in the defect's description. You then fill in the other defect fields and
submit the defect.

= Screen captures and movies. You can choose to attach a screen capture that illustrates the
defect to your defect. If you submit the defect from the Annotation Workspace, the screen
capture will include any annotations you added. For details, see "Annotation Tools Sidebar" on
page 183. You can also attach a movie of your run.

For details on configuring the information to include in your defect, see "Smart Defect Settings
Dialog Box" on page 177.

o New Defect

You can open the New Defect Details dialog box directly from Sprinter and manually fill in all the
defect fields. The annotation is saved with the Sprinter test or component—it is not added as an
attachment to the defect.

o Defect Reminder
You can continue your test run without disrupting its flow by creating a Defect Reminder.

A defect reminder enables you to summarize the defect in your application. The reminder is
included with the test results and can be viewed at the end of your test. You can then submit the
defect later from the test Results. The same information you have available during the test is also
available to you from the results. So you can include screen captures, movies, and step or action
information in the defect at that time.

When you submit an ALM defect using Sprinter, the defect is created in the ALM server, domain,
and project that you configured in the "Application Lifecycle Management Connection Dialog Box"
on page 52.
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How to Detect and Submit a Defect

This task describes the different ways you can submit a defect using Sprinter. You can also email,
save, or print a screen capture of a defect in your application.

This task includes the following steps:

o Examine and annotate a screen capture of your application - Optional
¢ Submit a defect

o Create a defect reminder

o Email, save, or print a screen capture of the defect - Optional

Examine and annotate a screen capture of your application - Optional

You can use Sprinter's screen examining and annotations tools to detect and mark defects ina
screen capture of your application.

1. Inthe Tools sidebar, click the Annotation Workspace button ¥

Workspace.

to open the Annotation

2. Usethe tools in the Annotations Tools sidebar to find defects and prepare your screen
capture. For details, see "Annotation Tools Sidebar" on page 183. For more details, see
"Detecting and Submitting Defects Overview" on page 165

Submit a defect

You can submit a defect from one of the following locations:
e "Tools Sidebar" on page 173

o "Steps Sidebar" on page 147

o "Annotation Tools Sidebar" on page 183

e "Storyboard Window" on page 201

From any of these locations you can:

o Click the Smart Defect button '/ ™ in the Tools, Steps, or Annotation Tools sidebars to open
a Smart Defect (default). Smart defects enable you automatically include detailed defect

scenario information in the defect description, as well as a screen capture or movie of a defect in
your application. For details, see "Submitting Defects" on previous page.

For details on configuring the information to include in your Smart Defect, see "Smart Defect
Settings Dialog Box" on page 177.

For details, see "Submitting Defects" on previous page.
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¢ Click the down-arrow next to the Smart Defect button and select -INew Defect to open the
New Defect dialog box. This enables you to manually set the ALM defect fields. For details, see

"Submitting Defects" on page 169.

If you submit your defect from the Annotation Workspace, click the Close button in the
Annotation Tools sidebar to close the Annotation Workspace and return to your application.

For more details, see:

e "Tools Sidebar" on page 173

o "Steps Sidebar" on page 147

e "Annotation Tools Sidebar" on page 183

You can also submit a defect while reviewing your run results from the "Defect Reminders Pane
(Results Group)" on page 196 and while resolving differences in a mirroring test in the "Differences
Viewer" on page 315.

Create a defect reminder

You can create a defect reminder from one of the following locations:
e "Tools Sidebar" on page 173

o "Steps Sidebar" on page 147

From any of these locations you can:

¢ Click the down-arrow next to the Smart Defect button and select L Defect Reminder to add a
reminder to submit a defect at a later time.

For details see "Defect Reminder Dialog Box" on page 181.

Email, save, or print a screen capture of the defect - Optional

You can email, save, or print a screen capture of a defect in your application from one of the
following locations:

o Tools sidebar
o Annotations Tools sidebar

From any of these locations you can click the down-arrow next to the Screen Capture button
(@ ~ and select:

« Email to open an email message in your default email editor and include a screen capture of a
defect in your application as an attachment.

o Save to save a screen capture of a defect in your application to the file system.

o Print to print a screen capture of a defect in your application.
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If you email, save, or print a screen capture from the Annotation Workspace, click the Close
button in the Annotation Tools sidebar to close the Annotation Workspace and return to your
application.

For more details, see the "Tools Sidebar" on next page and the "Annotation Tools Sidebar" on page
183.
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Tools Sidebar

This sidebar enables you to find defects in the user interface of your application and report them to
ALM. You can open the Annotation Workspace to annotate a screen capture of your application and
include it in a defect, or you can save, print, or email the screen capture.

2 In Power Mode this sidebar also enables you to add a comment to your test, open the Timeline
Viewer, or display a list of the user actions in your run.

Tasks you can accomplish with the Tools sidebar:
¢ "How to Detect and Submit a Defect" on page 170

The following image shows the Tools sidebar without Power Mode:
2

g & @

Taols A

The following image shows the Tools sidebar with Power Mode:

Actions
mm [ |
To Do the following:
access
1. Enter Run mode
2. Open atest or component.
3. Click the Run = or the Power Mode Run #~ button.
Tip: Tolock the sidebar in the open position, click the thumbtack e icon. To reposition
the sidebar, click and drag on the sidebar header.
See "Detecting and Submitting Defects Overview" on page 165
also
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User interface elements are described below:

Ul
Elements

(L.

Description

raStoryboard. Opens the Storyboard window enabling you to view a visual
summary of all the user actions in your test. For details, see "Storyboard Window"

on page 201.

‘-n{ |

raUser Actions. Displays a list of the recorded user actions. You can export the
list to an .xsl or.csv file. You can also print or include the summary in an email.

For details, see "User Actions Pane/User Actions Summary Dialog Box" on page
198.

Smart Defect. Enables you to submit a defect.
Drop-down options:

e [21 Smart Defect. (Default) Enables you to include automatically generated
scenario information in the defect description. For details, see "Smart Defect
Settings Dialog Box" on page 177.

e U New Defect. Enables you to manually submit a new defect.

e Lo Add Defect Reminder. Lets you add a descriptive defect reminder. For
details, see the "Defect Reminder Dialog Box" on page 181.

If you are not connected to ALM, the "Application Lifecycle Management
Connection Dialog Box" on page 52 opens, to enable you to first connect to ALM.

Annotation Workspace. Opens the Annotation Workspace, enabling you to
detect user interface defects in your application and add annotations in a screen
capture of your application.

From the Annotation Workspace you can include the annotated screen capture in
the defect, save it to the actual result of the current step, or you can save, print, or
email the annotated screen capture.

For details see, "Annotation Tools Sidebar" on page 183.
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Ul

Elements Description

&) ~ Screen Capture. Takes a snapshot image of your application.

Drop-down options:

e Email. (Default) Opens a message in your default email application with the
attached screen capture of the application.

e Save. Saves the screen capture of the application.

e Print. Prints the screen capture of the application.

2 Add Comment. Enables you to add a comment to the current user action. For
more details, see "Comment Dialog Box" on page 182.

You can view the comments you added to your test in the Storyboard Window, for
each action. For details on the Timeline Viewer, see "Storyboard Window" on page
201.

<custom Anicon representing the first custom tool. For details see below.
icon>

Adding Custom Tools to the Tools Sidebar

Sprinter allows you to add additional tools to the Tools Sidebar. These tools will be available during

the test run, similar to all other buttons on the Tools Sidebar.

A tool can be any program that you can run from the command line. For example, an executable

file, a VB script and so forth. To add a tool:

1.

Open the <Installation Folder>/bin folder and locate the CustomCommands.xml file. The
file contains several examples in the commented section.

Open the XML file for editing.
Specify an executable file, or any program that can be run from the command line. For example
<FileName>notepad.exe</FileName>

Provide arguments using the syntax that can be used on the command line. For example,
<Arguments>C:\temp.txt</Arguments>

Specify the path of an icon representing the tool. For example,

<ImageSource>C:\MyIcon.jpg</ImageSource>
Specify the title of the tool as it will appear on the drop-down on the Tools Sidebar. For

example, <Title>Notepad</Title>

Indicate the action of the tool as it will appear in the tooltip's header. For example,
<TooltipHeader>Opens Notepad</TooltipHeader>
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8. Provide a description of the tool as it will appear in the tooltip's header. For example,

<TooltipDescription>Opens Notepad with the “C:\temp.txt”
file</TooltipDescription>

9. Save and close the file.
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Smart Defect Settings Dialog Box

This dialog box enables you to define the information that will be included in your defect's

description, and any defect attachments.

Tasks you can accomplish with the Smart Defect Settings dialog box:

o "How to Detect and Submit a Defect" on page 170

The following image shows the Smart Defect Settings dialog box.

Smart Defect Seftings

Include in descripiion

x

[} |Gurrentstep | - |

¥l Inclede last step's actusl result information

V| |AII user actions | - |

= Description praview:

User achions:

1. Enter "mencury” in the "userMame" edit field.

2. Enter the encrypted password in the "password” edit field.
3. Click the "Sign-In" image.

4. Select the "oneway” radio button in the “ripType" radio group.

locations:

¢ Tools sidebar

o Steps sidebar

o Annotation Tools sidebar
¢ Scanner Results dialog box

o Storyboard window

5. Select the "2” item from the "passCount” combo box. |Z|
Attach to defect
ly| Current screen capture
W] Screen movie: Include the last | 1 | - | minute(s).
Submit Defect
To access

During a test run, click the Smart Defect button " ™ from one of the following
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Important ¢ If you are not connected to ALM, the "Application Lifecycle Management
information Connection Dialog Box" on page 52 opens, to enable you to connect to ALM
first.

2 Action options are available only if you are working in Power Mode.

See also "Detecting and Submitting Defects Overview" on page 165

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

<Step Available only when you are working in test with steps.

information>
Enables you to include step information as part of the description of the defect.

Drop-down options:

o All steps to current. Includes the step name and description for all the
steps in the test up to the current step.

o All steps. Includes the step name and description for all the steps in the
test.

e Custom. Enables you to select specific steps to include in the defect
description. For details, see the "Custom Selection Dialog Box" on page
180.

The expected result for the last step that you include in the description is also
added to the defect description.

Include last Adds the actual result (if available) for the last step you included in the defect
step’s actual | gescription.

result
information
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Ul Elements Description

2 <Action Enables you to include user action information as part of the description of the
information> defect.

Drop-down options:

o Last 5 user actions. Includes a description of the last five user actions.
o Last 10 user actions. Includes a description of the last ten user actions.
o All user actions. Includes a description of all the user actions.

e Custom. Enables you to select specific user actions to include in the
defect description. For details, see the "Custom Selection Dialog Box" on
next page.

Description A preview of the information that will be included in the defect description.

preview
Attach to o Current screen capture. Include a screen capture of the application as an
defect attachment to the defect.

= If you submit the defect from the Annotation Workspace, the screen
capture includes your annotations.

= |f you submit the defect from the Differences Viewer, screen captures of
both machines are attached to the defect.

e Screen movie. Include a movie of your run. Select a value from the drop-
down box to define how much of the movie to include.

= The screen movie functionality must first be enabled by your ALM
administrator.

= Sprinter supports recording screen movies of up to 10 minutes. However,
your ALM administrator may have reduced the maximum allowable movie
length in the Sprinter section of the Project Customization page in ALM.

= Screen movies can be enabled and disabled. You must enable screen
movies prior to running your test. For details, see the "Run Settings Pane
(Settings Dialog Box)" on page 59.

= Sprinter sidebars may not be visible in movies.

Submit Defect | Closes the Smart Defect Settings dialog box and opens the New Defect dialog
box, enabling you to fill in the remaining information in the defect.

Cancel Cancels the defect submission.
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Custom Selection Dialog Box

This dialog box enables you to select specific steps or user actions to include in a defect.
Tasks you can accomplish with the Custom Selection dialog box:
o "How to Detect and Submit a Defect" on page 170

The following image shows the Custom Selection dialog box.

Custom Selection !
Select All
Step Descrigtion
Login Enter user name and password
Flight Search info  Enter = 2 = Eniter = San Francisco = Enfer dateEnter = New
Yaork = Enter date
Select Flight Select & depariing and refurn flight
Book a Flight Enter billing info
To In the "Smart Defect Settings Dialog Box" on page 177, select Custom from the step
access | information or action information drop-down lists.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

Select All Selects all the steps or actions in the list.

<Step / Action The list of steps or user actions in your test. CTRL+CLICK to select multiple
list> steps or actions.

o Thellist of actions includes only those you performed up to this point in
your run.

e Thelist of steps includes all the steps in your test.
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Defect Reminder Dialog Box

12 Relevant for Power Mode only

This dialog box enables you to add a reminder to open a defect at a later time.

Tasks you can accomplish with the Defect Reminder dialog box:

o "How to Detect and Submit a Defect" on page 170

The following image shows the Defect Reminder dialog box.

Defect Reminder [
Drescription:
To access | During atest run, from one of the following locations:
o Tools sidebar
o Steps sidebar
Click the down arrow next to the SmartDefect button L& and select Add Defect
Reminder.
Important | You can view your defect reminders:
information
¢ Inthe Storyboard window, for the user action for which the defect reminder
was created. For details, see "Storyboard Window" on page 201.
o By selecting Results > Defect Reminders
Note: Defect reminders are discarded when you remove a run from the Run
Setup area, replace a run with a new run, or close Sprinter. If the run you are
closing contains defect reminders, a warning message is displayed.
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Comment Dialog Box

12 Relevant for Power Mode only

This dialog box enables you to add a comment to the current user action.
Tasks you can accomplish with the Comment dialog box:
e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Comment dialog box.

Comment | vl |

Text ||

Toaccess | ping atest run, select Tools sidebar > Add Comment button

Important | You can add only one comment per user action. To edit a comment you created
information | for your current action, open the Add Comment dialog box again.

You can view your comments:

¢ Inthe Timeline Viewer, for the user action for which the defect reminder was
created.

o By selecting Results > Run Summary and then clicking the link next to
Comments added.
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Annotation Tools Sidebar

This sidebar enables you to add graphic annotations to a screen capture of your application. It also
enables you to examine the characteristics of the user interface elements in your application and
detect defects in their layout and color.

You can include the annotated screen capture with the defect in ALM. You can also print, save, or
include the annotated screen capture in an email.

Tasks you can accomplish with the Annotation Tools sidebar:
¢ "How to Detect and Submit a Defect" on page 170

The following image shows the Annotation Tools sidebar.

78

2 i
-
Fa

4 ‘;
]

Annotation Tools A

1

To access | Inthe Tools sidebar or the "Actual Result Dialog Box" on page 156, click the

Annotation Workspace button ¥ .

The Annotation Workspace opens with the Annotations Tools sidebar open.

o Click the sidebar tab, or click off the sidebar tab, to close the sidebar.

¢ Toreposition the sidebar, click and drag on the sidebar header.
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Important Some objects like drop-down menus automatically close when you open the

information | Annotation Workspace. Use the keyboard shortcut (CTRL + F10) to open the
Annotation Workspace with these objects displayed.

See also "Using Annotation Tools to Detect Defects" on page 167

User interface elements are described below:

Ul Elements Description

Tools

Selection. Selects a previously created annotation on the annotation
workspace. Once an annotation is selected, it can be moved, resized, or
deleted. Click off the annotation to deselect.

Delete Annotation. Deletes the selected annotations from the
workspace.

Text. Adds a text box to the Annotation Workspace. Use the Properties
area to determine the background color and text color for the text box. A
yellow background has black text, and a black background has white text.
Select the color that will be most visible based on the area on which you
are drawing the text box.

L!

Rectangle. Draws an rectangle on the Annotation Workspace. Use the
Properties area to determine the color and width of the rectangle.

Ellipse. Draws an ellipse on the Annotation Workspace. Use the
Properties area to determine the color and width of the ellipse.

Arrow. Draws an arrow on the Annotation Workspace. Use the
Properties area to determine the color and width of the arrow.

 J

Highlight. Highlights an area of the Annotation Workspace. Click and
drag to define the length and width of the highlight. Use the Properties
area to determine the color of the highlight.

Ruler. Draws a line on the annotation workspace, displaying its length in
pixels. The ruler tool locks the ruler line along the horizontal or vertical
axes while dragging. To release the axis lock, press the Shift key while
dragging. For more details, see "Using Annotation Tools to Detect
Defects" on page 167.
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Ul Elements Description

J

Guides. Displays a vertical and horizontal guide line along the length and
width of the annotation workspace, with their intersection under the cursor
(crosshair). Guide lines can be repositioned using the Select tool. The
vertical and horizontal lines can be also be individually selected and
repositioned.

Click to place the guides on the workspace. For more details, see "Using
Annotation Tools to Detect Defects" on page 167.

Color Picker. Displays the RGB values of a point on the Annotation
Workspace, in a pop-up window. Click alocation to place the pop-up
window on the workspace. For more details, see "Using Annotation Tools
to Detect Defects" on page 167.

Properties

LTI

b

Color and Weight. Determines the color and width of the currently
selected tool from among the Text, Highlight, Arrow, Rectangle, and
Circle tools.

O L ©

Zoom. Zooms in and out on the display of the Annotation Workspace.

The zoom function contains the following controls:

. © Zooms out on the display.

o ENBEIS Restores the display to 100%.

« © Zoomsinonthe display. The display cannot zoom in more than
100%.

= When you zoom in on the image you can then drag the image by
pressing CTRL + LEFT MOUSE BUTTON. The cursor turns into a pointing
hand and you can drag different areas of the image in or out of view
using the mouse or keyboard arrows

You can also zoom in and out using the mouse wheel.

Screen Capture
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Ul Elements Description

&) ~ Screen Capture. Takes a screen capture of your application.

Drop-down options:
o Save. Saves the screen capture of the application.
o Print. Printsthe screen capture of the application.

« Email. Opens a message in your default email application with the
screen capture of the application as an attachment.

|- Smart Defect. Enables you to submit a defect to ALM.
Drop-down options:

o Smart Defect. (Default) Opens the "Smart Defect Settings Dialog
Box" on page 177, enabling you to include automatically generated
defect scenario information in your defect description. For details, see
"Smart Defect Settings Dialog Box" on page 177.

+ New Defect. Opens the New Defect dialog box, enabling you to
manually submit a defect to ALM.

o] Save to Actual Result. Adds the annotated screen capture to the Actual
Results of the current step. Disabled for test with no steps.

Close Closes the Annotation Workspace.
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Run Results

Throughout this guide, descriptions of features that are available only in Power Mode are

identified by the Power Mode'ra icon.

This chapter includes:

Concepts

o "Run Results Overview" on next page

Tasks

o "How to Review Run Results" on page 189

Reference

¢ "Results Group" on page 192

o "User Actions Pane/User Actions Summary Dialog Box" on page 198

o "Storyboard Window" on page 201
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Run Results Overview

Sprinter's run results provide a summary of your run. In the run results you can:

View a summary of your run including basic run information, the number of user actions, run
defects, comments, and a breakdown of the steps by status.

View details of all the steps in your run including actual results and any attached screen
captures or other attachments.

View details of all the defects you submitted during your run. You can open the Application
Lifecycle Management Defect Details dialog box from the run results to review the information in
your defects.

View details of the defect reminders you created during your run. You can submit defects based
on these defect reminders. (Not available when viewing the results in the Results Viewer
without Sprinter installed.)

View details of all the user actions you performed during your run, and convert them to a Unified
Functional Testing-compatible data file.

Open the Storyboard, enabling you to view detailed information for each user action you
performed in your run, and export this information to a PDF or Microsoft Word file.

Sprinter temporarily saves the screen captures of all the actions in your test. You can indicate
whether Sprinter should save the images shown in the Storyboard or discard them after the run.
To indicate which images to capture, open the Run area in the Settings dialog box. For details,
see "Run Settings Pane (Settings Dialog Box)" on page 59.

If the Capture all images in a test option is disabled in the Setting dialog box, your ALM
administrator can enable it in the project. If you do not have permissions in Application Lifecycle
Management, this pane's options will be disabled.

For details, see the "Results Group" on page 192.
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How to Review Run Results

2 Some steps are relevant only for tests run in Power Mode.

This task describes the various steps you can perform to review your run results:
o Review a summary of your run

o Review the steps you performed in your run

¢ Review the defects you submitted during your run

o Review the defect reminders you created during your run

o Review the user actions you performed during your run

o Review details and screen captures of your user actions in the Storyboard

Review a summary of your run

The Run Summary pane displays a summary of the details of your test run, including basic test
and run information as well as a summary of the steps and actions in your test. You can also view
the defects you opened and comments you added, and print or email the summary.

Click the Run Summary node in the Results Group to display the Run Summary pane.

Review the steps you performed in your run

The Steps Summary pane displays a summary of any steps you ran in your test, including actual
results and any attached screen captures or other attachments. You can also export, print, or email
the steps in your test.

Click the Steps Summary node in the Results Group to display the Steps Summary pane. For
details, see "Steps Tab (Results Group)" on page 194.

Review the defects you submitted during your run

The Run Defects pane displays a summary of all the defects you submitted during your run. You
can open the Defect Details dialog box from the Run Defects pane to review the information in your
defects. You can also print or email the summary of the run defects.

Click the Run Defects node in the Results Group to display the Run Defects pane.

For details, see "Run Defects Pane (Results Group)" on page 194.

Review the defect reminders you created during your run

Note: The Defect Reminders Pane is not available when viewing the results in the Results
Viewer without Sprinter installed.
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The Defect Reminders Pane displays a summary of the defect reminders you created during your
run. You can submit defects based on these defect reminders. You can also print or email the
summary of your defect reminders.

Click the Defect Reminders node in the Results Group to display the Defect Reminders Pane.

For details, see "Defect Reminders Pane (Results Group)" on page 196.

2 Review the user actions you performed during your run

The User Actions pane displays a summary of the user actions you performed during your run.
You can export the user actions to an .xls, .xIsx, or.csv file. You can also print and email the list of
your user actions.

Click the User Actions node in the Results Group to display the User Actions pane.

For details, see "User Actions Pane/User Actions Summary Dialog Box" on page 198.

2 Review details and screen captures of your user actions in the
Storyboard

1. Select the Storyboard node in the Results group.
The Storyboard opens.

2. Select an action in the Timeline.

All the user actions you performed in your run are represented in the Timeline as image
thumbnails along the bottom of the Storyboard.

When you select an action in the Timeline, its screen capture is displayed in the upper left pane
and the action details are displayed in the upper right pane of the Storyboard.

You can filter the actions that are displayed in the Timeline. For details on how to filter and
navigate the Timeline, see "Storyboard Window" on page 201.

3. Review the action details.

The upper right pane of the Storyboard displays information about the action you selected in the
Timeline.

From this pane you can:
= View adescription of the action.

= View a list of any defects you submitted for the action. You can click the defect ID link to
open the Defect Details dialog box from Application Lifecycle Management and view or edit
your defect.

= View a list of any defect reminders you created for the action. You can submit defects
based on these reminders.

Page 190 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 6: Run Results

= View the comment, if you added one to the action.
= View any differences that may have been found for the action (Tests run with mirroring only).

4. Export the storyboard to a PDF or Word file.

Select alocation in the file system in which to save the PDF file. This file includes run
information, step status information, and the action details for the entire run session.

For more details on how to view and navigate the storyboard, see "Storyboard Window" on
page 201.
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Results Group

The Results group is located in the left side of the main window.

Tours? ?
m ., =
Print Email
[ Definitions Run Summary
General Settings
Steps (1) [ Test instance: Toursl
Parameters (0) 4]& Test name: Tours|
T Status: () Passed
P2 Resuits
Run Summary . Runname: Run_10-17_13-56-52
Steps (1) ) Tester: admin

Run Defects (3}

Defect Reminders (1) L Starttime:  10/17/2012 1:57:14 BM
User Actians (3) (T) End time:  10/17/2012 2:00:57 PM
Storyboard... ' Duration: 00:03:43
. Actions l_‘l Run Defects l_:‘ﬂ Defect Reminders { ) Comments
....... L i
3 3 1 0

!_0.5] Steps 1

& No Run
1

The Results group contains the following panes:

e "Run Summary Pane (Results Group)" on next page

o "Steps Tab (Results Group)" on page 194

¢ "Run Defects Pane (Results Group)" on page 194

o "Defect Reminders Pane (Results Group)" on page 196

o "User Actions Pane/User Actions Summary Dialog Box" on page 198

¢ "Storyboard Window" on page 201
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Run Summary Pane (Results Group)

This pane displays a summary of the details of your test run. You can view basic test and run
information as well as a summary of the steps and actions in your test and the defects and

comments you opened.

Tasks you can accomplish with the Run Summary pane:

+ "How to Review Run Results" on page 189

The following image shows the Run Summary pane.

Some result information is available only for tests run in Power Mode 2.

m. =

Print Email

Run Summary

¥

[ Test instance:
y K Test name:

Status:

Tours1
Tours1

) Passed

@ Run name:
T Tester: admin

Run_10-17_13-56-52

B Start time:
| @ ) End time:
) [ Duration:

10/17/2012 1:57:14 PM
1001772012 3:03:59 PM
00:07:29

3

»H Actions |_] Run Defects
5

L’Cj) Defect Reminders |

2

) Comments

0

[#¥ steps 4
() Passed [ Blocked © NoRun & Failed
1 1 1 1
To access After arun, select the Results > Run Summary node.

Descriptions of the user interface elements are available in the pane.
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Steps Tab (Results Group)

This tab displays a summary of the steps you performed in your test. It also enables you to export,
print, or email your step information.

Tasks you can accomplish with the Steps tab:
o "How to Review Run Results" on page 189

The following image shows the Steps tab.

xe B, X
Export Print Email
Steps
# Status  Name Description Expecte
1 Q Step 3 Enter "jo" in the "j_usermame” edit field.
2 Q Step 4 Enter the encrypted password in the "j_password” edit
field.
3 Q Step & Click the "Login” button.
4 o Step 6 Click the "Money Transfer " link.
5 (T Step T Select the "Money Market [543877] $84.00" item from
the "fromAccount” combo box.
] © Step&  Selectthe "Checking [543875] §1,757.00" item from
the "toAccount” combo box.
7 © Stepd  Click the "Mext” button.
H] ©  Step10 Enter "68" in the "amount” edit field.
] @&  Step 11 Click the "25" link.
10 Q Step 12 Click the "Mext” button.
1 &  Step13  Click the "OK" button.
12 o Step 14 Click the "Logout” link.
m b

To access | Afterrunning a test or component, select the Results > Steps node.

Important e You can resize the Sprinter window and the columns in the display to view all
information the information.

¢ Double-clicking a thumbnail in the Screen Capture column or the
Attachments column opens the attachment in the default program on your
computer for that file type.

¢ You cannot Export, Print, or Email steps in a Business Process Test.

Run Defects Pane (Results Group)

This pane displays a summary of the defects you submitted during your test run. You can also
export, print, or email a summary of your run-time defects.

Tasks you can accomplish with the Run Defects pane:
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o "How to Review Run Results" on page 189

The following image shows the Run Defects pane.

2. B, =B| [

Export Print Email I Show Defacts in ALM

Run Defects

Defect ID  Summary Severity Status
1 Broken Link Main Fage 2-Medium  New
2 CObsolete CGI script 3-High Mew
3 General Error 4-%ery High New
To access After arun, select the Results > Run Defects node.

Important information | « Clicking the Defect ID number opens the Defect Details dialog box
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Defect Reminders Pane (Results Group)

This pane displays a summary of the defect reminders you created during your test run. It enables
you to submit defects based on information in your defect reminders, and to export, print, or email
your defect reminders.

Tasks you can accomplish with the Defect Reminders pane:
o "How to Review Run Results" on page 189

The following image shows the Defect Reminders pane.

R . @ .= [

Export Print Email Submit Defact

Defect Reminders

Summary

Spellcheck error found in; M+
Spellcheck errors found inh=

To access | After running a test or component, select the Results > Defect Reminders node.

Important o Defect reminders are discarded when you remove a run from the Run Setup

information area, replace a run with a new run, or close Sprinter. If the run you are closing

contains defect reminders, a warning message is displayed.
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The table below provides additional information for some of these elements:

ul
Elements Description

& Drop-down options:
Submit Defect

o New Defect. Opens the New Defect dialog box, enabling you to manually submit

a defect.

o Submit Defect. (Default) Enables you to automatically include defect scenario
information in your defect. For details, see the "Smart Defect Settings Dialog
Box" on page 177.

When you create a defect from the defect reminders pane, the same information is
available for you to include in the defect as is available when you open the defect
during the run. You can include a screen capture of the application as it appeared for
the user action when the reminder was created, and the steps or actions in your test

run.

When you create a defect from a defect reminder, the defect reminder is deleted.
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User Actions Pane/User Actions Summary
Dialog Box

12 Relevant for Power Mode only

This area displays a summary of the user actions you performed during your run and any comments
you added for each action. It also enables you to export, print, or email your user action information.
This pane also allows you to export the run to a manual test or to a Unified Functional Testing (UFT)

test.
Tasks you can accomplish with the User Actions pane/User Actions Summary dialog box:
o "How to Review Run Results" on page 189

The following image shows the User Actions pane.

Py o B M. . 2
| Generate Test Exportto UFT Export Print Email
User Actions
Action Time Description Comment
1 2:40:26 PM  Enter "Flowers™ in the "guery" edit field.
2 24030 PM Click the "bitn_search_hp_text" image.

To access o Afteratest run, select the Results > User Actions node.
e During arun, select the Tools sidebar > Show User Actions button.
o Select the Results > User Actions node.

Select the Results > User Actions node.

Important e The User Actions Summary dialog box displays user action information during
information atest run. It contains most of the information and most of the functionality as

the User Actions pane.

o Useractions are recorded only in Power Mode.
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User interface elements are described below:

ul
Elements Description

Generate | Enables you to export all user actions as test steps in a new manual test. You can

Test add test details, format and edit the steps, and save the new test to Application
Lifecycle Management. For details, see "Generate Test Dialog Box" on page 161.
Note: This option is available only at the end of the run session.

Export Enables you to export all user actions and application control definitions to an XML

to UFT

file and save this file in the file system.

This file can be converted to a GUI test with a local object repository in

HP Unified Functional Testing. For details on the functionality available with
HP Unified Functional Testing, go to the HP Software Web site at
www.hp.com/go/software.

Note: This option is available only at the end of the run session. If you close the test
and reopen it in Run mode, you will not be able to perform this export.

Export Enables you to export all user actions to an external spreadsheet. You can modify
the data in the external file and then use the Import Steps option in the Plan mode's
Steps tab.
Drop-down options:
o Export to Excel
e Export to CSV

Print Prints the user action list.
Drop-down options:
e Print
e Print Preview

Email Enables you to email the user action list as an attachment. A default mail client must
be installed on the Sprinter machine.
Note: On Windows Vista or XP, you must install The XPS Viewer in order to view
the report attached to the email. This viewer is available from the Microsoft website.
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ul
Elements Description

User A list of user actions performed during the run session. The following information is
Actions | gyailable for each user action:

e Action
e Time
o Description

¢ Comment
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Storyboard Window

This window displays information for each user action in your run. You can:

o View the description of each user action

o View the defects submitted, defect reminders, comments, and differences found for each

action.
o Filter the displayed actions.
o Export the storyboard to a PDF or Microsoft Word file.
Tasks you can accomplish with the Storyboard:
¢ "How to Review Run Results" on page 189

The following image shows the Storyboard.

‘Storyboard - Order Flight in DemoTours1 (24 User Actions)

[ a5 x|

Action 8 - 5/10/2012 5:00:10 PM

P e

Smart Defect  Export o Word  Maximize

Login - Click the "Sign-In" image

LURun Defects
Mone

LaDefect Reminders
None

Comments
Mone

Timeline

oy v o | - 8 -

To
access

Do one of the following:

o Select the Results > Storyboard node.

button.

e During arun, click Tools sidebar > Storyboard.

¢ Right-click a test in the Test Runs list, and select Show All Runs. In the The "Test
<'Test Name">: All Runs Dialog Box" on page 131 opens. Click the Storyboard
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

Smart Defect

Enables you to submit a defect to Application Lifecycle Management.
Drop-down options:

o Smart Defect. (Default) Enables you to include automatically
generated defect scenario information in your defect description. For
details, see "Smart Defect Settings Dialog Box" on page 177.

¢ New Defect. Opens the New Defect dialog box, enabling you to
manually submit a defect.

When you create a defect from the Storyboard, the same information is
available for you to include in the defect as is available when you open the
defect during the run. You can include a screen capture of your
application during your user action, and a list of the steps or actions in
your test run.

Export to Word

A drop-down menu that lets you to export the storyboard to a Word or
PDF file. This file contains the run summary, step status, and defect
information for the run session.

Note: If you want it to also include images, make sure to enable image
captures in the Run area of the Settings dialog box before the run. For
details, see "Run Settings Pane (Settings Dialog Box)" on page 59.

If the Capture all images in a test option is disabled, your ALM
administrator can enable it for the project. In ALM, select Tools >
Customize. In the Project Customization window, select the Sprinter
node, and select the desired options in the Screen Captures section. For
example, Enable Storing of all images during a test.

Maximize/Minimize

Zooms in or out of the screen capture selected in the Timeline.

<Action screen
capture>

Displays a screen capture of the action selected in the Timeline.
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Ul Elements Description

<Action details> Displays the following:

e A description of the user action.

o Defects. All the defects submitted for the action. Clicking the link fora
defect opens the Defect Details dialog box from Application Lifecycle
Management.

o Defect Reminders. A list of all the defect reminders you created for
the action. Click Create Defect to open the Smart Defect Settings
Dialog Box, enabling you to automatically include defect scenario
information in your defect.

e Comments. A list of all the comments you added to the action.

o Differences. A list of all the differences found for the action. Click
Show, to open the Differences Viewer.

The Differences Viewer displays the details of the differences and any
rules you created for the action. You can also open a new defect from
the Differences Viewer.

Timeline Displays a thumbnail view of each action in the run. Each thumbnail can
contain any of the following icons indicating the details of the action:

o [ A defect was submitted for this action.
¢ [& A defect reminder was created for this action.
¢ = A comment was added to this action.

o &2 Differences were found for this action.

<Timeline filtering | The Timeline contains the following filter buttons:
options>
e LA Filter Defects

e v Filter Defect Reminders
e I Filter Comments

o ':':f' Filter Differences

When you click a filter button, the Timeline displays only those actions
that contain the selected filter item. Click the filter button again to turn the
filter off.
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Ul Elements Description

<Timeline The Timeline contains the following navigation buttons:
navigation
buttons>

e = Prev. Retumns the Timeline one defect back.

e =« Next. Advances the Timeline one defect forward.

If you filter the Timeline, the Prev and Next buttons advance or return you
to the next or previous action in the filtered list of actions.

You can also filter just the Prev and Next behavior using the drop-down
options under these buttons.

These drop-down options control the functionality of the Prev and Next
buttons, but do not filter the Timeline.

When you select a drop-down option in one button, the same option is
automatically selected in the other button, and the Prev and Next buttons
advance or return you to the previous or next action that contains the
selected option.

Drop-down options:

o 51 &Previous/Next Defect
. 'E&%Previous/Next Defect Reminders
e 7 "Previous/Next Comment

&b W-Previous/Next Difference
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Power Mode

Throughout this guide, descriptions of features that are available only in Power Mode are
identified by the Power Mode"9 icon.

This chapter includes:

Concepts

o "Power Mode Overview" on next page

o "Applications" on page 207

Tasks

e "How to Prepare a Test to Run in Power Mode" on page 210

Reference

o "Power Mode Group" on page 212

o "Application Pane (Power Mode Group)" on page 214

"Troubleshooting and Limitations - Power Mode" on page 223
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Power Mode Overview

When you run a test in Power Mode, Sprinter learns your application's display and identifies its
objects. This information enables Sprinter to track your activity during your test run. It also enables
Sprinter to help you perform some of the user actions on your application.

With this information, Sprinter can:

o Create and run macros to allow Sprinter to perform a set of actions in your application for you.
« Automatically enter datainto fields in your application.

¢ Replicate your user actions on multiple machines.

¢ Scan the application for potential defects.

o Keep arecord of your user actions. Add comments and reminders to the recorded user actions in
your run, for later review.

o Keep arecord of the defects you submitted for each action.

o Automatically include the list of your steps or user actions in any defect you submit to create a
defect scenario for you.

For Sprinter to be able to learn your application's display, you need to define the application you will
be testing.

For more details, see:
o "Applications" on next page
e "How to Prepare a Test to Run in Power Mode" on page 210

When you run a test in Power Mode, you can accomplish the following tasks:

"How to Inject Data into your Application" on page 231

"How to Record and Run Macros" on page 245
e "How to Run a Test with Mirroring" on page 286
e "How to Scan Your Application For Potential Defects" on page 257

For more details, see "Running Tests in Power Mode" on page 112.

Page 206 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 7: Power Mode

Applications

To work with Power Mode features, you must define the application you will be testing. This
enables Power Mode to run advanced features such as data injection and macros on your
application.

Many Power Mode configurations are associated with their specific application.

Because you define application for your test, all tests have the same defined application will share
the same Power Mode configuration. This saves you the time of redefining these configurations for
each one of your tests.

You can also define applications in Plan mode, when creating new tests or components. For
details, see " Select Application Dialog Box" on page 102.

Example: Suppose you are testing a banking application. You create a test and define your
application with the name My Banking App. During your test you then record a macro on the
login page and save it with the name Login Macro. Sprinter remembers that the Login
Macro macro was recorded forthe My Banking App application.

In the future, whenever you run atest withMy Banking App defined as its application, the
Login_ Macro macro will be available for your test.

The following information is associated with the application in your test:

o Datainjection data sets

o Macros

o Rules (for use with mirroring)
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When you define an application, you provide Sprinter with a logical name for the application. Power
Mode associates your information with this logical name. This logical name is displayed next to the
Application node in the "Power Mode Group" (described on page 212), and in the "Application Pane

(Power Mode Group)" (described on page 214).

Zower Mode

Application (MercuryTours)
Data Injection (0)
Macros (0)

Mirroring Rules (0)

Scanners (0/4)

Mirrcring (D)

Run Setup LTy Application ?
i e id [d 4 X
P> Open Save Favorites Quick Add  Add Edit Remove
[ Application: |MercuryTours o
2« Test Runs . | : -]
Mame Status

MercuryTours - Details

Type: Web application

Browser: Intemst Explorer

Technologies: Web

Run Settings:

URL: nitp:iinewtours demoaut comimercurywelcome. php

Sprinter will start the application when the run begins.

You may want to create more than one version of an application with different logical names, and

associate specific information with each version.

Example: Suppose you are testing a banking application that has multiple versions for different

languages. Each version of the actual application is named Banking. You can define multiple

banking applications for your tests, and give each one a meaningful, logical name such as

Banking SpanishandBanking French.

You can then associate different information with each version of the application. For example,

you can associate Spanish data sets with the Banking Spanish application and French

data sets withthe Banking French application.

Whenever you run a test with Banking Spanish as the defined application, the Spanish
data sets will be available. Whenever you run a test with Banking French as the defined

application, the French data sets will be available.

Page 208

HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 7: Power Mode

For details on how to configure Power Mode features, see "How to Prepare a Test to Run in Power
Mode" on next page.

For more details on how Sprinter maintains application information and which features are
associated with the defined application, see "How User Information is Maintained" on page 44.
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How to Prepare a Test to Run in Power Mode

The following steps describe how to prepare a test to run using the advanced features available with
Power Mode.

o This task assumes you already understand how to run a test in Sprinter. For details, see "How to
Run a Manual Test in Sprinter" on page 114.

o This task does not include information about how to prepare a test to run with mirroring. For
details on running a test with mirroring, see "How to Prepare a Test for Mirroring" on page 284.

o This task does not include information about how to configure scanner settings. For details, see
"How to Scan Your Application For Potential Defects" on page 257.

For details on Power Mode features, see "Running Tests in Power Mode" on page 112.
This task includes the following steps:
o Enable Power Mode for your test

Configure the application for your test

o Configure data injection

o Review the macros for your application
o Results

Enable Power Mode for your test

Click the Power Mode button Bl in the Power Mode group. The Power Mode button tumns

green and displays On, the Run button displays the Power Mode icon #~ | and the Power Mode
group nodes are displayed.

Configure the application for your test
You must configure an application for your test to run it with Power Mode.

Click the Application node in the Power Mode group and use the options in the Application pane to
configure your application.

For details on working in the Application pane, see "Application Pane (Power Mode Group)" on page
214,

Configure data injection
1. Create a data set.

To use data injection you must first create a data set in .xls, .xIsx, or .csv format. For details on
how to format a data set, see "Guidelines for Creating Data Injection Data Sets" on page 229.
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After you create a data set you can store it in your file system or in Application Lifecycle
Management. To store data sets in Application Lifecycle Management, upload them to the
Resources folder for your project. For details on uploading resources, see the Application
Lifecycle Management User Guide.

Note: Sprinter stores the path to the data file in the DataSource.xml file in Sprinter's
Resources folder. It is not recommended to modify this folder.

2. Associate the data set with your application.

After you create the data set, you associate it with your application in the Data Injection pane
of the Tests Explorer. For details, see "Data Injection Pane (Power Mode Group)" on page 234.

Data can be automatically entered into forms only in the application that is defined in the
"Application Pane (Power Mode Group)" on page 214. For details, see "Application Pane (Power
Mode Group)" on page 214.

3. Define which fields you want to inject, and in what order - Optional.
If you want to use all the fields in your data set, in the order they appear, you can skip this step.

Click the Customize Fields button in the Data Injection pane to define which field you want
automatically enter in your application and in what order they should be entered. For details, see
"Manage (& Map) Fields Dialog Box" on page 237.

Review the macros for your application
If you have already defined macros for this application, click the Macros node to review, edit, and
delete the Macros associated with your application.

For more details, see "Macros Pane (Power Mode Group)" on page 247.

Results
You are now ready to run a test in Power Mode, as described in "How to Run a Manual Test in
Sprinter" on page 114.
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Power Mode Group

The Power Mode group enables you to turn Power Mode on and off. When you turn Power Mode on
and select one of the nodes in the Power Mode group, the right pane displays the settings for that
node.

For details on which features are available in Power Mode, see "Running Tests in Power Mode" on
page 112.

Tasks you can accomplish with the Power Mode group:
e "How to Prepare a Test to Run in Power Mode" on page 210
o "How to Prepare a Test for Mirroring" on page 284

The following image shows the Power Mode group.

rPower Mode (& On |

Application {MercuryTours)

Data Injection {0)
Macros (0}
Mimoring Rules (0)

Scanners (0/4)

Mirrcring (0}
To access In the Power Mode group, click the On button.
Important You must define an application for your test in order to run it in Power
information Mode.

The Power Mode group contains the following nodes:

ul
Elements Description

Application | Defines the application you want to test.

The application currently defined for your test is displayed in parenthesis in the
Application node.

For details, see "Application Pane (Power Mode Group)" on page 214.
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Ul
Elements

Data
Injection

Description

Defines the data sets you want to use with the data injection feature.

The number of data sets currently defined for use with your application is
displayed in parenthesis in the Data Injection node.

For details, see "Data Injection Pane (Power Mode Group)" on page 234.

Macros

Displays the macros that are associated with the currently defined application.

The number of macros currently defined for use with your application is displayed
in parenthesis in the Macros node.

For details, see "Macros Pane (Power Mode Group)" on page 247.

Mirroring
Rules

Displays the rules that are associated with the currently defined application.

The number of rules currently defined for use with your application is displayed in
parenthesis in the Rules node.

For details, see "Mirroring Rules Pane (Power Mode Group)" on page 304.

Scanners

Defines the settings for each scanner that you want to use during your run.

You can scan your application for spelling errors, Web Standards errors (Web
applications only), broken links, and localization errors. For details, see "Scanners
Pane (Power Mode Group) / Scanner Settings Dialog Box" on page 262.

Mirroring

Defines the secondary machines on which you want to replicate the actions you
perform during your run.

The number of secondary machines currently defined for with your application is
displayed in the parenthesis in the Mirroring node. For details, see "Mirroring Pane
(Power Mode Group)" on page 294.
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Application Pane (Power Mode Group)

This pane enables you to define or select the application that your test will use. You can also add,
edit, or delete existing applications.

Tasks you can accomplish with the Application pane:
e "How to Prepare a Test to Run in Power Mode" on page 210

The following image shows the Application pane when there are no previously defined applications.
Application (none) ?

L4 O L X

Quick Add  Add Edit Remove

This area enables you to define which applications are available for use in your tesis

Click Quick Add fo select from a list of currently running applications

Click Add to manually define an application

The following image shows the Application pane when there are previously defined applications.

Application ?

4 @ @ X

Quick Add  Add Edit Remove

Application: |Merc.t'y' Tours | - |

Mercuty Tours - Details

Type: Web application
URL: hitp:/inewtours.demoaut.com
Browser: Intemet Explorer

Technologies: Web

Run Settings:

Sprinter will start the application when the run begins.

To access Select Power Mode group > Application node.
Important For details on how Sprinter maintains the list of applications, see "How User
information

Information is Maintained" on page 44.

See also "Applications" on page 207
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The Application pane contains the following user interface elements:

Ul
Elements

Description

Add

:"1 Opens the "Quick Add Application Dialog Box" (described on page 221), enabling
Clek Ad you to add an application to your application list from a list of currently running
applications.
E{'l Opens the "Add/Edit Application Dialog Box" (described on page 216), enabling

you to manually define a new application to add to your application list.

[z

Edit

Opens the "Add/Edit Application Dialog Box" (described on page 216), enabling
you to edit the application details for the selected application in the application list.

* Removes the selected application from the application list.

Femove

Application | The list of available applications (when applications are defined). Use the
QuickAdd, Add, Edit, and Remove buttons to manage your list of applications.
To use a previously defined application, enter the first few characters of the name
and then select it from the displayed list.
For details on how Sprinter maintains the list of applications, see "How User
Information is Maintained" on page 44.

Application | Displays information about the application you selected in the Application list

details area | yhen applications are defined). Click the Edit button to open the "Add/Edit
Application Dialog Box" (described on page 216) and edit these details.
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Add/Edit Application Dialog Box

This dialog box enables you to define or modify the settings for your application.

Tasks you can accomplish with the Add/Edit Application dialog box:

¢ "How to Author a Test or Component” on page 70

e "How to Prepare a Test to Run in Power Mode" on page 210

When you select the Web Application button, the Settings area enables you to set options

specific to Web applications.

Add Application

= MName: | New Application{2)
" | O
Web Application Deskiop Application
Settings: URL- |

Browser:

Enter the web application’s address (for example: www hp.com).

Technologies:

[ ActiveX [ GWT
[ ASPAjax [ Java
] Dojo ] sAP

O silveright [ WPF
Web ] *ahooUI
[ NET ) jQueryll

1 Record on any open application

| Start the application when the run begins

When you select the Desktop Application button, the Settings area enables you to set options

specific to desktop applications.
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Add Application ~
+ MName: | Mew Application(2) |
™ @ -
Web Application Desktop Application
Seftings: *Location:l | Browse...
Enter the full path to the location of the application's executsble file.
Additional Settings =>
Technologies: | — ey [ GWT [ Silverlight [ WPF
[T ASPAjax [ Java W) Web ] YahooUl
[ Dojo [ saP [ NET [ jQueryut
¥ Start the application when the run begins
1 Record on any open application
| Cancel |
To access In Plan mode:
o Create or open a test or component.
o Intheright pane, click the Steps tab.
o Expand the Steps Capture button and choose SelectApplication.
o Click the Add or Edit button.
In Run mode:
o Select Power Mode group > Application node > Add or Edit button.
See also "Applications" on page 207
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User interface elements are described below:

Ul Elements Description

Name The name of the application you want to run in your test. You can give the
application any name that will help to clarify the application.

For example, you might want to use a name that identifies the application as the
foreign language version of an application, suchas My application -
Spanish.

Type Web Application. Select this button if you want to define a web application.

Desktop application. Select this button if you want to define a desktop

application.
Settings URL. The URL address of the Web application you are defining.
(when
defining a Browser. The browser in which you want to run the Web application. For a list
Web of supported browser versions, see the HP Sprinter Readme.
application)
Additonal Close the browser when the test closes. Automatically close the browser at
Settings the end of the test.

Location. The path to the desktop application (if relevant).

Parameters. Any parameters you want Sprinter to use when it starts the
application.

Working folder. The working folder for the desktop application. The working
folder is used by the application to search for related files. If a working folder is
not specified, the application's executable folder is used as the working folder.
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Ul Elements Description

Technologies | The technologies used in developing the application being tested.

o For Power Mode to work, you need to ensure that all the technologies that
were used to develop your application are selected. Consult the application
developers if you are not sure which technologies to select.

Some technologies depend on other technologies to run. Some of these
dependencies are automatically selected and disabled in the Technologies list.

o Forbest performance it is recommended to avoid selecting unnecessary
technologies.

o Web is selected by default for Web applications.

¢ You can make use of Web Extensibility packages developed for QuickTest
/Unified Functional Testing to enable Power Mode to support objects that are
not supported out-of-the-box. Extensibility packages can be developed for
Web, Java, .NET Windows Forms, WPF, and Silverlight. For details, see
"Using Web Extensibility Packages" on page 332.

o For SAP GUI for Windows troubleshooting and limitations, see
"Troubleshooting and Limitations - Power Mode" on page 223.

Start the Instructs Sprinter to automatically start the application when you start your run.

application
when the run | It is recommended that you configure Sprinter to start your application when the

begins run begins or manually start your test application after you begin your run.
For desktop applications that use Java, ActiveX, and Web applications:

o Sprinter can only work with these applications if they start when the runs
begins.
« If you do not configure Sprinter to start your application when the run begins,

you need to manually start your application after you begin your run.

o Sprinter will work with any Java application that is started when the run
begins or after the run begins.

For desktop applications that do not use ActiveX:

o Sprinter can work with these applications that were already running before
the run begins. Sprinter is set by default to not start these applications when
the run begins.
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Ul Elements Description

Record on Instructs Sprinter to record user actions on any open application and not only
any open the application defined in the Add Application dialog box. This can be useful
application

when your test involves using more than one application and you want to record
the user actions for all applications.

Selecting this option may affect performance.
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Quick Add Application Dialog Box

This dialog box enables you to add a new application to your application list by selecting it from a
list of currently running applications.

Tasks you can accomplish with the Quick Add Application dialog box:
o "How to Author a Test or Component" on page 70
e "How to Prepare a Test to Run in Power Mode" on page 210

The following image shows the Quick Add Application dialog box.
Quick Add Application [~

Select the application you want to add.

;] Calculator
[ /J Network Activity
(-x.' Altiris Client Service

&2 HP Application Lifecycle Mar

To access In Plan mode:

o Create or open a test or component.

In the right pane, click the Steps tab.

Expand the Steps Capture button and choose SelectApplication.

Click the Quick Add button.

In Run mode:

o Select Power Mode group > Application node > Quick Add button.
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Important
information

Application details are entered automatically.

e To change the application details, open the "Add/Edit Application Dialog Box"
on page 216 (Power Mode group > Application node. Select the application
from the application list and click the Edit button.)

o Quick Add does not automatically enter the URL of Web applications in the
URL field. You need to enter the URL information manually in the "Add/Edit
Application Dialog Box" on page 216.

Quick Add automatically selects the technologies used in developing the
application being tested.

¢ You need to ensure that all the technologies that were used to develop your
application are selected.

e Some technologies depend on other technologies to run. Some of these
dependencies are automatically selected and disabled in the Technologies list.

o Webis selected by default for Web applications.

For desktop applications that use ActiveX and Web applications:

o Sprinter can only work with these applications if they start when the runs
begins. Sprinter is set by default to start these applications when the run
begins.

For desktop applications that do not use ActiveX:

o Sprinter can work with these applications if they were already running when the
run begins. Sprinter is set by default to not run these applications when the run
begins.
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Troubleshooting and Limitations - Power
Mode

This section describes troubleshooting and limitations for Power Mode.

General Limitations

o When working with Power Mode, you should not have more than one instance of the application
you are testing open on any machine in your run.

o Applications that have a hidden mode may not display in the list of applications, if they were
hidden when you opened the Quick Add Application dialog box.

o In 64-bit operating systems, if you are logged in as an ordinary (non-administrator) user, but run
an application as administrator, it will not be listed in the Quick Add Application dialog box.
Workaround: Close the application and restart it without administrator privileges or add the
application manually.

¢ If you do not have Excel 2007 installed on your machine, you must have the 2007 Office System
Driver installed, to work with data sets in the .xlsx format. The 2007 Office System Driveris
available for download here at
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=23734.

o Application names cannot contain the following characters:
N /s x 2> | sl )

Workaround: Remove the characters from the name of the application in Sprinter to enable the

test torun.

o Itis recommended that when you work with Power Mode you configure Sprinter to start your
application when the run begins or manually start your application after the run begins. If your
application was started before the start of the run, Sprinter may be unable to recognize it.

Web Browsers

o Sprinter does not recognize dialog boxes opened by Mozilla Firefox.

o Totest your Web application on Firefox 8 or higher, you need to enable QuickTest Professional
or Unified Functional Testing Plugin support, in any of the following ways:

= If the Select Your Add-ons screen is displayed when opening Firefox, select to keep the
QuickTest Professional or Unified Functional Testing Plugin.

= [f the Install Add-on tab opens and displays QuickTest Professional or Unified Functional
Testing Plugin when opening Firefox, select the Allow this installation check box and click
Continue.

o If neither of these are available, enable the add-on manually:
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a. InFirefox, select Tools > Add-ons.
b. Inthe General tab, click Manage Add-ons (not relevant in some versions).
c. Inthe Add-ons Manager tab, select the Extensions node.

d. Click the Enable button in the QuickTest Professional or Unified Functional Testing
Plugin row.

Java Applications

o Before Sprinter can work with Java objects, you need to run the Sprinter JRE Support Tool

(JavaEnabler.jar).

= You only need to run this tool the first time you want to work with a Java object, on machines
that have a JRE version of 1.6 or lower.

= The tool can be found in the C:\<Sprinter installation folder>\bin directory.

= For more information, run the Sprinter JRE Support Tool and click the Help button.

Google Web Toolkit (GWT)

o Inuser action descriptions, Sprinter does not properly identify GWT Richtext edit boxes by
their name.

Silverlight

o Sprinter does not support windowless Silverlight applications hosted in Mozilla Firefox.

o Towork with Silverlight, your Silverlight application must be initialized with the
EnableHtmlAccess property value set to ' True'. For details, see
http://msdn.microsoft.com/en-us/library/cc838264(VS.95).aspx

SAP GUI for Windows Applications

General Limitations

o Sprinter does not support capturing and replicating user actions performed on HTML elements
embedded in SAP GUI for Windows applications.

o Microsoft Office controls within an SAP window are not supported.
e The SAP Editor control is not supported.
o The OK button in SAP messages for connecting to the SAP Scripting APl is not captured.

¢ When the Compare All option is selected in the Machines sidebar during a mirroring session,
Sprinter does not compare cell content in SAP Table controls.

o Sprinter captures user actions only when the SAP GUI for Windows client sends information to
the SAP back-end server. When this occurs, all of the user actions that were performed between
the previous communication and the current one are captured. Therefore, Sprinter captures an
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image of each screen that is sent to the server only after all of the user actions have been
performed during that communication.

o Forsecurity reasons, the SAP scripting API prevents capturing user actions that contain
passwords. When you insert a password in a password box, Sprinter captures a Set statement
using asterisks (* * **) as the method argument value. For this reason, Login cannot be
recorded as a macro and cannot be replicated when using mirroring.

o Sprinter does not capture user actions performed in standard Windows dialog boxes that are
used by your SAP GUI for Windows application (such as the Open File and Save As dialog
boxes). This is because the SAP scripting API does not support these dialog boxes. This may
also occur when using SAP GUI for Windows with GuiXT. Therefore, you must manually
perform these user actions on all machines while running macros or using mirroring.

Installation Prerequisites

When you install your SAP GUI for Windows application, you must select the SAP GUI Scripting
installation option. If you did not select this option when you installed the SAP GUI for Windows
application, it is essential that you reinstall it and select this option before running steps on that
application.

Note: SAP provides a range of security mechanisms that allow the administrator to limit the
use of SAP GUI Scripting by system, by group, by user, and by scripting functionality. To test
SAP GUI for Windows applications, you must ensure that these security mechanisms are not
activated for the application you are testing. For details on the various security options, see the
online SAP GUI Scripting Security Guide at the SAP Service Marketplace.

Enabling Scripting on the SAP Application (Server-Side)

After you confirm that you have the proper support package and kermnel patch levels installed, you
must enable scripting on your SAP application. By default, scripting is disabled.

You enable scripting by entering the Maintain Profile Parameters window with administrative
permissions and setting the sapgui/user_scripting profile parameter to TRUE on the application
server.

To enable scripting for all users, set this parameter on all application servers. To enable scripting for
a specific group of users, set the parameter only on application servers with the appropriate access
restriction settings.

Note: If you connect to a server on which scripting is disabled, an error message displays
when you try to record on your SAP GUI for Windows application.

Enabling Scripting on the SAP Application (Client-Side)
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To test SAP GUI for Windows applications with Sprinter, you must confirm that scripting is enabled
on the SAP GUI for Windows client.

It is recommended to disable warning messages in the SAP GUI for Windows environment when
working with Sprinter. When using mirroring, it is recommended to also disable warning messages
on all secondary machines.

Eliminating Warning Messages

By default, you may receive warning messages when using Sprinter with an SAP GUI for Windows
application: When Sprinter connects to the Scripting AP, the following warning message is
displayed: A script is trying to attach to the gui.

It is recommended to disable the warning messages in the SAP GUI for Windows application when
working with Sprinter.

Checking the Connection Speed on the SAP Server

When you log on to SAP using the Low speed connection option to communicate with the server,
the SAP server does not send sufficient information for Sprinter to properly run steps. (Sprinter
displays an error message if the Low speed connection option is selected.) Therefore, confirm
that this option is not selected for the server to which you are connecting before running Sprinter
tests.

For details, see SAP OSS note #587202.
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Data Injection

Throughout this guide, descriptions of features that are available only in Power Mode are

identified by the Power Mode"9 icon.
This chapter includes:
Concepts
o "Data Injection Overview" on next page
o "Guidelines for Creating Data Injection Data Sets" on page 229
Tasks
e "How to Inject Data into your Application" on page 231

Reference

"Data Injection Pane (Power Mode Group)" on page 234

"Data Set Details Dialog Box" on page 236

¢ "Manage (& Map) Fields Dialog Box" on page 237

"Data Injection Sidebar" on page 240

"Troubleshooting and Limitations - Data Injection" on page 242
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Data Injection Overview

Relevant for Power Mode only

During the testing process, it is often necessary to enter pre-defined data into a form in the
application being tested. To make the data entry process faster and less error-prone, data injection
enables you to automatically enter data contained in an .xls, .xIsx, or .csv file (data set) into fields
in your application. For details on creating a data set, see "Guidelines for Creating Data Injection
Data Sets" on next page.

You can store data sets in your file system or in Application Lifecycle Management. To store data
sets in Application Lifecycle Management, upload them to the Resources folder for your project.
For details on uploading resources, see the Application Lifecycle Management User Guide.

Note: Sprinter stores the path to the data file in the DataSource.xml file in Sprinter's
Resources folder. It is recommended that you not modify this folder.

After you create a data set, you associate it with your application in the Data Injection pane of the
main window. When you associate a data set with an application, it is available for use in any test
that is configured to use the currently defined application.

If you previously associated a data set with your application it is automatically available for your
test.

Using Sprinter, you can map the column headings of your data set with the field names in your
application.

Sprinter also allows you map fields automatically or manually. In automatic mapping, Sprinter
scans the application for field names that match the data set's column names.

If, however, the names of the columns in your data set do not match those in the application or if
there are multiple fields with the same name, you can manually map the fields. All mappings are
saved with your test.

You can also define which fields in your data set you want to enter in your application and in what
order. For details, see "Manage (& Map) Fields Dialog Box" on page 237.

For details on preparing a test to run with data injection, see "How to Prepare a Test to Runiin
Power Mode" on page 210.

For details on associating a data set with your application, see "Data Injection Pane (Power Mode
Group)" on page 234.

For details on using data injection during a test run, see "How to Inject Data into your Application"
on page 231.
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Guidelines for Creating Data Injection Data
Sets

Follow these guidelines when creating data injection sets:

To use data injection you must first create a data set in .xls, .xlsx, or .csv format.

Each application field into which you want to inject data must be represented by a column in your
data set. The column header should be the field name of the field in your application. Data
injection matches the column headers with the field names in your application.

Data injection uses Smart Matching to map between the field names and column headings.
Therefore, the two do not need to exactly match for data injection to map the correct field to its
column.

Field matching is not case-sensitive.
Field matching ignores leading and trailing blank spaces in column headers.
Field matching ignores double blank spaces in column headers.

If there is too great a difference between the field name in your application and the column
headings in your data set, Smart Matching may not correctly match the field to its heading. In
this case, modify the column heading in the data set to more closely match the field name in the
application.

If a field in your application has a very long text label, the column header needs to include at
least the first 10 characters of the label for field matching to create a match.

To use Data Injection to select a check box in your application, use the field name of the check
box as the column header, and use any of the following as the data value to set the check box as
selected/deselected:

On/Off
Yes/No

Y/N

1/0
True/False
Succeed/Fail

Success/Failure

o Touse Data Injection for drop-down boxes, use the field name of the drop-down as the column

header, and the selection from the drop-down list as the data value.
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o Data Injection cannot be used on radio buttons.

o If your application has a field name that is followed by multiple unlabeled fields (for example a
Date field that is followed by edit boxes for Day, Month, and Year, but which are not individually
labeled), Data Injection will inject data only into the first field.

o When Smart Matching succeeds, Sprinter saves the mappings for all future runs.

o Data Injection ignores empty lines in your data set, and instead skips to the nearest row
containing data.

If Smart Matching is not effective for your application, or if the field and column names do not
match, you can manually map the fields.

For task information, see "How to Inject Data into your Application” on next page.
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How to Inject Data into your Application

This task describes how to automatically enter pre-defined data into a form in your application.
Entering data automatically can make the data entry process faster and less error-prone.

2 Data Injection can be used only in tests run in Power Mode.

This task includes the following steps:

Prerequisites

o Determine whether you need to do manual mapping

e Begintherun

e Open the Manage & Map Fields dialog box

o Map the fields - Automatic Mapping

o Map the fields - Manual Mapping

o Define which fields you want to inject, and in what order - Optional
o Inject the data into your application during your run

1. Prerequisites

= Touse data injection, you must add data sets for your application. For details, see the step
on configuring data injection in "How to Prepare a Test to Run in Power Mode" on page 210.

= To use data injection, you can only have one instance of your application open.

2. Determine whether you need to do automatic or manual mapping
When performing data injection, you can do automatic or manual mapping. In automatic
mapping, Sprinter attempts to map the headers in your data set to fields in your application. If
the column and field names are identical, you can use automatic mapping.

If, however, the field names are different or duplicated, you cannot rely on automatic mapping.
In these cases, use manual mapping to select the fields in which to inject data.

3. Begin the testrun

a. Begin the run and make sure your application opens.
b. Expand the Data Injection sidebar.

c. If you have more than one data set, select the data set you want to use from the drop-down
list. For details, see "Data Injection Sidebar" on page 240.

4. Open the Manage & Map Fields dialog box

%
On the Data Injection sidebar, click the Manage Fields button = . The Manage & Map
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Fields dialog box opens.

5. Map the fields - Automatic Mapping
In the Manage & Map Fields dialog box, click the Map Automatically button. Sprinter scans

the application for matching fields and maps them to the columns of the data set.

6. Map the fields - Manual Mapping
If you determined that you need to use manual mapping, or if the automatic mapping did not

succeed, continue with the following steps:

a.

b.

In the Manage & Map Fields dialog box, select the data set row you want to map.
In the Manage & Map Fields dialog box, click the Map Manually button.

At this stage, your mouse pointer becomes a pointing hand. You use the pointing hand to
select an object in your application.

Tip. To enable your mouse during the selection mode, for example to scroll or view a right-
click menu in your application, hold down the left Ctrl button on the keyboard. You can then
change the window focus or perform operations in Sprinter or your application.

In your application, click the field you want to map with the selected data set row.

Repeat the above step for each field that you want to map and then click OK to close the
dialog box.

7. Define which fields you want to inject, and in what order - Optional
If you want to use all the fields in your data set, in the order by which they appear, you can skip

this step.

To define which fields to fill in your application and the order by which they should be entered,

el
click the Manage Fields button =" in the "Data Injection Sidebar" on page 240. Clear the
check box adjacent to the fields that you do not want to inject. Use the Move Up and Move

Down buttons to set the order.

For details, see "Manage (& Map) Fields Dialog Box" on page 237.

8. Inject the data into your application during your run

a.

b.

In the Data Injection sidebar select the data set you want to use from the list of data sets.
Click the Display Field Mapping button to verify the field mapping between your data set
and the fields in your application == . Click it again to hide the highlighting.

Select the row of data you want to inject and click the Inject Data button e

The Data Injection sidebar displays anicon in its tab indicating the success or failure of
the injection. If you did not previously map any of the fields, Sprinter offers to perform
automatic mapping. If the data injection fails, a popup box opens with additional details.

Page 232

HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 8: Data Injection

For more details, see "Data Injection Sidebar" on page 240.
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Data Injection Pane (Power Mode Group)

This tab enables you to define which data sets will to be available to use with the Data Injection

feature during a test run.

You can also delete data sets, define which fields from your data set will be injected, and in which

order.
Tasks you can accomplish with the Data Injection pane:
e "How to Prepare a Test to Run in Power Mode" on page 210

The following image shows the Data Injection pane when there are no defined data sets.

Data Injection ?

B . B BH X

Add Dsta Set Set Properfies Manage Fields Delete

This area enables you to define the data sets that will be available for use with Data Injection
during your test.

Click Add Local Data Set
to add a data set from local disk that will be available for use with Data Injection.

Click Add from HP ALM
to add a data set from HP ALM that will be available for use with Data Injection

The following image shows the Data Injection pane with defined data sets.

Data Injection ]
B . B B X

Add Dats Sat Set Properties Manage Fields Delete

Mame Location

Sample DI Ci\Users\Deskiop\Dl_csv

Tours C\Users\Desktop\Tours.csv

Accounts ChUsers\Desktop\Accounts.csv

To access Select Power Mode group > Data Injection node.
Important o Datasets can be .xls, .xlIsx, or.csv files.
information

o For details on how Sprinter maintains the list of data sets, see "How User
Information is Maintained" on page 44.

See also "Data Injection Overview" on page 228
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User interface elements are described below:

ul
Elements Description

B .

Add Data Set

Drop-down options:

e Add Local Data Set. Opens the "Data Set Details Dialog Box" (described on
page 236), enabling you to define a new data set for your application from your file
system.

¢ Add from HP Application Lifecycle Management. Opens the "Data Set Details
Dialog Box" (described on page 236), enabling you to define a new data set for
your application from your Application Lifecycle ManagementResources folder.

B

Set Properties

Opens the "Data Set Details Dialog Box" (described on page 236), enabling you set
the name and location of the data set.

Manage Fields

Opens the "Manage (& Map) Fields Dialog Box" (described on page 237), enabling
you to define which fields from your data will be injected, and in which order.

Do

Delete

Removes the selected data set from your application.
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Data Set Details Dialog Box

12 Relevant for Power Mode only

This dialog box enables you to define a data set for your application, to be used with the Data
Injection feature during a test run.

Tasks you can accomplish with the Data Details dialog box:
¢ "How to Prepare a Test to Run in Power Mode" on page 210

The following image shows the Data Details dialog box.

Data Set Details [=%™
Location: | |
Enter the path and file name of the data
MName:
To access Do one of the following:

o Select Power Mode group > Data Injection node > Add button.

e Select Power Mode group > Data Injection node. Select from the list of
defined data sets and click the Edit button.

Important e Data sets can be .xls, .xlIsx, or.csv files.

information
o Data sets cannot be edited from within Sprinter.

See also "Data Injection Overview" on page 228
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Manage (& Map) Fields Dialog Box

12 Relevant for Power Mode only

This dialog box enables you to manage the data set fields.

When you access this dialog box from the Power Mode pane, you can indicate which fields to inject
from your data set, and in which order.

When you access this dialog box from the Power Mode pane, you can also manage the mappings
between your application and the data set columns.

Tasks you can accomplish with the Manage (& Map) Fields dialog box:
e "How to Prepare a Test to Run in Power Mode" on page 210
o "How to Inject Data into your Application" on page 231

The following image shows the Manage Fields dialog box accessed from the Power Mode pane
before the test run.

Manage Fields 7 =7
fr
Mowve Up Mowve Down
Enabled Name Mapping
Middle:
Number:
Meal:

-

—— ——

The following image shows the Manage & Map Fields dialog box accessed from the Data Injection

sidebar during the test run.

Wanage & Map Fields s
0= = OB
™ v ] it =l } b4

Move Up Move Down | Show Mspping Map Automatically Map Manuslly Remave All Mappings

Enabled Name Mapping
Middle: cc_mid_name b4
Number creditnumber b4
Meal: pass.0.meal ®

| Ok Cancel |
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To access | Do one of the following:

¢ Inthe Power Mode group, select the Data Injection node > Manage Fields
button.

[
e During arun in the Data Injection sidebar, click the Manage Fields button = .

See also o "Data Injection Overview" on page 228

o "Data Injection Sidebar" on page 240

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

R Moves the selected field up one level in the order of injected fields.
Move Up
g Moves the selected field down one level in the order of injected fields.
Mowve Down
' |||:| Highlights and labels the fields in the application that match the column headings
ShowMapping in the data set. The column headings in the data set are displayed in the

highlighted fields in the application. Click again to turn off the highlighting.

Passengers
First Name: Last Name: Meal:
|Mea|:
Credit Card
Card Type: Number: Expiration:
American Express - |Number: | MNone = MNone -
First Name: Middle: Last:

o

0 Scans the application for matching fields and maps them to the columns of the
Mep Autometically data set (only available when dialog box is opened from sidebar).

;I Enables a pointer allowing you to manually choose the field to map to the
Mo Manuslty selected data set column (only available when dialog box is opened from
sidebar).
p 4 Deletes all of the listed mappings (only available when dialog box is opened from
Remowve All Mappings Sidebar).
Enabled Enables or disables data injection for the field.

column
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Ul Elements Description

Name The name of the field as it appears in the column header of the data set.
column

Mapping The field to which the data is mapped.

column
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Data Injection Sidebar

12 Relevant for Power Mode only

This sidebar enables you to automatically enter data into forms in desktop applications or Web

pages.

Tasks you can accomplish with the Data Injection sidebar:

o "How to Inject Data into your Application" on page 231

e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Data Injection sidebar.

Data Injection ¥ [

7@
Sample DI - 'ZH & ?g; L=,
Middle: | Number:
John 45345638
Kathy 12346543
Tom 89765432 Low Calorie

To access Do the following:

1. Enter Run mode and open a test or component.

2. Turn on Power mode.

3. Inthe Power Mode group, click the Data Injection node.

4. Inthe Data Injection pane, add at least one data set.

5. Click the Power Mode Run 2% button.

reposition the sidebar, click and drag on the sidebar header.

Important If your application does not have any associated data sets, the Data Injection
information | sigebar is not displayed.

See also "Data Injection Overview" on page 228
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

<Data set list>

A drop-down list of the data sets associated with your application.

<Data set columns>

The column names in your data set. To exclude a specific column from
data injection, clear its check box.

5 | Inject Data. Injects the data from the selected row of the data table
into the fields in your application.
Display Field Mapping. Highlights and labels the fields in the
application that match the column headings in the data set. The
column headings in the data set are displayed in the highlighted fields
in the application. Click again to turn off the highlighting.
Passengers
First Name: Last Name: Meal:
|Mea|:
Credit Card
Card Type: Number: Expiration:
American Express - |Number: | MNone = MNone -
First Name: Middle: Last:
5:& Refresh Data. Reloads the data from the data set source into the Data

Injection sidebar.

Manage Fields. Opens the "Manage (& Map) Fields Dialog Box" on
page 237, enabling you to define which fields will be injected, the fields
to which they should be mapped, and the mapping order. For details,
see "Manage (& Map) Fields Dialog Box" on page 237.

<Data injection
status>

The Data Injection sidebar displays an icon in its tab indicating the
success @ , partial success ' , or failure @ of data that was most
recently injected. For details, click the icon to open the Data Injection
Status window.

<Mapping status>

A status message in the lower section of the sidebar, indicating that
some or all headers of the data set were not mapped.
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Troubleshooting and Limitations - Data
Injection

This section describes troubleshooting and limitations for data injection.

o Datainjection may not work with all technologies.

o Datainjection files do not support Unicode.

o If data injection cannot identify the matching field in the application, the data will not be injected.

o When loading data from a CSV file in a non-English operating system in which the separator is
not a comma, all data appears in a single column. For example, in German Windows 7, the
default separator, a semicolon, is ignored.

Workaround: Change the default separator in your locale to a comma. Select Control Panel >
Regional and Language > Additional Settings. Change the List separator value to a comma.

« Inthe grid within the Data Injection sidebar, the following characters are not displayed if they
appear in the column headers ofadataset: [ 1 { } / \ , ( ). This affects the display
only—data injection will still identify the matching field.

+ When working with data injection files, in HTML pages where the labels are simple text nodes
and not Web elements, the data injection mechanism will not be able to identify the label text.
Workaround: Use : TOName:<Editbox_name>

o When manually mapping fields in a SapGuiArea, you cannot highlight individual objects.
Workaround: Click the desired object with left mouse button. Sprinter will map this object
correctly.
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Macros

Throughout this guide, descriptions of features that are available only in Power Mode are
identified by the Power Mode"9 icon.

This chapter includes:

Concepts

o "Macros Overview" on next page

Tasks

e "How to Record and Run Macros" on page 245

Reference

"Macros Pane (Power Mode Group)" on page 247

"Macros Sidebar" on page 248

"Macro Details Dialog Box" on page 250
o "Manage Macros Dialog Box" on page 252

"Troubleshooting and Limitations - Macros" on page 253
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Macros Overview

During the testing process, you may have parts of your test that require performing a series of user
actions that you want Sprinter to perform for you. You may also have parts of your test that involve
performing the same set of actions in multiple areas of your application. Having Sprinter perform the
set of actions can save testing time and reduce errors.

A macro is a series of actions that you can save and run as a single command.
Sprinter can perform these actions for you when you create and run macros.
For example, you may want to use macros to:

o Automate a login procedure.

o Perform a series of introductory steps to set up your application for testing.

Sprinter only saves a macro if it contains at least one user action. Your user actions are only
recorded after they are completed. For edit boxes and combo boxes, the action is not complete, and
will not be recorded until you move the focus off the box.
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How to Record and Run Macros

This task describes how to use macros to have Sprinter perform a series of user actions in your test
and run them as a single command.

2 Macros can be used only in tests run in Power Mode.

This task includes the following steps:
o Activate Power Mode
¢ Record amacro

¢ Runamacro
1. Activate Power Mode

P~ In Run mode, make sure you have a test open and that Power Mode is active. Click the
Power Mode Run button. For details, see the relevant steps in "How to Prepare a Test to Run

in Power Mode" on page 210.

2. Record a macro

If your application already has a macro associated with it that you want to run, you can skip
this step.

a. Inthe Macros sidebar click the Record button '@

b. Perform the actions you want to include in your macro.

c. Inthe Macros sidebar, click the Stop button . The Macro Details Dialog Box opens.
d. Set the definitions for your macro and save it. For details, see "Macro Details Dialog Box"
on page 250.

For more details about the sidebar, see "Macros Sidebar" on page 248.

3. Run a macro
a. Close the instance of the application upon which the macro was recorded. Allow Power

mode to reopen the application.

b. Inthe Macros sidebar select the macro you want to run from the macros drop-down list.

c. Inthe Macros sidebar click the Run button %* .

d. The Macros sidebar displays anicon in its tab indicating the progress and success or
failure of the macro. Click the icon for more details.
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For more details about the sidebar, see "Macros Sidebar" on page 248.

For more details on using macros in your test, see "Macros Overview" on page 244.
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Macros Pane (Power Mode Group)

This pane displays the macros that are associated with the currently defined application.
Tasks you can accomplish with the Macros pane:
o "How to Prepare a Test to Run in Power Mode" on page 210

The following image shows the Macros pane.

Macras ?

X &
Delete Edit

Mame Description

lagin Enter the login and password credentials in the Mercury Tours travel agency web application.

Payment Enter all the payment information in the Book & Flight page.
To access Select Power Mode group > Macros node.
Important information You can edit only the macro Name and Description.
See also "Macros Overview" on page 244

Descriptions of the user interface elements are available in the pane when you hover over them.
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Macros Sidebar

Relevant for Power Mode only

This sidebar enables you to record and run macros during your test run.
Tasks you can accomplish with the Macros sidebar:

o "How to Record and Run Macros" on page 245

e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Macros sidebar.

- an i S
Tours signin | = ({We>

re |

Macros A

To access | During atest run, click the Macros sidebar tab.

o Click the sidebar tab again, or click off the sidebar tab, to close the sidebar.

o Toreposition the sidebar, click and drag on the sidebar header.

See also "Macros Overview" on page 244

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

Record/Stop. Starts and stops recording user actions you perform in your

L

o
A application. When you stop recording, the Macro Details Dialog Box opens, enabling
= you to name and save your macro. For details, see "Macro Details Dialog Box" on
page 250.
(,,\[»_) Run. Runs the selected macro from the macros drop-down list.

Manage. Opens the Manage Macros Dialog Box. For details, see the "Manage
Macros Dialog Box" on page 252.

<Macros | The list of macros you can run in this test. Sprinter associates macros with the

drop- application for which they were created.
down

list>
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Ul

Elements Description

<Macros | The Macros sidebar displays anicon inits tab indicating the progress of the macro
status> | 5nd the success or failure of a macro that was run. Click the icon for more details.
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Macro Details Dialog Box

Relevant for Power Mode only

This dialog box enables you to name your macro and view and edit its details.
Tasks you can accomplish with the Macro Details dialog box:

¢ "How to Record and Run Macros" on page 245

e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Macro Details dialog box.

Macro Details 7%

MName: I login] I

Associated Application: Tours

Description: | Enter the login and password credentials in the Mercury
Tours travel agency web application.

Enter a description of the macro.

Actions: | Enter " Travel1" in the "useriame” edit field.
Enter the encrypted password in the "password” edit field.
Click the "Sign-In" image.

To Do one of the following:
access

¢ Afterrecording a new macro click the Macros sidebar > Stop button .

o Inthe Macros sidebar click the Manage Macros button *-1 . Select a macro in the
Macros pane and click the Edit button.

¢ Inthe "Power Mode Group" on page 212 in the main window select the Macros
node. Select a macro in the Macros pane and click the Edit button.

See "Macros Overview" on page 244
also
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Descriptions of the user interface elements are available in the dialog box when you hover over
them. The table below provides additional information for some of these elements:

Ul Elements Description

Associated The application for which this macro is available.

application
The associated application is the application that was defined for the test in

which the macro was recorded.

Steps A list of the steps that were recorded in the macro. Each user action in the
application is recorded as a step in the macro.
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Manage Macros Dialog Box

Relevant for Power Mode only

This dialog box enables you to delete and modify the details of your macros.

The following image shows the Manage Macros dialog box.
=7

Manage Macros
X ©
Delets Edit
- .
Name Descnption

Tours sign in

To access : .
Click the Macros sidebar > Manage Macros button =4 .

See also "Macros Overview" on page 244

Descriptions of the user interface elements are available in the dialog box when you hover over
them. The table below provides additional information for some of these elements:

ul
Elements Description

Macros | The list of macros that are associated with your application.

List
o To edit a macro, select it from this list and click the Edit button. The "Macro

Details Dialog Box" on page 250 opens enabling you to edit the macro.

e Todelete a macro, select it from this list and click the Delete button.
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Troubleshooting and Limitations - Macros

This section describes troubleshooting and limitations for macros.
o Macros may not work with all technologies.

o Useractions on an edit box are recorded only after you move the focus off the edit box.
For example, if you click the Record button, enter text in an edit box, and then click the Stop
button, your action is not recorded in your macro. You need to perform an action on another
object in your application for your action on the text box to be recorded.
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Scanners

Throughout this guide, descriptions of features that are available only in Power Mode are
identified by the Power Mode 2 icon.

This chapter includes:

Concepts

e "Scanners Overview" on next page

Tasks

¢ "How to Scan Your Application For Potential Defects" on page 257

e "How to Add or Remove Words From a Dictionary" on page 259

¢ "How to Create a Custom Scanner" on page 261

Reference

e "Scanners Pane (Power Mode Group)/ Scanner Settings Dialog Box" on page 262

e "Scanners Sidebar" on page 266

e "Scan Progress Window" on page 268

e "Scan Results Viewer" on page 270

o " Sprinter Scanner AP|" on page 272

"Troubleshooting and Limitations - Scanners" on page 273
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Scanners Overview

12 Relevant for Power Mode only

During the testing process, you may want to check that different aspects of your application behave
or display correctly. Sprinter's scanners enable you to check whether strings in your application are
spelled correctly, whether the application conforms to Web Standards (Web applications only), if
there are broken links, or whether the user interface of your application is translated correctly.

You can select which scanners to use both prior to the run session and during the run session. After
each scan is completed, the scan results are displayed in the Scan Results Viewer. In the Scan
Results Viewer you can perform several actions, such as creating smart defects and defect
reminders.

For task details, see "How to Scan Your Application For Potential Defects" on page 257.

For user interface details, see "Scanners Pane (Power Mode Group) / Scanner Settings Dialog
Box" on page 262.

Sprinter includes the following scanners:

Broken Links Scanner

This scanner, relevant only for Web applications, checks your application for broken hyperlinks and
missing referenced content. You can set the threshold time—the time in seconds after which the
link will be considered broken.

Localization Scanner

This scanner checks your application for errors resulting from translating the application's user
interface into different languages. You can scan for the following issues:

« Incomplete strings. Suppose that after translating the user interface strings in your application,
the main title of the page is too long to be displayed within the title bar. When this option is
selected, the Localization scanner identifies the string as incomplete. Make sure to set the
target language, as the scanner performs a check against this language during the scan.

« Untranslated strings. Suppose that after translating the user interface strings of your
application you want to verify that all of the strings were translated from the source language to
the target language. When this option is selected, the Localization scanner compares any string
that is not spelled correctly with both the target dictionary and the source dictionary. If the string
is found in the source dictionary, the scanner identifies the string as untranslated.

Spelicheck Scanner

This scanner checks your application for spelling errors. You can define up to two dictionaries for
the scanner to use. This enable you to check spelling for applications that contain strings in more
than one language.
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Web Standards Scanner

This scanner checks that the Web page complies with Web standards for HTML validity, as defined
by the World Wide Web Consortium (W3C). The scanner detects and reports any Web standards
errors that are found in the Web page during the run session.

The Web Standards scanner is available only if you select a Web application in the "Application
Pane (Power Mode Group)" ( described on page 214).

Custom Scanner

Sprinter allows you to extend the scanner's capabilities by defining custom scanners. This allows
you to design a scanner that will detect the desired items in your application.

You can use a sample scanner provided with Sprinter as a starting point for designing your own
custom scanner.

For details, see "How to Create a Custom Scanner" on page 261.
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How to Scan Your Application For Potential
Defects

This task describes how to configure, run, and analyze scans for your application during a run
session.

2 Scanners can be used only in tests run in Power Mode.

This task includes the following steps:

Prerequisites

Configure scanner settings

e Scan your application during a run session

¢ Analyze scan results

Prerequisites
To use scanners, you must first enable Power Mode and configure an application for your test. For
details, see the relevant steps in "How to Prepare a Test to Run in Power Mode" on page 210.

Configure scanner settings

« Before the run session begins. Use the Scanners pane (Power Mode group) to tum on the
relevant scanners. For details, see "Scanners Pane (Power Mode Group) / Scanner Settings
Dialog Box" on page 262.

o During the run session. In the Scanners sidebar, click the Scanner Settings button :-. . The
Scanner Settings dialog opens. This dialog box contains all of the available settings that the

Scanners pane (Power Mode group) contains. For details, see "Scanners Sidebar" on page 266
and "Scanners Pane (Power Mode Group) / Scanner Settings Dialog Box" on page 262.

Scan your application during a run session

In the Scanners sidebar, click the Start Scan button @ . The progress window opens, displaying
the status of each scanner. For details, see "Scanners Sidebar" on page 266 and "Scan Progress
Window" on page 268.

Analyze scan results

After the scan ends, click Continue in the Scan Progress window, to open the Scan Results
Viewer. Handle the results for each scanner by creating a defect or a defect reminder, or performing
a custom action. For example, for Spellcheck scan results, add the word to a dictionary. For details,
see "Scan Results Viewer" on page 270.
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Tip: If you closed the Scan Results Viewer, click the Last Scan Results button @] inthe
Scanners sidebar to display the results of the last scan.
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How to Add or Remove Words From a
Dictionary

This section explains how to modify a dictionary for the Spellcheck scanner. For details, see
"Scanners Overview" on page 255.

In normal use, if your scanner detects a spelling error, you can choose to add the word to the
scanner directly from the Scan Results user interface using the Add to button. For details, see
"Scan Results Viewer" on page 270.

When modifying a dictionary, you need to modify it on ALM and on the local copy stored on the file
system.

This section describes how to manually add entries to the dictionary, and how to remove exiting
entries.

The dictionaries used are based on the OpenOffice Hunspell dictionaries. For details, see

http://wiki.services.openoffice.org/wiki/Dictionaries
This task includes the following steps:
o Download the dictionary file from ALM

o Edit thefile

Upload the dictionary file to ALM

Modify the local copy

1. Download the dictionary file from ALM

a. Loginto Application Lifecycle Management with administrator privileges.
b. Open the Test Resources module.

c. Select Resources > Sprinter > <your_user_name>/SpellChecker.
d. Click the Resource Viewer tab.

e. Click Download to download the dictionary file in XML format and save it on the file
system.

2. Edit the file
a. Open the saved file in a text or XML editor.

b. Locate the Elements list for your language.

<Key>English</Key>
<Value objectID="5"
type="System.Collections.Generic.List 1[[System.String,
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d.

e.

mscorlib, Version=4.0.0.0, Culture=neutral,
PublicKeyToken=b77a5c561934e089]], mscorlib">
<Elements isCollection="True">
<String>Sprinter</String>
<String>Facebook</String>
<String>NewWord</String>
</Elements>
</Value>

To add a word, add an entry for each word in the following format: <String>New
Word</String>.

To remove a word, delete the entire line with the word.

Save thefile.

3. Upload the dictionary file to ALM

In Application Lifecycle Management's Test Resources module, in the Resource View tab,
click Upload File to upload the file to Application Lifecycle Management.

4. Modify the local copy

In the file system, open %appdata%\HP\Sprinter\SpellChecker.xml in a text editor and add
or remove the same word from the XML file.
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How to Create a Custom Scanner
This task describes how to create a custom scanner for your application.

12 Scanners can be used only in tests run in Power Mode.

This task includes the following steps:

o Open the sample scanner

Implement the interface

Save the custom scanner

o Configure scanner settings

1. Open the sample scanner
Select Start > All Programs > HP Sprinter > Extensibility > Broken Links Scanner
Code Sample to open the sample in Visual Studio 2010. Alternatively, open the sample
scanner project located in <Installation_Directory>\Sample\Scanners\BrokenLinks\
HP.Sprinter.DemoScanners.BrokenLinks.csproj.

2. Implement the interface

Make sure to implement the IScanner interface located in the <Installation_
Directory>\bin\HP.Sprinter.Scanners.API.dII.

If you are using additional external dependencies, note that the custom scanner's working
folder during run time is <Installation_Directory>\bin

3. Save the custom scanner

Save custom scanner assemblies in the <Installation_Directory>\bin\CustomScanners
folder in order to allow it to load when you invoke Sprinter.

4. Configure scanner settings

Restart Sprinter and activate Power Mode. Activate and define the custom scanner settings as
necessary.

For complete information about the Scanners API provided with Sprinter, click here or select
Programs > HP Sprinter > Extensibility > Sprinter Scanners API Reference to open the
online reference or click on the link in the Welcome to HP Sprinter Help page, accessible
from any Help screen.
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Scanners Pane (Power Mode Group) / Scanner

Settings Dialog Box

The Scanners pane and the Scanner Settings dialog box enable you to select which scanners to
use during a run session. You can also configure settings for each scanner.

Tasks you can accomplish with the Scanners pane:

e "How to Scan Your Application For Potential Defects" on page 257

The following image shows the Broken Links scanner.

@f“ Broken Links

Scans the application for broken hyperinks and referenced content.

Connectivity Check Timeout 6 .1 seconds

The following image shows the Localization scanner.

@ Localization

face into different languages.

Source language: |English
The language from which the application is translated.
Target language: |English

Incomplete strings

Untranslated strings

Scans the text in the application for errors resulting from franslating the user inter-

The following image shows the Spellcheck scanner.

AQE,} Spelicheck

Scans the application for spelling amors.

Primary language: |English | - |

Secondary language: |Italian | - |

Page 262

HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide

Chapter 10: Scanners

The following image shows the Web Standards scanner.

-
@ \Web Standards

m
i
T

Checks whether the \Web page complies with Web standards as defined by the World Wide Web
Cansortium (W3C).

X
Mame
To access e Scanners pane. In the Power Mode group, select Scanners.
e Scanner Settings dialog box. During a run session, click the Scanners
sidebar tab and click the Scanner Settings button.
Important e The options in the Scanners pane and the Scanner Settings dialog box are
information

identical.

The Broken Links and Web Standards scanners are only available if you select
a Web application in the "Application Pane (Power Mode Group)" (described on
page 214).

You must be connected to the Internet before performing a Web Standards
scan.

For the Localization scanner: Set the Target language to match the currently
visible user interface. Set the Source language to the original user interface
language. If you select other languages, the scanner may provide false results.

User interface elements for all scanners are described below:

Broken Links Scanner

Ul Elements Description
Connectivity Check The threshold in seconds after which a link will be considered
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Localization Scanner

Ul Elements Description

Source The language from which the application is translated.

Language

Target The language to which the application is translated.

Language

Incomplete Scans for strings that do not fit within a specific area in the application.
strings

Untranslated Scans for string that are not translated from the source language to the target
string language.

Spellcheck Scanner

Ul
Elements

Description

Main The main language in which the user interface strings of the application are
language | gisplayed. This determines which dictionary to use when scanning the application
for spelling errors.
Default: English
Additional | (Optional) An Additional language or locale used in the application.
language

To add words to the main and additional dictionaries use the Scan Results Viewer. For details see

"Scan Results Viewer" on page 270.

For details about custom dictionaries, see "How to Add or Remove Words From a Dictionary" on

page 259

Web Standards Scanner

ul
Elements Description
Analysis | The type of analysis to perform on the Web page:
type
o Dynamic HTML. Scan the document's dynamic HTML content.
o Static HTML. Scan the document's static HTML content.
Excluded | The list of rules that instruct the Web Standards scanner to ignore specific result
Category | categories. You can delete rules from this list, but you can add rules only from the
Rules "Scan Results Viewer" on page 270.
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ul
Elements Description
Delete Deletes the selected results category rule from the list.
Rule
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Scanners Sidebar

12 Relevant for Power Mode only

This sidebar enables you to scan your application, configure scanner settings, and view scan
results.

Tasks you can accomplish with the Scanners sidebar:
e "How to Scan Your Application For Potential Defects" on page 257
e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Scanners sidebar.
e

® |G
1 Scanners A r

an

To access | Do the following:

1. Enter Run mode and open a test or component.

2. Turn on Power mode.

3. Inthe Power Mode group, click the Scanners node.

4. Inthe Scanners pane, turn on at least one scanner.

5. Click the Power Mode Run P~ button.

reposition the sidebar, click and drag on the sidebar header.

Important If you do not turn on any scanners prior to the run session, the Scanners sidebar

information | js not displayed. To display the sidebar, stop the run and turn on at least one
scanner.
See also "Scanners Overview" on page 255

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul

Elements Description

@ Start Scan. Instructs all enabled scanners to scan the currently active
screen/page/area of the application. You can monitor the scan progress in the "Scan
Progress Window" (described on page 268).

Page 266 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 10: Scanners

ul
Elements Description

@ Last Scan Results. Opens the Scan Results Viewer, which enables you to view the
results from the last performed scan. If no scan was performed during the run

session, this option is disabled. For details, see "Scan Results Viewer" on page 270.

Note: The Scan Results Viewer displays results only for the last performed scan.

Scanner Settings. Opens the Scanner Settings dialog box, which enables you to
turn individual scanners on or off. It also enables you to define settings for each
scanner. The options in this dialog box are identical to the options in the Scanners

ol

pane. For details, see "Scanners Pane (Power Mode Group) / Scanner Settings
Dialog Box" on page 262.

Page 267 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 10: Scanners

Scan Progress Window

This window enables you to monitor the status of each selected scanner during the scan. It also
displays the number of potential defects found by each scanner.

Tasks you can accomplish with the Scan Progress window:
e "How to Scan Your Application For Potential Defects" on page 257
e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Scan Progress window.

- ?
Scanning. ..

Potential defects found: 68

Scanner Potentizl Defects Status
Broken Links In Progress
Finighed

Finighed

o o =
-

Spellcheck
Web Standards

~ | Details | Cancel |

To access | pring a run session, click the Start Scan button @ on the "Scanners Sidebar"

tab ( described on page 266).

Important o By default, only summary information is displayed. You can expand the
information window to view detailed information about each scanner.

o Ifall scans run successfully and results are found, this window closes after the
scan is completed, and the Scan Results Viewer opens. For details, see "Scan
Results Viewer" on page 270.

o If one or more scans fail, the failure reason is displayed in a tooltip when you
hover over the scanner name.

See also e "Scanners Sidebar" on page 266

e "Scanners Overview" on page 255

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element Description

<Scan status> The overall progress of the scan.

Potential defects The total number of scan results, which may indicate defects in the
found application.
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Ul Element Description

<Scan status The scanner name, potential defects, and status for each scanner that you
details> selected to use.
Details Shows or hides the scan status details.

Page 269 HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 10: Scanners

Scan Results Viewer

This viewer displays the results of the last scan that you performed during the run session.

The Scan Results Viewer also enables you to address the results by submitting defects to

Application Lifecycle Management based on the results. You can also create defect reminders to be

submitted after the run session ends.

The following image shows the Scan Results Viewer.

Scan Results Viewer

E Lo

Submit Defect Defect Reminder

7=

Scan Results

Summary Action
[> g Broken Links (1)
A Spelicheck

b (gWeb Standards (57)

Broken Link: hitp://newtours.demoaut.com/images/spacer.gif
NotFound (404)
hitp:/inewtours demoaut com/images/spacer.gif

To access Do the following:
1. During arun session, click the "Scanners Sidebar" tab ( described on
page 255).
2. Click the Start Scan button.
3. After the scan, click Continue in the Scan Progress dialog box.
Important e The Scan Results Viewer displays results only from the last scan that
information you performed.
¢ The Scan Results Viewer is available only during the run session.
See also e "Scanners Sidebar" on page 266
e "Scan Progress Window" on page 268
e "Scanners Overview" on page 255
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User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element Description

| Opens the "Smart Defect Settings Dialog Box" (described on page 177),

Submé Detedt enabling you to automatically include defect scenario information in your defect.
The defect summary includes a description of the selected results.

i Opens the "Defect Reminder Dialog Box" (described on page 181), enabling you
Defert Feminder to add a reminder to open a defect for the selected results at a later time.
Add to Adds the selected results to the target dictionary.
Target

Dictionary Available only when Localization results are selected.

Note: To remove words that you added to the dictionary, follow the steps in
"How to Add or Remove Words From a Dictionary" on page 259.

Add to Adds the selected results to the primary dictionary.
Dictionary
(<language>) | Available only when Spellcheck results are selected.

Note: To remove words that you added to the dictionary, follow the steps in
"How to Add or Remove Words From a Dictionary" on page 259.

Exclude Creates a rule that excludes the selected results category from future scans.
Category
Available only when Web Standards results are selected.
Scan The list of results for each scanner; Summary and Action.
Results

¢ Click the arrow adjacent to each scanner to expand its results.

o Select one or more results in the list to perform actions on them using the
right-click menu or toolbar buttons.

e To perform an action on all results for a specific scanner, select its parent
node and expand the right-click menu.

<Results The display of the results. The results are indicated in red boxes. This pane also
display> contains a slider control, which allows you to zoom in or out.
Note:

o Not available when Broken Links or Web Standards results are selected.

o If the results are located outside of the captured area of the application, they
are not shown in the display.

<Results A textual description of the selected results.
description>
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@ Sprinter Scanner API

The Sprinter Scanners AP| Reference allows you to create custom scanners using the built-in API.
To open the references guide, select Programs > HP Sprinter > Extensibility > Sprinter
Scanners API Reference or click on the link in the Welcome to HP Sprinter Help page,
accessible from any Help screen.
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Troubleshooting and Limitations - Scanners

This section describes troubleshooting and limitations for scanners.

General

Activating Sprinter scanners does not guarantee detecting all relevant results. In certain
environments, the Sprinter scanners might also detect false positive results.

A scan operation can fail for one of the following reasons:
The window of the AUT (application under test) was closed before the scan started.
The window of the AUT was minimized before the scan started.
The SprinterRTE process was terminated unexpectedly before the scan started.
A technical issue is preventing Sprinter from interacting with the AUT.

The AUT's add-in definitions are missing or not valid.

Defects

Issues listed in scanner results for which you created defects, will continue to be listed in

subsequent scan results.

L10N

The following applies to Localization scanner:

Scroll Bars: The scanner may display certain controls containing scroll bars (horizontal and\or
vertical) as a string cut. As a result, it may report a false positive.

Left Side Cut: The scanner cannot detect string cuts on the left side of the text. This is mostly
relevant in right-to-left languages.

Vertical Cut: If the control's text is not fully visible in the vertical axis, and does not contain scroll
bars, the scanner will be unable to analyze the text in the hidden area. As a result, it may report a
false positive.

Language Support: East Asian Languages and non-default languages are not supported.

Multiple Child Controls: The scanner cannot detect string cuts on very small controls (less than
three characters in length) such as lists and tree view.
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Mirroring Tests

This chapter includes:

Concepts

"Testing on Multiple Machines - Overview" on next page

o "How Sprinter Replicates Your User Actions" on page 277

o "Comparing Machines" on page 278

¢ "Resolving Problems on and Unlocking Secondary Machines" on page 279
o "Rules Overview" on page 281

Tasks

e "How to Prepare a Test for Mirroring" on page 284

¢ "How to Run a Test with Mirroring" on page 286

« "How to Resolve Differences During a Run" on page 289

« "How to Handle Replication Errors During a Run" on page 292

Reference

o "Mirroring Pane (Power Mode Group)" on page 294

o "New Machine/Machine Details Dialog Box" on page 296
o "Mirroring Rules Pane (Power Mode Group)" on page 304
o "Health Console" on page 305

¢ "Sprinter Agent" on page 308

e "Machines Sidebar" on page 309

¢ "Rule Wizard - Rule Details Page" on page 322

"Troubleshooting and Limitations - Mirroring" on page 330
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Testing on Multiple Machines - Overview

12 Relevant for Power Mode only
A common testing requirement is the need to test your application's compatibility with different

computer configurations, and in the case of Web applications, with different browsers.

Sprinter's Mirroring feature enables you to run your test simultaneously on multiple machines with
different configurations.

A test run with mirroring has a primary machine and secondary machines:
o Primary machine. The machine on which you manually perform all the user actions in your test.
« Secondary machine. The machine on which Sprinterreplicates your user actions.

To run a test with Mirroring, you configure each of the secondary machines with the specific
configuration you want to test. After you perform each user action on your primary machine,
Sprinter replicates that user action on your secondary machines.

When you configure your secondary machines, consider that Sprinter replicates your user actions
the same way they were performed on your primary machine. You need to configure your secondary
machines in such a way that there will not be a conflict between the actions that are performed on
all the machines.

Example:

Suppose your application works with a database. When you create or modify a record in your
primary machine, Sprinter will attempt to create or modify the same record when it replicates
your action in the secondary machines. Therefore, you cannot use the same database
schema in your primary and secondary machines.

To address this issue, you can configure each secondary machine in your run to work with its
own database, or with a dedicated database schema.

You can compare your primary machine with all the secondary machines in your run, to see if there
are differences in their displays. Sprinter provides a number of different options to resolve
differences it detects between the displays.

Sprinter associates the list of secondary machines available for mirroring with your user in your
Application Lifecycle Management project.

To work with mirroring, you need to have a certain number of available Application Lifecycle
Management licenses. The number of licenses you need depends on the number of secondary
machines you want to use in your test. You can work with a maximum of five secondary machines
inarun.
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The following table describes the total number of licenses required in a run with mirroring:

Secondary Machines Total Number of Licenses Required

1 1
2-3 2
4-5 3

This section also includes:
o "How Sprinter Replicates Your User Actions" on next page
e "Comparing Machines" on page 278

« "Resolving Problems on and Unlocking Secondary Machines" on page 279
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How Sprinter Replicates Your User Actions

12 Relevant for Power Mode only

Each time you perform a user action on your primary machine, Sprinter updates the action number
on the primary machine display in the Machines sidebar.

Sprinter then replicates that action on all the secondary machines in your run. As the action is
replicated, there is a visual indication on the Machines sidebar tab, as well as on the replication
icon for each secondary machine display. The replication icon for each secondary machine also
turns gray during the replication process.

If the action is replicated successfully, the replication status returns to green and the action number
for that machine is updated to reflect the performed action.

If Sprinter was unable to replicate your user action, the replication status turns red. Sprinter also
turns the secondary machine display red and locks the secondary machine.

When a secondary machine is locked, you can continue to perform actions on your primary
machine. These actions will be pending for any secondary machines that are locked. When you
perform these actions, the action number of the primary machine will advance, but those of any
locked secondary machines will remain at the action number that caused the failure.

Pending actions may or may not be replicated when you unlock the machine, depending on how you
resolve the differences between machines. For details, see "Resolving Problems on and Unlocking
Secondary Machines" on page 279.

During replication, Sprinter checks only those user interface elements that are needed to replicate
the action, to determine if it can replicate the action. All other objects in the user interface are not
compared between the primary and secondary machines.

To check for all differences between the displays of the primary and secondary machines, you
perform a Compare All operation from the Machines sidebar.

For details on comparing the displays of the primary and secondary machines, see "Comparing
Machines" on next page.
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Comparing Machines

12 Relevant for Power Mode only

When you compare machines, Sprinter compares the display of your primary machine with those of
all the secondary machines in your run.

When Sprinter begins comparing the machines, the display on your primary machine will display a
gray overlay, indicating that Sprinter is learning all the objects in your primary display. There is also
avisual indication on the Machines sidebar tab. During the learning process, Sprinter learns each
of the individual objects in the displays as well as their properties, and compares them. For
example, Sprinter can learn that your display contains a check box, as well as whether the
checkbox is enabled or disabled, even if there is no indication in the display as to its state.

After Sprinter learns the display of your primary machine, it compares it to the displays of the
secondary machines. While each secondary machine is being compared, the comparison status
tumns gray. If Sprinter did not detect any differences in the displays, the comparison icon retumns to
green

If Sprinter detects differences between the displays, the comparison status and the secondary
machine display both turn red and Sprinter locks the secondary machine.

When a secondary machine is locked, you can continue to perform actions on your primary
machine. These actions will be pending for any secondary machines that are locked. Pending
actions may or may not be replicated, depending on how you resolve the differences between
machines. For details, see "Resolving Problems on and Unlocking Secondary Machines" on next

page.
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Resolving Problems on and Unlocking
Secondary Machines

12 Relevant for Power Mode only
When a secondary machine is locked, you need to solve the problem and unlock the machine so
that Sprinter can continue replicating your user actions.

Sprinter provides the following operations to address problems on the secondary machine:

« Stop/Continue Replication. When you stop replication on a secondary machine, any actions
you perform on the primary machine are not kept as pending actions and will not be replicated on
the secondary machine.

This may be useful if you need to perform actions to resolve the difference that are not part of your
test on your primary machine, and that you do not want replicated. You can also use the Stop
Recording button in the Tools sidebar to stop recording all your user actions on your primary
machine.

« Differences Viewer. The "Differences Viewer" on page 315 enables you to view the details of
differences that were found during a Compare All operation. From the Differences Viewer you
can:

= Submit a defect about the problem.
= Ignore the difference.
= Create arule so that Sprinter ignores the difference now and in the future.

If you use the Differences Viewer to ignore all the differences or to create rules for all the
differences, the secondary machine is unlocked and Sprinter attempts to replicate any pending
actions.

« Open Remote Desktop. You can open a remote desktop connection from the Machines
sidebar or the Differences Viewer.

This may be useful if the problem with the secondary machine is due to a display issue that is not
related to the application you are testing. You can open a remote desktop connection and correct
the problem. You would then use one of the operations below to unlock the machine.

« Show Screen. Displays a current screen capture of the secondary machine.
Sprinter provides the following operations to unlock the machine after you address the problem:

o Skip. You can ignore the problem that Sprinter found with the secondary machine and continue
replicating pending user actions.
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e Sync. You can ignore the problem that Sprinter found with the secondary machine, delete all
pending actions, and synchronize the actions number with the primary machine.

¢ Retry. You can try to replicate the failed user action again.

This may be useful if you opened a remote desktop connection to address a display issue that is

not related to the application you are testing. After addressing the issue, you can try to replicate
the action again.

o Recompare. You can recompare the secondary machine with the primary machine.

After you resolve differences that were detected by a Compare All operation, you can

Recompare the machines to confirm that there are no differences, and to unlock the secondary
machine.

If you resolved the differences between machines using the Differences Viewer, the machines are
automatically recompared and unlocked when all the differences are resolved.
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Rules Overview

12 Relevant for Power Mode only

During a test run with mirroring, you may want to periodically compare the display of your primary
machine with those of your secondary machines. When you compare the displays, Sprinter detects
differences between the displays.

Once you resolve the difference between the displays, you may want Sprinter to ignore similar
differences in the future.

When you create a rule, you teach Sprinter to ignore certain types of differences during a compare
operation.

Rules are associated with a specific application, and are available for all tests that are configured to
use that application. You can also create rules that apply to all your Sprinter tests, regardless of
their configured application.

When you create a rule in the Differences Viewer, Sprinter automatically re-compares the
secondary machine with the primary machine, to determine if the difference is no longer detected.

This section also includes:

o "Built-in Rules" below

o "Pre-Defined Rules" below

e "Custom Rules" on next page

o "Rules for Nested Objects" on page 283

Built-in Rules

Sprinter provides you with a set of built-in rules that address the most common differences that can
occur between machines. These rules tell Sprinter to ignore differences up to a certain amount, in
the position, size, and location of objects in your display. By default, Sprinter will not detect
differences between displays, that meet these rules. Built-in rules apply to all your Sprinter tests,
regardless of their configured application.

For more details on these rules and how to enable, disable, and configure them, see "Mirroring
Settings Pane (Settings Dialog Box)" on page 61.

Pre-Defined Rules

When you view a difference in the Differences Viewer, you have the option to create a new rule to
resolve the difference. When you create a new rule, Sprinter gives you the option to select from a
set of pre-defined rules or to create a custom rule.
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A pre-defined rule teaches Sprinter to ignore the same type of difference in the future. For example,
if the difference is that an object is present in one display and missing in another, a pre-defined rule
would ignore the missing object in the future.

If the difference is that a property value of an object is different between machines, the pre-defined
rule would ignore that property value in the future.

For details on the specific options available when you select a pre-defined rule, see "New Rule
Dialog Box" on page 318.

If a pre-defined rule does not meet your needs, you can create a custom rule.

Custom Rules

You create a custom rule using the Rule Wizard. The rule wizard gives you control over the
following aspects of a rule:

o Type. The type determines whether the rule will ignore a specific object, a property of a specific
object, but not the entire object, or a property of all objects. When you define the rule type you do
not define which object or object property will be ignored, only what type of action the rule will
take.

o Scope. The scope determines when the rule will apply. You can choose to have the rule apply to
the currently configured application, or to all applications. Applying the rule to all applications
means that the rule will apply whenever you run a test in Sprinter with mirroring.

o Target. The target is the object to which the rule will apply. If your rule Type ignores a specific
object property, the object you select determines which properties are available to ignore.

o Action. The action determines the specific action the rule will take when it is applied. If your rule
Type ignores an object, the action will be to ignore the object. If, however, your rule Type
ignores a specific property, the action enables you to select the specific properties you want to
ignore. The properties you can ignore will be the properties associated with your Target object.

« Condition. The condition determines the specific conditions under which the rule will apply.
The condition does not have to depend on the property value you want to ignore.

For example: Suppose you create a rule to ignore the color of a button. But you know that the
color will only be different when the text in the button displays OK instead of Yes. You want to
ignore the color of the button, but when you want to ignore the color depends on the text in the
button.

You can create a rule to ignore the value of the Color property, and then set the condition for the
rule so that it applies only when the Text value is OK.
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It is not necessary to set a condition for a rule. If you do not set a specific condition for a rule, the
rule will apply whenever the property value you selected for the rule is different between
machines.

Rules for Nested Objects
When Sprinter detects differences between machines, it sometimes combines multiple differences
into one difference to simplify the displayed information.

Example:

Suppose Sprinter detects a difference between two machines, where one machine displays a
table and the other does not. In this case, Sprinter will list the missing table as a difference in
the "Differences Viewer" on page 315, but will not list each individual cell within the table as a
difference.

When you create a rule to resolve a difference, Sprinter recompares the two displays to apply the
new rule and remove the difference from the list of detected differences.

When Sprinter applies a rule to a difference that combined many differences and removes it, the
individual differences it combined are now detected separately.

Example:

In the above example, when you create a rule to ignore the difference of the missing table
between the two machines, Sprinter recompares the machines to apply the new rule and
removes the missing table from the list of differences. Once the missing table is no longer
detected, Sprinter detects all the individual cells within the table as differences between the

machines.

In this case, when you create a rule to resolve a difference, you may see new differences appear in
the Differences Viewer. You need to create a rule for each of these newly detected differences as
well. Sprinter may detect multiple differences for Web objects as well, such as browser, page, and
frame objects in the same window.
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How to Prepare a Test for Mirroring

12 Relevant for Power Mode only

This task describes how to prepare your test to run with mirroring.

Note: This task is part of a higher-level task. For details, see "How to Run a Manual Test in
Sprinter" on page 114.

This task includes the following steps:

o Prerequisites

Configure your comparison settings - Optional

Review the rules for your application

o Configure the secondary machines for your run

1. Prerequisites
a. Install Sprinter on the computers or virtual machines you want to use as secondary
machines.

Confirm that the Sprinter Agent icon s displayed in the task bar and that the computers
or machines are not locked. The Sprinter application does not need to be running on the

secondary machines.
b. Disable screen savers for the secondary machines in your run.
c. Ensure that your application is not running on the secondary machines.
d. Make sure that the secondary machines in your run are not locked.

e. If you open an external remote desktop connection to a secondary machine (not via
Sprinter), make sure it is not minimized.

f. Make sure that the firewall on all secondary machines is configured to allow the Sprinter
Agent process.

g. The Sprinter Agent must be run with administrator permissions on each secondary
machine. Therefore, if the user that started a secondary machine does not have
administrator permissions on that machine, mirroring will work only if you have an active
remote desktop connection to that machine.

h. You can work with a maximum of five secondary machines in a run with mirroring.
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Working with mirroring requires that you have the required number of Application Lifecycle
Management licenses. The number of licenses you need depends on the number of
secondary machines you want to use in your test.

For details on the number of licenses required, see "Testing on Multiple Machines -
Overview" on page 275.

i. If youwant to use Remote Desktop Connection during your mirroring test, Remote
Desktop Connection (Terminal Services Client 6.0) must be installed on your primary
machine. If it is missing, Sprinter will prompt you to install it.

j- For more things to consider when preparing your test for mirroring, see Mirroring Test
Preparation in "Troubleshooting and Limitations - Mirroring" on page 330.

2. Configure your comparison settings - Optional

Your comparison settings control which built-in rules you want to activate for your run.
For details on comparison settings and built-in rules, see

= "Mirroring Settings Pane (Settings Dialog Box)" on page 61

= The section on Built-in Rules in "Rules Overview" on page 281

3. Review the rules for your application

Click the Rules node in the "Power Mode Group" on page 212 to view or delete any rules you
may have already created for your application.

For details on rules, see "Rules Overview" on page 281.

4. Configure the secondary machines for your run
A test run with mirroring has a primary machine on which you manually perform all the user
actions in your test and secondary machines on which Sprinter replicates your user actions.

When you configure a secondary machine, you provide the information Sprinter needs to
connect to the machine and how Sprinter will start the application on the secondary machine.
You can also provide the information needed to open a remote desktop connection. (This can
be also be provided during the run.)

Note: Make sure the product version on the secondary machine is the same as that on the
primary machine.

For details on configuring secondary machines, see "Mirroring Pane (Power Mode Group)" on
page 294.
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How to Run a Test with Mirroring

P Relevant for Power Mode only

The following steps describe how to run a test with Mirroring. This task assumes that you already
understand the basic functionality of Sprinter and how to run a test without Mirroring as described in
"How to Run a Manual Test in Sprinter" on page 114, and includes the following steps:

o Prerequisites

o Start therun

o Perform the user actions in your test

o View the status of your secondary machines in the Machines sidebar

o View a current screen capture of all the machines in your run - Optional

o Compare the displays of your primary and secondary machines - Optional

« Resolve replication or comparison problems on a secondary machine - Optional

o Continue with your test as usual

1. Prerequisites
To run a test with mirroring, you need to configure the secondary machines in your run. You
may also want to review any rules you already have for your application and your comparison
settings.

For details, see "How to Prepare a Test for Mirroring" on page 284

2. Start the run

When you start a run with mirroring, the "Health Console" (described on page 305) opens,
displaying the status and connection progress of all the machines in the run.

From the Health Console you can:

= Initialize a machine that failed to connect

= Open the " Machine Details Dialog Box" on page 306
= Open a remote desktop connection to the machine

When all the machines connect successfully, the Health Console closes and the run begins.

3. Perform the user actions in your test
Run your test as usual. Each of the user actions you perform on your primary machine are
replicated on your secondary machines.
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Note: Sprinter replicates your user actions only after they are completed. For edit boxes
and combo boxes, the action is not complete, and will not be replicated, until you move the
focus off the box.

4. View the status of your secondary machines in the Machines sidebar
The Machines sidebar displays:

= The number action that was last attempted on each machine.
= The status of each machine as a tool tip, when you hover over the machine display.
= The replication status of your action.

The comparison status of each machine.

For details on using the Machines sidebar, see "Machines Sidebar" on page 309.

5. View a current screen capture of all the machines in your run - Optional

Click the Machines Viewer button T to open the "Machines Viewer" (described on page
314).

6. Compare the displays of your primary and secondary machines -
Optional
When you compare machines, Sprinter compares the display of your primary machine with
those of all the secondary machines in your run and detects any differences between the
displays.

Click the Compare All button *'I" to compare the display of your primary machine with those
of all your secondary machines.

Compare All compares only those secondary machines whose action numbers are the
same as the primary machine.

For more details on comparing the machines in your run, see "Comparing Machines" on page
278.

7. Resolve replication or comparison problems on a secondary machine -
Optional
If Sprinter could not replicate your user action on a secondary machine, or if it detected
differences between your machines during a Compare All operation, the Machines sidebar
indicates the problem and the secondary machine is locked.

In order for subsequent user actions to be replicated, you must resolve the replication problem
or difference and unlock the machine.
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For details on how to handle differences and replication errors, see:
= "How to Resolve Differences During a Run" on next page
= "How to Handle Replication Errors During a Run" on page 292
For more details, see:
= "Resolving Problems on and Unlocking Secondary Machines" on page 279
= The section on Secondary Machines Display in "Machines Sidebar" on page 309

= The section on Secondary Machine Right-click Options in "Machines Sidebar" on page
309

= "How Sprinter Replicates Your User Actions" on page 277

= "Comparing Machines" on page 278

8. Continue with your test as usual
Continue performing the user actions in your test as usual.
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How to Resolve Differences During a Run

P Relevant for Power Mode only

If you run your test on multiple machines (as described in "How to Run a Test with Mirroring" on

page 286), you may want to compare the display of the secondary machines to that of the primary

machine, and find those areas where the displays may not match.

Sprinter detects differences between these displays. It also enables you to address these

differences and continue your test.

During the time that you are resolving differences, you may need to perform actions on your primary
machine. In this case you may want to stop capturing your user actions so they are not replicated
on your secondary machines. For details on stopping capturing, see "Tools Sidebar" on page 173.

The following steps describe how to resolve differences detected between displays.

o Determine the type of difference

Resolve the difference

Unlock the secondary machine

1. Determine the type of difference
Before you can resolve a difference between machines, you need to understand the type of

difference Sprinter found. You can view the difference in one of the following ways:

Open the Differences viewer to view the difference. The Differences Viewer displays the
differences between machines, and enables you to create a rule or submit a defect based on
the difference. For details on the Differences Viewer, see "Differences Viewer" on page 315.

Display a screen capture of the current state of a secondary machine with the Show
Screen operation.

Open a remote desktop connection to the secondary machine.

These operations are available by for each of the secondary machines in the Machines
sidebar, by right-clicking the secondary machine display. For more details on these options,
see the section on Secondary Machine Right-click Options in "Machines Sidebar" on page
309.

2. Resolve the difference

Once you determine the type of difference, you can decide the best method to resolve it. The

following are the types of differences and options for resolving them:

A one-time difference between displays. This might be a message box, warning, or other
object that displays in a machine, based on settings for that machine. It may not represent a
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defect in the application, and it is not likely to occur again during your test.

o You might resolve this type of difference by opening a remote desktop connection to the
secondary computer and performing the actions necessary to resolve the difference.

o If the difference represents a defect in your application, you can submit a defect for this
difference. For details on submitting defects, see "How to Detect and Submit a Defect" on
page 170.

= A difference in the displays that is likely to occur again.

If the difference is likely to occur again, it is recommended that you resolve the difference
through the Differences Viewer.

o If the difference represents a defect in your application, you can submit a defect for this
difference. In the "Differences Viewer" on page 315, click the Submit Defect button to
submit the defect to Application Lifecycle Management. For more details, see
"Differences Viewer" on page 315.

When you submit a defect, Sprinter also creates a rule to ignore this specific difference on
this object, with its current properties.

o If the difference does not represent a defect, but it is likely to occur again, you may want to
teach Sprinter to ignore similar differences in the future.

In the "Differences Viewer" on page 315, click the New Rule button to open the "New Rule
Dialog Box" on page 318 (described on page 318), and follow the on screen instructions.

When you create a rule to ignore a difference, Sprinter automatically recompares the
secondary machine with the primary machine, to determine if the difference is no longer
detected.

3. Unlock the secondary machine
If you resolved the difference by creating a rule, the secondary machine is unlocked, and you
can continue your test. A secondary machine will only be unlocked if all the detected
differences are resolved.

If you used a different method to resolve the difference, you need to unlock the secondary
machine to continue replicating your user actions on that machine.

= Right-click > Skip unlocks the machine and attempts to replicate any pending user action.

= Right-click > Recompare compares the secondary machine with the primary machine,
and unlocks the machine if no differences are found.

= Right-click > Sync ignores the problem that Sprinter found with the secondary machine,
deletes all pending actions, and synchronizes the actions number with the primary machine.
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For more details, see the section on Secondary Machine Right-click Options in "Machines
Sidebar" on page 309.
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How to Handle Replication Errors During a
Run

12 Relevant for Power Mode only
If you run your test on multiple machines (as described in "How to Run a Test with Mirroring" on

page 286), you may experience a replication error on a secondary machine.

Replication errors can occur due to differences between the displays of the primary and a
secondary machine, or due to a communication error with the secondary machine.

During the time that you are handling replication errors, you may need to perform actions on your
primary machine that are not part of your test. In this case you may want to stop capturing your user
actions so they are not replicated on your secondary machines. For details on stopping capturing,
see "Tools Sidebar" on page 173.

For details on how Sprinter replicates user actions, see "How Sprinter Replicates Your User
Actions" on page 277.

This task includes the following steps:

o Determine the type of replication error

Handle the error

e Unlock the secondary machine

1. Determine the type of replication error
Before you can handle a replication error, you need to understand its cause by viewing the

current display of the secondary machine. You can view the secondary machine in one of the
following ways:

= Display a screen shot of the current state of a secondary machine with the Show Screen
operation.

= Open a remote desktop connection to the secondary machine.
You can also hover over the secondary machine display to view details of the error.

These operations are available for each of the secondary machines in the Machines sidebar.
For more details on these options, see the section on Secondary Machine Right-click
Options in "Machines Sidebar" on page 309.

2. Handle the error

Once you determine the cause of the error, you can decide the best method to handle it. The
following are the types of errors and options for handling them:
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= A problem with the display. This might be a message box, waming, or other object that
displays in a machine, based on settings for that machine. It could also represent a defect in
your application.

o You can handle this type of error by opening a remote desktop connection to the
secondary machine and performing the actions necessary to modify the display to match
that of the primary machine.

o If the problem was caused by a defect in your application, you can report it by submitting a
defect. For details, see "How to Detect and Submit a Defect" on page 170.

= A communication problem with the secondary machine.

o Areplication error may occur if the connection to the secondary machine is lost. You can

use the options in the Health Console (Machines sidebar >Health Console button 5 )
to reconnect to a secondary machine. For details, see "Health Console" on page 305.

3. Unlock the secondary machine

After you handle a replication error you need to unlock the secondary machine to continue
replicating your user actions on that machine. You can unlock a machine in one of the following
ways:

= Skip. This option unlocks the machine and attempts to replicate any pending user action.

= Sync. This option unlocks the machine and does not replicate any pending user actions.
The action number is set to match the number of actions on the primary machine.

= Retry. Retries replicating the failed user action.

For more details on these options, see the section on Secondary Machine Right-click
Options in "Machines Sidebar" on page 309.
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Mirroring Pane (Power Mode Group)

This pane enables you to add, edit, and delete secondary machines for your test.
Tasks you can accomplish with the Mirroring pane:

o "How to Prepare a Test to Run in Power Mode" on page 210

o "How to Prepare a Test for Mirroring" on page 284

The following image shows the Mirroring pane.

Mirroring ?
B B X
Add Edit Delete
Machine Name Computer Name / IF Address Description
E Primary localhost Primary Host
E Eirefox lab 2 Windows Vista with Firefox
B win7 Lab4 Windows 7 with [E
B Firefox Lab1 ‘windows 7 with Firefox
To access SelectPower Mode group > Mirroring node.
Important o By default, your local computer is defined as the Primary machine.
information
o For details on how Sprinter maintains the list of secondary computers, see
"How User Information is Maintained" on page 44.
See also "Testing on Multiple Machines - Overview" on page 275

User interface elements are described below:

ul
Elements Description

% Opens the New Machine dialog box, enabling you to define the configuration of a
fas secondary machine.

The New Machine dialog box contains the following tabs:
e "General Tab (New Machine/Machine Details Dialog Box)" on page 297

e "User Credentials Tab (New Machine/Machine Details Dialog Box)" on page 302

¢ "Run Configuration Tab (New Machine/Machine Details Dialog Box)" on page 300
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ul
Elements Description

|_%, Opens the Machine Details dialog box, enabling you to edit the configuration of a
Edit

secondary machine.

The Machine Details dialog box contains the following tabs:

¢ "General Tab (New Machine/Machine Details Dialog Box)" on page 297

e "User Credentials Tab (New Machine/Machine Details Dialog Box)" on page 302

¢ "Run Configuration Tab (New Machine/Machine Details Dialog Box)" on page 300

K Deletes the selected machine from the list of secondary machines.
Delete

Note: You can disable a secondary machine for a particular test run by clearing its
check box, without removing it from the list of machines. It will then be available with
its configuration, for use in future tests.
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New Machine/Machine Details Dialog Box

ZRelevant for Power Mode only

This dialog box enables you to define edit the configuration of a secondary machine, and includes
the following tabs:

¢ "General Tab (New Machine/Machine Details Dialog Box)" on next page
¢ "Run Configuration Tab (New Machine/Machine Details Dialog Box)" on page 300

o "User Credentials Tab (New Machine/Machine Details Dialog Box)" on page 302
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General Tab (New Machine/Machine Details Dialog
Box)

12 Relevant for Power Mode only

This tab enables you to define the configuration of a secondary machine.
Tasks you can accomplish with the General tab:

e "How to Prepare a Test to Run in Power Mode" on page 210

o "How to Prepare a Test for Mirroring" on page 284

The following image shows the General tab.

New Machine 7=

General Run Configuration User Credentials

* Name: | New Machine I

Enter & name for the machine.
Description:
« Machine: |
Icon: Change. .
=]

To access | 1. Select Power Mode group > Mirroring node.
2. Inthe Mirroring pane, click the Add button. The New Machine dialog box
opens.

3. Select New Machine dialog box > General tab.

See also | "Testing on Multiple Machines - Overview" on page 275

Descriptions of the user interface elements are available in the dialog box when you hover over

them. The table below describes the user interface elements:

]|

Elements Description

Name A logical name for the secondary machine.
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ul
Elements Description
Description | A description of the secondary machine's environment, for example, a browser or
operating system name.
Machine The computer or virtual machine you want to use as a secondary machine.
The following are valid entries:
e The IP address of the computer or virtual machine
¢ The machine name of the computer or virtual machine in one of the following
formats:
m MachineName.DomainName
» DomainName\MachineName
Icon The icon that will be displayed in the Machines sidebar, to represent the
secondary machine.
Click the Change Icon button to open the "Change Icon Dialog Box" on next page
and select a different icon for the secondary machine.
You may want to select an icon that helps you identify the specific configuration of
the secondary machine. For example, if the secondary machine is testing a
different browser, you can use an icon to represent that browser.
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Change Icon Dialog Box

72 Relevant for Power Mode only

This dialog box enables you to select an icon to represent the secondary machine in the Machines
sidebar.

The following image shows the Change Icon dialog box.

Change Icon for Machine 'Firefox'

Select an icon from the list below:

All Categories
Application Servers

Browsers

Data Bases

My icons

Operating Systems o |

To access | 1. Select Power Mode group > Mirroring node.

2. Inthe Mirroring pane, click the Add button. The New Machine dialog box
opens.

3. Select New Machine dialog box > General tab > Change button.

See also | "Testing on Multiple Machines - Overview" on page 275

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

Select an icon The list of categories from which to select an icon for the machine. The

from the list category you select changes the displayed list of icons available in the right

below
pane.

<lcon display> | A display of the icons you can select to represent the machine.

Add Enables you to browse the file system and select an icon for the machine.
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Run Configuration Tab (New Machine/Machine
Details Dialog Box)

12 Relevant for Power Mode only

This tab enables you to define how the secondary machine will run the application in your test run.

When you have a desktop application selected in the "Application Pane (Power Mode Group)" on
page 214, this tab displays options for desktop applications.

When you have a Web application selected in the "Application Pane (Power Mode Group)" on page
214, this tab displays options for Web applications.

Tasks you can accomplish with the Run Configuration tab:
e "How to Prepare a Test to Run in Power Mode" on page 210
o "How to Prepare a Test for Mirroring" on page 284

The following image shows the Run Configuration tab with options for a desktop application.

New Machine [ u|
General || Run Configuration || User Credentials
Configure how Sprinter will launch the application on the machine

® Same as Primary machine
Same as

) Other:

Location: | CAWINDOWS\NOTEPAD.EXE

Additional Seftings =>

The following image shows the Run Configuration tab with options for a Web application.

New Machine I~

General | Run Configuration | User Credentials

Configure how Sprinter will launch the application on the machine.

® Same as Primary machine
Same as:
) Other:
URL: | http:#/newtours.demoaut.comimercurywelcome.php

ee

Browser:
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To access 1. Select Power Mode group > Mirroring node.

2. Inthe Mirroring pane, click the Add button. The New Machine dialog box

opens.
3. Select New Machine dialog box > Run Configuration tab.

Important Sprinter remembers your modifications to the run configuration as long as you
information | ontinue to work with your currently defined application. If you change

applications, the run configurations return to their default settings.
See also "Testing on Multiple Machines - Overview" on page 275

User interface elements are described below. Some options are displayed differently, depending on

whether you are working with a desktop or Web application:

Ul Elements Description

applications)

Same as Instructs the machine to run the application according to the settings for the
Prima_ry application in the "Application Pane (Power Mode Group)" described on page
machine | 51, (Default)
Same as Instructs the machine to run the application according to the settings for the
<secondary | selected secondary machine. Only secondary machines that have unique run
machine> . : C

settings are displayed in this list.
Other (for Defines new run settings for the application, for this machine.
desktop

Path. The path to the desktop application. The Browse option displays the file
system for your local computer and not the secondary machine.

Additional Settings:

o Parameters. Any parameters you want to run the application with. Parameter
settings are maintained per-application. When you select an application in the
Application name field, any previously defined parameters are run by default.
To change or remove the parameters, edit them in the Parameters field.

e Working folder. The working folder for the desktop application.

Other (for
Web
applications)

URL. The URL address of the Web application you want to run in your test.
Browser. The browser in which you want to run the Web application.

Additional Settings

o Close the browser when the test closes. Automatically close the browser
at the end of the test.
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User Credentials Tab (New Machine/Machine
Details Dialog Box)

12 Relevant for Power Mode only

This tab enables you to provide login information for your secondary machine. This information is
used for the following:

« Opening a remote desktop connection to the secondary machine, when running the test.

o Interacting with the Sprinter Agent on the secondary machine. In this case Sprinter will only use
a Sprinter Agent that is launched by the specified user, with the correct credentials.

To allow Sprinter to use any Sprinter Agent running on the secondary machine, set the
ProtectSessions flag in the Sprinter.exe.config file (in the product's bin folder) to False onthe
secondary machine.

Tasks you can accomplish with the User Credentials tab:
e "How to Prepare a Test to Run in Power Mode" on page 210
e "How to Prepare a Test for Mirroring" on page 284

The following image shows the User Credentials tab.

New Machine ™

General Run Configuration User Credentials

Sprinter uses these settings in order to connect to the machine during the test.

® Same as Primary machine

Other:

To access 1. Select Power Mode group > Mirroring node.

2. Inthe Mirroring pane, click the Add button. The New Machine dialog box
opens.

3. Select New Machine dialog box > User Credentials tab.
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Important ¢ If you try to connect to the machine during your run and you did not enter the
information remote desktop connection credentials in this tab or the credentials are
incorrect, you will be prompted for this information.

o The credentials you provide must match the credentials for the user currently
logged on to the secondary machine. If they do not match, you will be
prompted for this information.

See also "Testing on Multiple Machines - Overview" on page 275

Descriptions of the user interface elements are available in the dialog box when you hover over
them.
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Mirroring Rules Pane (Power Mode Group)

This pane enables you to view and delete the rules that are associated with the mirroring for the

currently defined application.
Tasks you can accomplish with the Rules pane:
e "How to Prepare a Test to Run in Power Mode" on page 210

The following image shows the Mirroring Rules pane.

Wirroring Rules ?
Delete Rule
Enabled Name Type Scope Description

Title rule Ignore property  Current Application

Flight Details Ignore property  Current Application

Cruie Color Ignore property  Current Application

Content diff Ignore property  Current Application

Ignore the "SunfwiCanvas' object Ignore object Current Application

Ignore the "SunfwitCanvas(' object  Ignore object Current Application

lgnore the “View Calendar’ button Ignore object Current Application

lgnore the “View Calendarl’ button  Ignore object Current Application
To access Select Power Mode group > Rules node.
Important For details on the Type and Scope of a rule, see the Custom Rules section in
information "Rules Overview" on page 281.

Descriptions of the user interface elements are available in the pane when you hover over them.
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Health Console

12 Relevant for Power Mode only

This window displays the status of each machine in a mirroring test.

Tasks you can accomplish with the Health Console:

e "How to Run a Manual Test in Sprinter" on page 114

The following image shows the Health Console as it prepares a run with mirroring with two

secondary machines.

=)

Health Console
E= f_:—| (4
nitialize Machine Details Remote Deskiop
Sta... Machine Progress Details
J E| Primary {localhost) 10% Preparing the machine
o) |%| Firefox {1ab 2) B | nitaizing Power Mode
J E| Win 7 (Lab 1) 10% Conneciing to the machine
To ¢ The Health Console automatically opens when you run a test with mirroring.
access _ o
o During arun you can also access the health console by clicking the Health
Console button Machines sidebar.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

nitinlze machine if it failed to connect.

|§|ﬂ Instructs Sprinter to attempt to initialize the Sprinter Agent on the selected

Machine Detads selected machine.

o Opens the " Machine Details Dialog Box" (described on page 306) for the

DOpen Remaote Desktop

7S Opens a remote desktop connection to the selected machine.

<Machine

The list of machines for the current run. The machine list displays the status,
list> machine name, a progress bar, and details for each machine.
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Machine Details Dialog Box

72 Relevant for Power Mode only

This dialog box displays the details of the connection process for machines during a mirror test.

The following image shows the Machine Details dialog box.

Machine Details

Machine: | [ Firefox [~

Time Action Status | Details

6:27:09 PM  Locating the machine (v]

6:27:09 PM  Connecting to the machine C

To access | Inthe "Health Console" on previous page, click the Machine Details button.

User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

Machines | A drop-down list of the machines for this run.
<Action | Thelist of actions for the selected machine. The action list displays the Time,
list> Action, Status, and Details for each action.
o If an action completes successfully, no details are displayed.
« If an action fails, the Details column displays the specific problem. You can click
on the error message and select More Details to open the "Error Details Dialog
Box " (described on page 307).
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Error Details Dialog Box

12 Relevant for Power Mode only

This dialog box displays error information when Sprinter fails to connect to a machine.

The following image shows the Error Details dialog box.

Emor Details

Error description:

Unable to find host's computer in network

Error details:

Exception occurred while try to

ping machine 'Fail' (exception: No such host is known).

To Do the following:
access
1. Inthe Health Console for a failed connection, click the " Machine Details Dialog
Box" on previous page button.
2. The details column displays the specific problem. Click on the error message and
select More Details.
See "Testing on Multiple Machines - Overview" on page 275
also

Descriptions of the user interface elements are available in the dialog box.
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Sprinter Agent

12 Relevant for Power Mode only

The Sprinter Agent enables Sprinter to run tests in Power Mode and with mirroring.

To access | |n the task bar, right-click the Sprinter Agent icon* to display the Sprinter Agent
options.

Important | When you hover over the Sprinter Agent icon, the agent status is displayed. For a
information | secondary machine, the status displays if the agent is in use in a test with

mirroring, or if it is available for use.

Right-click shortcuts are described below:

Ul Elements Description

Reset Stops and restarts the Sprinter Agent.
Exit Stops the Sprinter Agent.
Run When Computer Instructs the machine to invoke the Sprinter Agent automatically on
Starts startup.
If
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Machines Sidebar

12 Relevant for Power Mode only

This sidebar enables you to work with your secondary machines during a test with mirroring.

Tasks you can accomplish with the Machines sidebar:

e "How to Run a Test with Mirroring" on page 286

+ "How to Resolve Differences During a Run" on page 289

+ "How to Handle Replication Errors During a Run" on page 292

The following image shows the Machines sidebar with two secondary machines.

sidebar options

7@

Machines _;I* /g | i': ?

Primary
machine display

Secondary
machine display

To access | During a test run, click the Machines sidebartab.

Click the sidebar tab again, or click off the sidebar tab, to close the sidebar.

To reposition the sidebar, click and drag on the sidebar header.

See also .

"Testing on Multiple Machines - Overview" on page 275

"How Sprinter Replicates Your User Actions" on page 277

"Comparing Machines" on page 278

"Resolving Problems on and Unlocking Secondary Machines" on page 279

"Rules Overview" on page 281
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Machines Sidebar Operations
User interface elements are described below:

ul
Elements Description

Compare All. Compares the display of the primary machine against the displays of
all the secondary machines in your run. Compare All compares the primary
machine only with secondary machines that are synchronized with the primary
machine.

Note: If you edit an edit box or combo box, the Compare All option is disabled until
you move the focus off the box.

User actions on edit boxes and combo boxes are not replicated until you move the
focus off the box. The Compare All operation is therefore disabled, to prevent
Sprinter from comparing edit boxes and combo boxes that have not yet been updated
on the secondary machines.

N Show Rules. Opens the "Rules Manager Dialog Box" (described on page 320)
enabling you to create, view, edit, and delete the rules in your test.

L View Machines. Opens the "Machines Viewer" (described on page 314), displaying
the current display of all the machines in your test.

¥ Health Console. Opens the Health Console, displaying the connection status of

each machine. For details, see "Health Console" on page 305.

Secondary Machine Display

Each secondary machine display provides information that is specific to its machine, indicates the

status of the machine, and provides you with operations you can perform on the machine.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

ul
Elements Description

Replication status. Indicates the status of replication on the secondary machine.

o After every action you perform on the primary machine, there is a visual indication
on this icon telling you that your action is being replicated on the secondary
machine.

o If youraction was replicated successfully, the icon turns green. If the action could
not be replicated, the icon turns red and the secondary machine is locked.

o Fordetails on how to handle replication problems and unlock the secondary
machine, see "How to Handle Replication Errors During a Run" on page 292.

Comparison status. Indicates the status of the comparison of the secondary
machine with the primary machine.

e Secondary machines are compared with the primary machine when you click the

Compare All button ‘I' , or when you select Recompare from the "Machines
Sidebar" on page 309.

o If the comparison did not detect any differences between the primary and
secondary machine, the icon turns green. If the comparison detected differences,
the icon turns red and the secondary machine is locked.

o For details on how to handle differences and unlock the secondary machine, see
"How to Resolve Differences During a Run" on page 289.

<tooltip>

When you hover over the Secondary Machine Display a tooltip is displayed,
providing you with information about the machine.

e Action. Lists the number of the action performed on the machine and provides a
description of the action.

o Status. Indicates the status of the machine. If the machine is locked, provides a
description of the problem. Indicates connections status with primary machine.

L3

Click the Health Console button to address connection problems.

<right-
click
options>

The right-click options for each machine enable you to control your secondary
machines and address replication and comparison errors on machines. For details,
see "Machines Sidebar" on page 309.
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Secondary Machine Right-click Options
The right-click options for each secondary machine are described below:

ul
Elements Description

Start/Stop | Starts or Stops replicating user actions performed on the primary machine, on the
Replication | secondary machine.

When you stop replicating on the secondary machine, any user actions performed
on the primary machine are not replicated on the secondary machine.

Skip Ignores the problem found with replication or comparison and unlocks the
machine, enabling replication of user actions to continue.

Any pending actions that have not yet been replicated are performed on the
secondary machine.

Sync Synchronizes the secondary machine with the primary machine.

¢ Ignores the replication error and unlocks the machine, enabling replication of
user actions to continue.

e The user action and any pending actions that failed to replicate are not
performed on the secondary machine.

e The number of user actions is set to match the number of actions on the
primary machine.

Retry Retries replicating the current user action on the secondary machine.
Show Displays a screen capture of the secondary machine.
Screen
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Ul
Elements

Recompare

Description

Compares the secondary machine with primary machine .

Comparing an individual secondary machine can be performed only after
performing a Compare All operation from the "Machines Sidebar" on page 309.

When you recompare machines, the secondary machine is compared with the
primary machine at the state the primary machine was in when the secondary
machine became locked. If you made any changes to the state of the primary
machine after the secondary machine was locked, they are not recognized by the
Recompare operation.

Note: The Recompare operation is designed to be used after you resolve
differences that were found between machines. You cannot perform a
Recompare operation if you perform a user action on your primary machine after a
Compare All operation.

If you click the Stop Recording button in the Tools sidebar, you can perform user
actions on your primary machine and still perform a Recompare operation on your
secondary machine when you continue recording.

Differences
Viewer

Opens the "Differences Viewer"(described on page 315), enabling you to view and
resolve differences that were detected between machines.

Remote
Desktop

Opens a remote desktop connection with the secondary machine.

You should not have an external remote desktop connection (not via Sprinter)
open, when you open a remote desktop connection via Sprinter.

Page 313

HP Sprinter (Service Pack 11.52)



Sprinter for ALM User Guide
Chapter 11: Mirroring Tests

Machines Viewer

72 Relevant for Power Mode only

This viewer displays a current screen capture of the machines in the run.
Tasks you can accomplish with the Machines Viewer:

e "How to Run a Test with Mirroring" on page 286

« "How to Resolve Differences During a Run" on page 289

« "How to Handle Replication Errors During a Run" on page 292

The following image shows the Machines Viewer.

Firefox

Lab 43

To access Select Machines side bar > View Machines button " .

User interface elements are described below:

ul
Elements Description

288 Displays the machines in a split-screen view.

oo
oo
Basic

Clicking on a machine brings that machine into the main view. Clicking again returns
the display to the split-screen view.

ich Displays the machines in a three dimensional view.

Clicking on a machine rotates that machine into the main view. You can also scroll
through the machines by using the scroll bar on the bottom of the screen.
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Differences Viewer

72 Relevant for Power Mode only

This viewer displays the differences detected between the displays of the primary machine and

secondary machines in your test.

The Difference Viewer also enables you to address the differences by creating rules for them or

ignoring them. You can also submit defects based on the detected differences.

Tasks you can accomplish with the Differences Viewer:

e "How to Run a Test with Mirroring" on page 286

o "How to Resolve Differences During a Run" on page 289

The following image shows the Differences Viewer.

ey — (waln-d |
Differences List
Action Summary
@ Difference not resolved “View Calendar' button can only be found in Firefox host
@ Difference not resolved “View Calendar' button can only be found in Firefox host
Primary Firefox
= e
@L -l 5 @\ Trip O One Way 2
W E
| _H
L Em B |
To Do one of the following:
access
¢ Right-click a secondary machine with comparison errors in the Machines sidebar
and select Differences Viewer.
o Select Results > Storyboard. Select an action where differences were found and in
the action details area click the Show link in the Differences section.
See "Rules Overview" on page 281
also
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User interface elements are described below:

Ul Elements Description

Submit Defect

o Submit Defect. (Default) Opens the "Smart Defect Settings Dialog Box"
(described on page 177), enabling you to automatically include defect
scenario information in your defect. The defect summary includes a
description of the difference.

= |f you choose to attach a screen capture to your defect, screen captures of
both machines are attached to the defect.

= When you submit a defect in the Differences Viewer, Sprinter also creates a
rule to ignore this specific difference on this object, with its current
properties.

gnore

Ignores the selected differences.

When you create a rule to ignore a difference, Sprinter automatically recompares
the secondary machine with the primary machine, to determine if the difference
is no longer detected.

Not available when you open the Differences Viewer from the Storyboard,
Results, or the Sprinter Standalone Results Viewer.

Mew rule

Opens the "New Rule Dialog Box" (described on page318).

When you create a rule to ignore a difference, Sprinter automatically recompares
the secondary machine with the primary machine, to determine if the difference
is no longer detected.

Not available when you open the Differences Viewer from the Storyboard,
Results,or the Sprinter Standalone Results Viewer.

Opens the "Rules Manager Dialog Box" (described on page 320).

Zooms the display in to the selected difference.

Zooms the display out to 100%.

_\r

7-.‘3_ Selects all the differences in the Differences List.
Differences | The list of differences detected between the primary machine and the secondary
List

machine. Select a difference in the list to perform an action oniit.
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Ul Elements Description

<Difference | The display of the difference. The difference is indicated in the display in a red
display> box. In the case of a missing object there is no indication in the display where the
object is missing.

The difference display contains the following elements:

o Maximize/Minimize. Expands the machine's display to fill the entire
Differences Viewer window. Minimize returns the display to normal.

o Slider control. Zooms in and out on the display.

¢ Remote Desktop. (Secondary machines only) Opens a remote desktop
connection to the secondary machine.

<Difference | A text description of the difference.
description>
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New Rule Dialog Box

12 Relevant for Power Mode only

This dialog box enables you to accept a pre-defined for the difference, or create a custom rule.
Tasks you can accomplish with the New Rule dialog box:
« "How to Resolve Differences During a Run" on page 289

The following image shows the New Rule dialog box.

#) |gnore the selection of: |this combo box| = |

Create custom rule

To access From the Differences Viewer, select a difference and click the New Rule
button.

Important The options displayed in the dialog box are different depending on the type of

information difference detected.

See also "Rules Overview" on page 281

Options when the object is found in one display and missing in another:
User interface elements are described below (variable text is shown in angle brackets):

Ul Elements Description

Ignore the <object name> Ignore every occurrence of the specified object.
<object type>
Create custom rule Opens the Rule Wizard (described on page 322).

Ignore all the objects in the area | Ignore all the objects in the area where this specified

that contains the <object type> object is located.
(the <area name> <area type>)
Note: This option is displayed only in certain cases where

the object that is missing is located within a container
object, but that container object is not a window.
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Options when a specific property value is different between machines
User interface elements are described below (variable text is shown in angle brackets):

Ul Elements Description

Ignore the Defines when the property value that was different will be ignored.
<property name>
of <object> o this <object name>. Ignore the property value for this specific object

only. Forexample: Ignore the color of the OK button.

o all <object type>. Ignore the property value for all objects of the same
type as this object. For example: Ignore the color of all
buttons.

o all objects. Ignore the property value for all objects. For example:

Ignore the color of all objects.

Note: This option is displayed only for the following properties that are
common to all objects:

= background color
= enabled state
= location

= Size

Create custom rule | Opens the Rule Wizard (described on page 322).
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Rules Manager Dialog Box

72 Relevant for Power Mode only

This dialog box enables you to create, view, edit, and delete the rules for your application.

Tasks you can accomplish with the Rules Manager dialog box:

« "How to Resolve Differences During a Run" on page 289

The following image shows the Rules Manager dialog box.

2 X B

New rule Delete Rule Edit Rule

Existing Rules

Enabled  Name Type Scope Description
Ignore the “iew Calendar button Ignore object  Current application
Ignore the 'SunAwiCanvas’ object Ignore object  Current application
Ignore the View Calendard' button Ignore object  Current application
Ignore the 'SunAwtCanvasd' object lgnore ohject  Current application
Ignore the View Calendar button Ignore object  Current application
Ignore the 'SunAwiCanvas’ object Ignore object  Current application
Ignore the 'SunAwtCanvas(’ object lgnore cbject  Current application
Ignore the 'Find a Flight: .." browser  Ignore object  Current application
Ignore the 'Find a Flight: _..' browser  Ignore object  Current application
Ignore the 'Find a Flight: ' browser  Ignore object  Current application

To From the Machines sidebar or the Differences Viewer,click the View Rules
access button.
See also | "Rules Overview" on page 281

User interface elements are described below:

Ul
Elements

A

Meaw rule

Description

Opens the Rule Wizard, enabling you to create a custom rule. For details, see "Rule
Wizard - Rule Details Page" on page 322.

X

Deletes the selected rule. The rule will no longer be available depending on its scope,

Pes=Ru= | as defined in the "Rule Wizard - Rule Details Page" (described on page 322).
P, Opens the Rule Wizard for the selected rule, enabling you to edit the rule. For details,
FaRue see "Rule Wizard - Rule Details Page" on page 322.
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ul
Elements Description

Existing | « Enabled. Select the check box next to the rule to enabile it for your run.
Rules

¢ Name. The name of the rule as defined in the Rule Wizard.

o Type. The type of rule.
* Ignore Property. Ignores a specific property of an object.
 Ignore Object. Ignores all objects of a specific type.

e Scope. When the rule is applied.
* Current application
+ All applications

o Description. The description of the rule as defined in the rule wizard.

For more details on rule definitions and settings, see "Rule Wizard - Rule Details
Page" on next page.
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Rule Wizard - Rule Details Page

12 Relevant for Power Mode only

This wizard enables you to create a custom rule to resolve differences between machines in a test
with mirroring.

Tasks you can accomplish with the Rules Wizard:

« "How to Resolve Differences During a Run" on page 289

The following image shows the Rules Wizard.

Rule Wizard [~7=

Rule Details. Rule Details
Rule Target
Rule Description

+Name: [ New Rule

Description:
Type: |lgnore property E‘
Scope: (ANl Appiications =
——— ——— —

To Use one of the following:
access

« Inthe Differences Viewer >New Rule button >Create custom rule option.

e Start arun and click the View Rules button in the Machine sidebar. In the Rules
Manager click the New Rule or Edit Rule buttons.

Wizard | This wizard contains:

map
Rule Details page > "Rule Target Page" on page 324 > "Rule Description Page" on
page 327

See "Rules Overview" on page 281

also

Descriptions of the user interface elements are available on the wizard page when you hover over
them.
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The table below provides additional information for some of these elements:

ul
Elements Description

Type Determines what the rule will ignore.

o Ignore property. Only differences in the specific property of the object will be
ignored.

o Ignore object. All differences in the object will be ignored.

Scope Determines when the rule will apply.
¢ All Applications. The rule will apply to all test runs.

e Current Application. The rule will apply to the application currently defined for
the test only. Any tests configured to use the same application will use this rule.
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Rule Target Page

12 Relevant for Power Mode only
This wizard page enables you to define the object to which your rule will apply.

Rule Wizard [~

Details Rule Target
Rule Target

Rule Description _ -
P WebTable4S' web element

Any object

Wizard This wizard contains:
map
"Rule Wizard - Rule Details Page" on page 322> Rule Target Page > "Rule

Description Page" on page 327

User interface elements are described below (variable text and unlabeled elements are shown in
angle brackets):

Ul Elements Description

<object Define a specific object for which the rule will apply.

name>

<object type> | ® Whenyou access the wizard from the Differences Viewer, the object on
| Specific which the difference was found is automatically selected.

object

Click the Select other object button to open the "Object Selection Window "
(described on page 326), and select a different object for the rule.

« When you access the wizard by creating a new rule from the Rules
Manager, no object is selected. Click the Select object button to open the
"Object Selection Window " (described on page 326), and select an object
for the rule.
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Ul Elements Description

Any object of | Apply the rule to all objects of a specific type.
type <object
drop-down
box>

Any object Apply the rule to all objects.
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Object Selection Window

This window enables you to define an object for your rule.

1@ Book a Flight: Mercury Tours - Windows Internet Explorer
@\_/ i |e. http:/fnewtours demoaut com/mercurypurchase,php v | +y |
W i @ Book a Flight: Mercury Tours ‘ i
AR B one cool summer FXTTTN
AV g
[Book A FLiGHT |
Please review your travel itinerary and make your purchase.
Summary
Acapulco to Acapulco 41172010
|__cuass |
Blue Skies Airlines 360 Coach 270
Acapulco to Acapulco 41172010
Blue Skies Airlines 630 Coach 270
VERSION Passengers: i
s Java Vaislon Tavee  Hdd E|E|
To access In the Rules Wizard > "Rule Target Page" on page 324, click the Select other
object button.
Relevant "Resolving Problems on and Unlocking Secondary Machines" on page 279
tasks
See also "Rules Overview" on page 281

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Elements Description

Select Select the machine to display in the Display window.
machine
<Display Displays the selected machine. As you hover over the display, each object in
window> the display is highlighted in red.
Click on an object to select it for the rule.
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Rule Description Page

This wizard page enables you to define when the rule will be applied and on which specific property.

Rule Wizard ]

Details Rule Description
Rule Target

Rule Description
Rule acticn

Ignere the 'passlastl’ edit field.

‘When:

Available Properties: Selected Conditions:

enabled state
text
location

size :>

background calar

Important The options displayed in the page are different depending on the selections in
information previous pages.
Wizard map This wizard contains:

"Rule Wizard - Rule Details Page" on page 322> "Rule Target Page" on page
324 > Rule Description Page
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User interface elements are described below:

ul
Elements Description

Rule
action

This area defines the specific action the rule will take. Its display depends on
selections you made earlier in the wizard.

o Ignore the <object name> <object type>.

If you selected Ignore object in the Rule Details page, the rule action is set to
ignore the object you selected in the Rule Target page.

o Select Properties to ignore.

If you selected Ignore property in the Rule Details page, you need to select the

properties you want the rule to ignore. Click the browse button E to select from a
list of properties for the object you selected in the Rule Target page. Press Enter

to accept your selections.

When

This area defines the specific conditions under which the rule will be applied.
Select properties and conditions to limit when the rule will be applied.

o Available Properties. The list of properties that are available for the selected
object. Select a property from the list and click the right arrow to move it to the
Selected Conditions list.

o Selected Conditions. When you move a property to this list it is automatically
set to apply the rule when the property is different between machines.

You can create a more specific definition of the conditions under which the rule will

apply, by clicking the browse button El . For details on the selections available,
see "Property Conditions" on next page, below.

Note: You do not need to set any conditions in this area. If no conditions are set, the

rule action will be applied based on your previous selections in the wizard with no
additional limiting conditions.

For example: Suppose these are your selections in the previous wizard pages:
¢ Inthe Rule Details page - you selected Ignore Property.

¢ Inthe Rule Target page - you selected the Any object of type radiobutton and
selected image.

If you do not set any conditions in the When area, the properties you selected in the
Rule Action area will be ignored for all image objects.
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Property Conditions
The property conditions enable you to set a specific condition under which the rule will apply.

Choose condition for the location property
) Value in Primary = I:l and value in Secondary = I:l

) Value in Primary equals to value in Secondary

) Value in Primary is different from value in Secondary

® Valuein lPrimar{.r ngeaterthan” 40 HAnd l‘a‘al,e in [F’rimary HlessthanH a0 |

) Walue in Primary Value in Secondary

' Absolute difference between Primary and Secondary |I|

| Absolute difference between Primary and Secondary |[less than 0 g %
=

The selections available in the property conditions depend on the property you selected in the
Selected Conditions section of the Rule Description page.

Some selections are available for integer values only, some for boolean values only, and some for
text values only.

Some conditions can be a simple or composite statement. The simple statement compares the
property value with a value that you set. To enable the composite statement, select the Use
composite statement check box. This enables the second part of the statement so you can further
refine the condition.

For integers, you can specify an absolute difference between the primary and secondary machine
values. You can specify an actual value or a percentage. These options are useful when you only
want to know the magnitude of the differences between the machines—you don't care if the value
on one machine was greater than another.
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Troubleshooting and Limitations - Mirroring

This section contains troubleshooting tips and limitations for mirroring.

Mirroring Test Preparation

Actions on objects in desktop applications that are visible on the primary machine display, but
are not visible on the secondary machine display, are not replicated.

You cannot use a machine as a secondary machine in your run, if you are not the active user for
that machine, and there is another active user on the machine. In this case, replication will not
work for that machine.

Sprinter prevents mirroring when the process user on the primary machine and the logged in user
on the secondary machine are not the same. To allow mirroring without authentication, set the
ProtectSessions flag in Sprinter.exe.config, located in the product's bin folder, to false on
the secondary machine.

See the list of Prerequisites in "How to Prepare a Test for Mirroring" on page 284.

Mirroring While Connected to Application Lifecycle Management

If you run Sprinter tests with mirroring while connected to an Application Lifecycle Management
server that runs on WebLogic or WebSphere, you must disable the default Basic Authentication
filter to enable the test to run.Ver11.00

Running Sprinter tests with mirroring while connected to an Application Lifecycle Management
server that uses a proxy is not supported.Ver11.00

General Limitations

Mirroring may not work with all technologies.

Secondary machines must have at least one address in ipv4 format. It may also include address
in ipv6 format.

The following actions performed on your application window are not replicated in secondary
machines for Web applications: Autocomplete of user credentials, Maximize, Minimize, Restore
from task bar, Restore size, Move, and Resize.

If a browser automatically enters a password, that user action is not learned by Sprinter.
Workarounds:

* Delete the automatically entered password, place the pointer focus on a different object, and
re-enter the password manually.

* Disable automatic password completion in the browser.

For some technologies, Sprinter does not learn the inner objects of tables. Sprinter will not
detect differences between tables in this case.
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o If you run Sprinter on a machine via a remote desktop connection and use the 3D mode in the
Machines Viewer, memory consumption on some operating systems can be very high. In this
case, it is recommended that you minimize your use of the Machines Viewer 3-D mode.

o User actions that are replicated on a secondary machine may not be displayed on an active
remote desktop connection.
Workaround: Perform an action on the secondary machine via the remote desktop connection
to refresh the display.

« When working with Mozilla Firefox, user actions are replicated only if you are logged in to the
secondary machine with Administrator permissions.

o Creating a rule in the Differences Viewer will not mark a difference as Resolved, in the

following situation;
Open the Differences Viewer for a secondary machine in your run that is not synchronized with
your primary machine (their action numbers do not match) and create a rule for the difference. In
this situation, the rule will apply only to any future actions in your run, but the current difference
will not be marked as Resolved.
Workarounds:

* Click Ignore in the Differences Viewer to ignore the current difference.

* Exit the Differences Viewer and select the Skip or Sync options in the Machines sidebar for
the secondary machine.

¢ When running Sprinter with mirroring, using the Color Picker tool on machines with different
screen resolutions or aspect ratios may not detect identical RGB for all machines.

o Actions may not replay properly if the primary and secondary machines have different screen
resolutions. To ensure proper replay, make sure the resolutions on the machines are identical.

o When using Citrix, you can run Sprinter with mirroring on up to 10 secondary machines
simultaneously.

o Sprinter may fail to communicate with a secondary machine which uses an empty password.
The Health Console will show "Invalid username or password" and the details will indicate a
user account restriction.

Workarounds:

* Define a user account with a non-empty password on the secondary machine, and configure
Sprinter to communicate with this account.

* On the secondary machine, type regedit in the Run box to open the Registry Editor.
Change the value of the following key:
HKLM\System\CurrentControlSet\Control\Lsa\limitblankpassworduse from 1 to 0.
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Using Web Extensibility Packages

You can make use of Web Extensibility packages developed for QuickTest Professional or Unified
Functional Testing (UFT) to enable Power Mode to learn Web objects that are not supported out-of-
the-box. Extensibility packages can be developed for Web, Java, .NET Windows Forms, WPF,
and Silverlight.

After you obtain an Extensibility package, install it by placing the files that it contains under the
Sprinter installation folder as described in the sections below. The next time you open Sprinter, the
Extensibility package appears in the list of technologies in the Add/Edit Application dialog box as
a sub-node under the relevant technology. To work with an Extensibility package, select the
package and its parent technology.

For the Extensibility packages to take effect, rerun the applications you are testing.
This chapter includes:
o "Web Extensibility Package Content" on next page

« "Installing a Web Extensibility Package" on page 334
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Web Extensibility Package Content

The Web Extensibility package consists of:
o XML files
= One test object file named <Extensibility Package Name>TestObjects.xml

= One configuration file named <Extensibility Package Name>.xml (or .cfg for WPF and
Silverlight)

o JavaScript files (.js)
¢ lcon and Help files (Optional)
Icons can be provided in the following file types: .ico, .exe, and .dll.

Help files are provided as .chm files.
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Installing a Web Extensibility Package

Toinstall a Web Extensibility package, place the files that it contains in the locations specified
below. If any of the sub-folders in the specified paths do not exist, create them.

Extensibility Package
File

<Extensibility Package
Name>TestObjects.xml
Note: If there is more than
one test object
configuration file, place

them all in the same folder.

Location on Sprinter Machine

<Sprinter Installation folder>\dat\Extensibility\Web

<Extensibility Package
Name>.xml

<Sprinter Installation folder>\dat\
Extensibility\Web\Toolkits\<Extensibility package name>

JavaScript files

The .js files can be located on the computer on which Sprinter is
installed, or in an accessible network location. Their locations are
specified in the <Extensibility Package Name>.xml file.

Do the following:

1. Search the XML file for lines that contain one of the following:
file_name, default_imp_file, common_file, file_for_func_
to_get_base_elem, JSLibrary.

2. Place the files referenced in those lines in the specified
locations.

Note:

e You can place the files in another location, and adjust the
location specified in the XML file accordingly.

o If the specified location is not a full file system path, it is relative
to the < Sprinter installation

folder>\dat\Extensibility\Web\Toolkits\<Extensibility
package name> folder.

o If the specified file location begins with INSTALLDIR, this
refers to the Sprinter installation path.
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Extensibility Package

File Location on Sprinter Machine

Icon files (optional) The files can be .dll, .exe, or .ico files, located on the computer on
which Sprinter is installed, or in an accessible network location.
Their locations are specified in the <Extensibility Package
Name>TestObjects.xml file.

Search the XML file for lines that contain IconFile, and then place
the files referenced in those lines in the specified locations.

Note:

¢ You can place the files in another location, and adjust the
location specified in the XML file accordingly.

o If the specified file location begins with INSTALLDIR, this
refers to the Sprinter installation path.

Help files (optional) These are .chm files, which must be located on the computer on
which Sprinter is installed. Their locations are specified in the
<Extensibility Package Name>TestObjects.xml file.

Search the XML file for lines that contain HelpFile, and then place
the files referenced in those lines in the specified locations.

Note:

¢ You can place the files in another location, and adjust the
location specified in the XML file accordingly.

o If the specified file location begins with INSTALLDIR, this
refers to the Sprinter installation path.

Sprinter Integration

To complete the integration, you must add the your package name to Sprinter's central addin list.
1. Locate the StationsManagerData.xml file in the Sprinter installation's bin folder.

2. Inthe Addin section, add an entry for your package.
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For example:

<Addins>
<Addin>
<Name>MyPackageName</Name>

<Addin>

</Project>
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